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Introduction to Pro Tools
Read this guide if you are new to

Pro Tools® | Software. This guide provides exam-

ples of how to record, edit, and mix audio, as well

as how to use MIDI in Pro Tools.

If you have not yet installed Pro Tools, install it

now according to the instructions in the Pro Tools
Installation Guide. For information on connecting

and installing drivers for your audio hardware,

refer to its documentation.
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Connecting Headphones or 
Speakers
To hear the audio from Pro Tools, connect head-

phones or speakers to your audio hardware (this

guide uses a Pro Tools | Mbox® audio interface as

an example). If you are using headphones, lower

the Headphone level control (by turning it counter-

clockwise). If you are using speakers, lower the

Master volume control (by turning it counterclock-

wise). It is important to start with the volume suffi-

ciently low to avoid damaging your ears or your

equipment. Once you have started Pro Tools and

opened a session (or created a new one) you can ad-

just the volume controls to a comfortable listening

level.
Mbox front panel connectors and controls

Mbox back panel speaker connections

Headphone level

Master volume

level

1/4-inch headphone jack
1



Playing Back the Demo 
Session 
Use the demo session to test your headphones and

speakers, and start exploring what you can do with

Pro Tools.

To install and open the demo session:

1 Do one of the following:

• Insert the Pro Tools Installer disc into your DVD

drive, locate and open the Additional Files

folder, and then drag the Demo Session folder to

your hard drive (for best performance, use an

Avid-qualified external hard drive rather than the

system drive).

• Download the Pro Tools demo session from your

online Avid account to your hard drive (for best

performance, use anAvid-qualified external hard

drive rather than the system drive).
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2 Launch Pro Tools.

3 Do one of the following, depending on what you

see on-screen:

• If the Quick Start dialog appears, click Open

Session, then click OK. Locate the Demo Ses-

sion file (.ptx), select it, and click Open.

• If the Quick Start dialog does not appear, choose

File > Open Session, then locate the Demo Ses-

sion file (.ptx), select it, and click Open.

For more information about the demo session,
see the Demo Session Read Me.
Tracks

Toolbar
2



To play the Demo Session:

1 Turn the volume down on your audio interface

so that you don’t play back audio at an

uncomfortably high level.

2 Start playback of the demo session in Pro Tools.

To start or stop Pro Tools, do one of the follow-

ing:

• Press the Spacebar on your computer keyboard.

• Click the Play or Stop button in the Transport

window (Window > Transport) or in the Edit win-

dow toolbar.

3 While the session plays, raise the volume on

your audio interface to a comfortable listening

level.

4 Explore Pro Tools while the demo session plays

back (see the different options available in the

Window menu):

• The Edit window provides a Timeline display of

audio, video, MIDI data, and mixer automation

for recording, editing, and arranging on tracks.

Use the Edit window for editing and arranging

audio, MIDI, and automation data in your ses-

sion.

• The Mix window shows tracks as channel

strips—much like a mixing board—with level

meters and controls for plug-in and hardware in-

serts, sends, input and output assignments, pan-

ning, volume, solo, mute, and record enable. Use

the Mix window for routing and mixing audio

and MIDI in your session.

Stop and Play controls in the Transport window

PlayStop
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• The Transport window provides controls for

transport related functions such as Play, Stop,

Record, Fast Forward, and Rewind.

• Plug-In windows provide controls for audio pro-

cessing and virtual instrument plug-ins.

• MIDI Editor windows let you edit MIDI data

using a “piano-roll” style interface, breakpoint

editing, and traditional music notation.

• The Score Editor window lets you edit the ses-

sion’s MIDI data using traditional music nota-

tion. You can even print the score directly from

Pro Tools.

• The Workspace provides an interactive database

for all of the media in your session as well as for

your system.

5 Press the Spacebar or click the Stop button to

stop playback.

6 When you’re finished checking out the Demo

Session, choose File > Close Session.

The Demo Session is an example of a finished
project that has been arranged, edited, and
mixed. You don’t need to return to the Demo
Session for anything else in this guide, but you
might want to check it out again later, after
you’ve been introduced to a few more
Pro Tools features.
3



Viewing the Edit and Mix Windows
The Edit window and the Mix window are the two main work areas in Pro Tools. Throughout the rest of this

guide, you will see examples of both windows being used for different types of production work.

Viewing the Edit Window

To display the Edit window:
 Choose Window > Edit.
Introduction to Pro Tools
To display all Edit window view options:
 Select View > Edit Window > All.
Edit window
4



Viewing the Mix Window

To display the Mix window:
 Choose Window > Mix.
Introduction to Pro Tools
To display all Mix window view options:
 Select View > Mix Window > All.
Mix window (with Transport and Plug-In windows shown)
5



Creating a New Session
This section shows you how to create a new

session. You can create a new session when you

first launch Pro Tools or while it is already running.

To create a new session:

1 If Pro Tools is not already running, launch

Pro Tools.

2 Do one of the following:

• When launching Pro Tools, if the Quick Start

dialog opens, select Create Blank Session and

click OK.

• Choose File > New Session. If you currently

have a session open, you will be prompted to

save any changes. In the New Session dialog,

select Create Blank Session and click OK.

3 In the Save dialog, navigate to where you want

to save the session, name it, and then click Save.

You have just created a new session with no tracks.

Next, you will connect a microphone or instrument

cable and create new tracks for audio recording.
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Recording Audio
This section shows how to connect a microphone or

instrument (such as a guitar or keyboard) to an

Mbox and record audio.

Connecting a Microphone or Instrument 
to an Mbox

To connect a microphone or an instrument:

1 Do one of the following:

• If you are using a microphone, connect it to a

Mic/Line input on the Mbox using an XLR

cable.

• If you are using an instrument, connect it to a DI

input on the Mbox using a 1/4-inch cable.

2 Do one of the following:

• With an Mbox, ensure that the Front/Rear switch

is set correctly for either a front panel or rear

panel connection.

• With an Mbox Mini, depending on which input

you are using, ensure that the Line/DI switch or

the Mic/Line switch is set correctly for the type

of connection.
Connecting a mic to Mic/Line Input 1 on the rear panel of an Mbox with an XLR cable

Input 1 source selector

(Front/Rear switch)
Input 1

Mic/Line input
6



Creating a Track

Pro Tools uses tracks for recording audio and MIDI

in a session. Before you can record audio, you need

to create an Audio track.

To create and prepare an audio track for recording:

1 Create a new session, or open an existing

session.

2 Choose Track > New.

3 To record a single microphone or instrument

connected to your audio interface, set the New

Tracks dialog for 1 Mono Audio Track, in

Samples, and click Create.

If you want to record both inputs at once, create one

stereo track or two mono tracks depending on what

you have plugged in and what you plan to record:

• To record two different sources (such as one vo-

cal mic and one electric guitar), create 2 Mono
audio tracks. This lets you record two input sig-

nals simultaneously. After recording, these can

be edited, processed, and balanced inde-

pendently.

• To record a two-channel stereo source (such as a

stereo keyboard), create 1 Stereo audio track.

4 Make sure the Mix window is open by choosing

Window > Mix.

Creating a new mono audio track
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5 In the middle of the new track’s channel strip,

notice where it says “Analog 1 (Mono).” This

shows which Input channel (Input 1 or Input 2)

is assigned to this track. (To specify a different

Input channel, click the Audio Input Path

selector and choose the other channel.)

Recording Your Performance to a Track

To record an audio track:

1 Click the track’s Record Enable button to arm

the track for recording. The button flashes red.

2 Sing or play into the mic, or play your

instrument.

Watch the meter level in the Pro Tools track while

you raise the input gain on your audio interface.

(Note that moving the on-screen fader has no effect

on input levels; it’s only for adjusting monitoring
levels.)

Record enabling a track in the Mix window

Audio Input

Path selector

Record Enable button
7



3 Turn up the input gain on your audio interface

until you see the on-screen track meter show

green most of the time, or yellow for louder

passages.

• If the track meter shows red, gain is too high;

lower the input gain.

• If you barely see green in the track meter, gain is

too low; raise the input gain.

Input 1 Gain (Mbox)

Track meter
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4 In the Transport window, click the Return to

Zero button if you want to start recording from

the beginning of the session.

5 Click the Record button in the Transport to

record arm the session. The button flashes red.

(This tells Pro Tools that you are ready to

record—think of this as a “master” record

enable button for the session.)

6 Choose Window > Edit so you can watch what

happens when you record.

7 When you are ready to start recording, press the

Spacebar or click the Play button in the

Transport. The Transport Record button and the

track’s Record Enable button turn solid red

while recording.

8 To stop recording, press the Spacebar again or

click the Stop button in the Transport. (The

Transport Record button disengages, but the

track’s Record Enable button remains enabled

and flashes red until you click it).

You have just recorded your first audio track.

A mono audio track after recording

Return to Zero Play Record
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Listening to Your Recording

After you have recorded some audio, you can play

it back for review, editing, and mixing.

To play back a recorded track:

1 Click the track’s Record Enable button again to

take it out of Record mode. The Record Enable

button stops flashing red.

2 To start playback, press the Spacebar or click

Play in the Transport.

3 To stop playback, press the Spacebar or click

Stop in the Transport.

Recording More Tracks

Simply repeat the same steps to create another

audio track (mono or stereo) and continue

recording more tracks. In this way, you can record

additional parts against the tracks you have

recorded previously. This is a common production

technique for layering different parts to create an

arrangement of a song.
Introduction to Pro Tools
Measuring Time in Minutes 
and Seconds or Bars and 
Beats
Pro Tools lets you measure time in minutes and
seconds (absolute time), or bars and beats (relative

time). For music production, it is often desirable to

measure time in bars and beats. The timing of beats

is relative in that it depends on the tempo. The

timing of bars is relative in that it depends on the

meter.

Pro Tools lets you set tempo and meter changes

using markers in the session Timeline at the top of

the Edit window. These settings scale the relative

time of bars and beats against the absolute time of

minutes and seconds (or samples). This distinction

is referred to in Pro Tools as tick-based (relative)

time versus sample-based (absolute) time, and both

audio and MIDI data can be set to follow either on

a track-by-track basis (for more information, see

the Pro Tools Reference Guide).
Pro Tools Timeline and Main Counter (with the Main Time Scale set to Minutes and Seconds)

Main Counter

Timeline

Grid mode

Timebase

Rulers
9



The Pro Tools Main Time Scale for the session’s

Timeline is set to Min:Secs (minutes and seconds)
by default, but you can change the Main Time

Scale to Bar|Beats (bars and beats) if you want to

record with a click track in a specified meter at a

specified tempo. Setting the Main Time Scale to

bars and beats is also useful if you want to create,

edit, and arrange audio and MIDI on a bar/beat

grid.

Changing the Main Time Scale

To set the MainTime Scale, do one of the following:

 Click a Main Counter selector (located at the top

of the Edit or Transport window (when it is set to

display Counters) and select a Time Scale.

 If a Timebase ruler is displayed, click its name

so it becomes highlighted.

Main Counter selector (in the Edit window)

Setting the Main Time Scale to the timebase
currently displayed in the Sub Counter
switches the two Time Scales, setting the Sub
Time Scale to the previous timebase of the
Main Time Scale.

Setting the Main Time Scale to Bars|Beats
Introduction to Pro Tools
Recording with a Click Track
A click track provides a metronomic click for

tempo reference while recording. Set the Main

Scale to Bar|Beats to record and edit your track

material according to the specified meter and

tempo instead of Min:Secs.

To create a click track:

1 Choose Track > Create Click Track.

Pro Tools creates a new Auxiliary Input track with

the Click II plug-in on the first track insert. When

you start playback or recording, the click provides

a countoff and continues according to the meter and

tempo map in the Pro Tools Timeline.

2 Select View > Transport > MIDI Controls to view

the MIDI controls in the Transport Window.

3 In the Transport, ensure that the Metronome and

Count Off buttons are selected.

4 Ensure that the Conductor button is enabled if

you want the click to follow the session tempo

(on the Timeline). Disable the Conductor button

if you want to adjust the tempo manually.

5 Press the Spacebar or click the Play button in the

Transport to start playback and hear the click.

Tempo

Count Off button

Metronome button

Conductor button
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To set the Click settings:

1 Choose Setup > Click/Countoff.

2 Select one of the following options:

• During play and record—the click sounds during

playback and recording

• Only during record—the click only sounds while

recording and not during playback

• Only during countoff—the click only sounds

when counting off before recording or playback

starts

3 Click OK.

To silence the click track, do one of the following:

 Mute the Click track by clicking the M (Mute)

button in the Track controls for the Click track.

 In the Transport window, deselect the Metro-

nome button so it is not highlighted blue. Then

deselect the Count Off button so it is not high-

lighted. (Doing both silences the click track and

disables Count Off.)

Click/Countoff dialog
Introduction to Pro Tools
Setting the Session Meter
Be sure to set the session meter to match the meter

of your music. If your session’s meter does not

match the music you’re recording, the accented

clicks from the Click track will not line up with

what you’re playing, and, as a result, the recorded

material may not align with the bars and beats grid

in the Edit window.

To set the meter for a session:

1 Double-click the Current Meter button in the

Transport window.

2 Enter the Meter for the session and set the

Location to 1|1|000 (to ensure that the inserted

meter event replaces the default).

3 From the Click pop-up menu, select a note value

for the beat. (For example, if you are in 6/8,

select a dotted-quarter note).

4 Click OK to insert the new meter event.

Current Meter button

Meter Change dialog
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Setting the Session Tempo
New sessions in Pro Tools default to a tempo of

120 BPM. If you want to record with a click at a

tempo other than 120 BPM, make sure to set the

tempo accordingly.

To change the session tempo:

1 Do one of the following:

• Double-click the Song Start Marker in the Edit

window.

• Click the Add Tempo Change button (+) at the

head of the Tempo ruler.

2 In the Tempo Change dialog, enter the BPM

value for the session.

Tempo ruler

Tempo Change dialog

You can type in a specific tempo, or you can
use the T key to tap in the tempo.

Song Start Marker

Add Tempo Change button

Tempo ruler
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3 Set the Location to 1|1|000 (to ensure that the

inserted tempo event replaces the default session

tempo).

4 From the Resolution pop-up menu, select the

note value for the beat. (For example, if you are

in 6/8, select a dotted-quarter note.)

5 Click OK.

Using Manual Tempo Mode
In Manual Tempo mode, Pro Tools ignores tempo

events in the Tempo ruler and instead plays back a

Manual Tempo. This tempo can be set numerically

by tapping in the tempo.

To set tempo manually:

1 Ensure that the MIDI controls are shown in the

Transport by selecting View > Transport > MIDI

Controls.

2 In the Transport, disable the Tempo ruler by

clicking the Conductor button so it is not high-

lighted. Pro Tools switches to Manual Tempo

mode. In this mode, any tempo events in the

Tempo ruler are ignored.

3 Click the Tempo Resolution selector and select a

note value. (For example, if you are in 6/8, select

the dotted-quarter note, or if you are in 3/4,

select the quarter note.)

Manual Tempo mode

Tempo Resolution

Conductor button

Tempo
12



4 To enter a new tempo, do one of the following:

• Click the Tempo value, type a new number, and

press Enter.

• Click the Tempo value and drag up or down to

change the setting. For finer resolution, hold

Command (Mac) or Control (Windows) while

dragging.

• Click the Tempo value and press the “T” key on

your computer keyboard at the desired tempo to

set the value.

Importing Audio
Many music production workflows include using

audio loops and audio from sample libraries. For

example, you can use drum loops instead of a click

track for recording. You can even combine and

arrange audio loops and “one-shot” samples from a

variety of sources to create a whole new piece of

music.

Pro Tools provides a number of ways to import

audio files from different sources into a session.

You can import audio from a hard drive, a network

volume, an audio CD, or removable media using

the Import Audio command, or by dragging from a

Workspace browser, or from the Finder (Mac) or

Windows Explorer (Windows).
Introduction to Pro Tools
Using the Import Audio 
Command
The Import Audio command lets you import audio

files or clips into your Pro Tools session.

To import audio files or clips into a session using

the Import Audio command:

1 Choose File > Import > Audio.

2 In the Import Audio dialog, locate and select an

audio file to display its properties and associated

clips.

3 To preview a selected file or clip before you

import it, click the Play button in the Import

Audio dialog. Click the Stop button to stop

preview. You can adjust the preview volume

with the vertical slider. To navigate to a

particular location in the file, use the horizontal

slider under the Play and Stop buttons.

Import Audio dialog

The Preview Volume control in the Import
Audio dialog also affects the preview volume
when auditioning clips in the Clip List.
13



4 Do any of the following:

• To place a file or clip in the Import list, select the

file and click Add or Convert.

• To import all files and clips in the current direc-

tory, click Add All or Convert All.

• To remove a file or clip from the Import list, se-

lect it and click Remove.

• To remove all files and clips, click Remove All.

5 When you have added all audio files and clips

you want to the Import list, you can apply

sample rate conversion by doing the following:

• Enable Apply SRC.

• Specify the Source Sample Rate either by typing

a number, or by selecting a sample rate from the

pop-up menu.

• Select the sample rate conversion quality from

the Quality pop-up menu. This setting overrides

the Sample Rate Conversion Quality setting in

the Processing Preferences page.

6 Click Done.

7 If you are copying or converting files, select a

location for the new files, such as the Audio

Files folder for the current session. When adding

files, the file is referenced from its original

location.

Pro Tools lets you add files to a session that
are at a different sample rate than the ses-
sion. In the comments field of the Import Au-
dio dialog, a warning is posted that these
files will play back at the wrong speed and
pitch if they are not converted.
Introduction to Pro Tools
8 In the Audio Import Options dialog, select

where the imported files will go in the session:

New Track Each audio file is imported into its own

individual track and into the Clip List.

Clip List Audio files are imported into the Clip List

without creating a new track. Imported audio files

appear in the Clip List and can then be dragged to

audio tracks.

9 If you chose to create a new track, select a

location for the imported file in the track:

Session Start Places the file or clip at the start of

the session.

Song Start Aligns the beginning of the file or clip

to the Song Start marker.

Selection Aligns the beginning of the file or clip to

the edit cursor or to the beginning of a selection in

the Timeline.

Spot Displays the Spot dialog, which lets you spot

the file or clip to a precise location based on any of

the available Time Scales.

10 Click OK.

Audio Import Options dialog
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Importing Files by Dragging
Pro Tools lets you import audio, MIDI, video, and session files by dragging files from a Workspace

browser, the Mac Finder, or Windows Explorer to the Pro Tools application icon, the session Timeline, a

track, the Track List, or the Clip List.
Introduction to Pro Tools
Importing from the Workspace by dragging

Workspace

Drag media or session files to

existing tracks, or to the Track

List to add as new tracks

Drag files to the Clip

List to import
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The preceding figure illustrates some of the

options available to import files by dragging from a

Workspace browser.

To import files into the Clip List:

1 Select audio, video, MIDI, clip group, REX, or

ACID files in a Workspace browser, or in the

Mac Finder or Windows Explorer.

2 Drag the selected files onto the Clip List.

To import files into an existing track:

1 Select the files you want to import in a

Workspace browser, or in the Mac Finder or

Windows Explorer.

2 Drag the selected file to a location on a

compatible track.

To import files as new tracks:

1 Select the files you want to import in a

Workspace browser, or in the Mac Finder or

Windows Explorer.

2 Do any of the following:

• Shift-drag files anywhere in the Edit window.

• Drag files to the Track List.

• Drag files to empty space in the Edit window, be-

low or between tracks.
Introduction to Pro Tools
Editing Audio
Pro Tools lets you edit audio on tracks by

trimming, separating, cutting or copying and

pasting, moving, re-arranging, and more.

Trimming Audio Clips
The following example shows you how to do a

simple edit to change where a song starts. In this

example, the drummer is heard “counting off” the

tempo (“1...2...1.2.3...”) before the song starts (let’s

assume this stereo track recorded the overhead

mics on the drum kit). Here’s what the audio looks

like in Pro Tools.

The stereo waveforms let you visualize the

different sections of the song. You can take

advantage of this “what you see is what you hear”

aspect of Pro Tools to be able to quickly silence the

countoff by “trimming” the beginning of the song.

countoff song start waveforms
(left and right
channels)
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To trim an audio clip:

1 Click to select the Trim tool (located in the Edit

window Toolbar).

2 Click in the track after the countoff and before

the start of the song (you’ll see the cursor

display the Trim icon). Drag right to trim the

beginning of the clip in, or drag left to trim the

beginning of the clip out.

You can “untrim” the clip by clicking and dragging

back to the left with the Trim tool. You’ll see that

the previous audio (the countoff) is still there. This

is an example of how Pro Tools lets you edit non-
destructively.

Copying and Pasting Clips
The following example shows you how to copy and

paste an audio clip on a track to different timeline

and track locations in a session. This example uses

an imported rhythmic audio loop.

To copy and paste a clip:

1 Import a rhythmic audio loop into a Pro Tools

session (see “Importing Audio” on page 13).

2 Click to select the Grabber tool or the Selector

tool (located in the Edit window Toolbar).

Trim tool

song start
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3 If using the Grabber tool, click the clip you want

to copy and paste. If using the Selector tool, dou-

ble-click the clip you want to copy and paste.

4 Choose Edit > Copy.

5 With the Selector tool, place the Edit cursor at

the location where you want to paste the copied

clip.

Edit Tools

Use the Smart Tool to have the Edit cursor
switch between different Edit tools,
depending on where you place it over a clip.

Selecting a clip with the Grabber tool

Smart Tool

Selector tool

Grabber tool
17



6 Choose Edit > Paste.

Separating and Rearranging 
Clips
There are many ways to create new audio clips in

Pro Tools. You can import or record whole file
audio clips. You can also create audio clips that

only refer to parts of audio files by trimming (see

“Trimming Audio Clips” on page 16) or by

separating whole file clips.

The following example demonstrates different

ways that you can separate and rearrange audio

clips in a session. This example uses an imported

rhythmic audio loop.

Pasting a clip to a different time location on a different
track

Press Command+C (Mac) or Control+C
(Windows) to copy the current Edit selection to
the clipboard. Press Command+V (Mac) or
Control+V (Windows) to paste the contents of
the clipboard to the current Edit location.
Introduction to Pro Tools
Separating Clips at the Edit Selection

To separate a clip at the current Edit location:

1 With the Selector tool, make an Edit selection

within an audio clip.

2 Choose Edit > Separate Clip > At Selection.

Making an Edit selection

Press Command+E (Mac) or Control+E
(Windows) to separate clips at the current Edit
selection.

New clips created by separating the parent clip at the
boundaries of the Edit selection

Use Edit > Separate Clip > On Grid to separate
the audio selection according to the current
grid. This is useful when working with audio on
a Bar|Beat grid. Use Edit > Separate Clip > At
Transients to separate the audio selection
according to individual attacks in the audio.
This is useful for separating audio out into
individual “hits,” such as each hit in a drum
loop or each note in a guitar riff.
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Rearranging Separated Clips

There are many ways to rearrange clips in

Pro Tools. The selected Edit mode (set in the left-

most section of the Edit window Toolbar)

determines how Pro Tools handles audio clips

when you move them. The following provides just

a few of the many possibilities for arranging audio

clips in your Pro Tools session.

To rearrange clips, do any of the following:

 With the Grabber tool in Slip mode, drag an

audio clip to a new location. The clip moves to

the exact location where you moved it.

 With the Grabber tool in Grid mode, drag an

audio clip to a new location. The clip snaps to

the nearest grid location where you moved it.

 With the Grabber tool in Spot mode, drag an

audio clip to a new location. The Spot dialog

opens and you can specify an exact time location

for the clip.

 With the Grabber tool in Shuffle mode, drag an

audio clip to a new location between other clips.

Adjacent clips shuffle to make room for the

moved clip.

 Select a clip with the Grabber or Selector tool

and choose Edit > Duplicate. The selected clip is

duplicated and placed directly after the current

selection.

Edit modes, Grid mode selected
Introduction to Pro Tools
 Select a clip with the Grabber or Selector tool

and choose Edit > Repeat. In the subsequent

Repeat dialog, enter the number of times you

want to repeat the selection and click OK. The

selection is repeated as separate clips, which are

then placed one after the other.

A rhythmic audio loop separated at transients and
“shuffled”

For more information about editing and
arranging audio, see the sections on Edit
Modes and Edit Tools, Clip Groups, and
Elastic Audio in the Pro Tools Reference
Guide.
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Sequencing MIDI with a 
Virtual Instrument Plug-In
The following provides an example of how to

program a MIDI sequence on an Instrument track

to play a virtual instrument plug-in. This example

uses the Xpand!2 plug-in from AIR Music

Technology.

What is MIDI?
MIDI (Musical Instrument Digital Interface) data is

not audio. MIDI does not generate sound. MIDI is

a way for MIDI-equipped devices—like

synthesizers, samplers, controllers, keyboards, and

sequencers—to communicate control data, to

“talk” to one another. MIDI effectively tells sound

generating devices (like hardware synthesizers or

samplers, or software virtual instruments) what to

play.

USB and FireWire-compatible MIDI interfaces

send and receive MIDI messages to and from the

computer over USB or FireWire. Hardware MIDI

instruments are connected using MIDI cables to the

MIDI inputs and outputs on your MIDI interface.

Virtual instruments are inserted as plug-ins on

Instrument tracks in Pro Tools and accessed

directly from within Pro Tools.

The Xpand!2 plug-in is part of the AIR
Creative Collection, which is bundled with
Pro Tools as a separate, downloaded installer.
Be sure to run the AIR Creative Collection
Installer, including the associated content,
before proceeding with this example. For more
information, see the AIR Creative Collection
Plug-Ins Guide.
Introduction to Pro Tools
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Creating an Instrument Track with an Instrument Plug-In
You can use either an Instrument track or a MIDI track to record, program, and play back MIDI sequences

in Pro Tools. If you are working with virtual instrument plug-ins (such as Xpand!2 from AIR), you will

generally want to use an Instrument track. Instrument tracks let you both work with MIDI sequences and

monitor audio.

You can also use Instrument tracks with external MIDI devices.

To create an Instrument track and insert an instrument plug-in:

1 Choose Track > New. In the New Track dialog, do the following:

• Select Stereo.

• Click the pop-up menu that shows Audio Track and select Instrument Track.

• Click Create.

2 If necessary, select Window > Mix to show the Mix window.

3 Click the track Insert selector near the top of the Instrument track and select Xpand2 from the Instrument

submenu.

New Track dialog, Stereo and Instrument track selected
Introduction to Pro Tools
Inserting the Xpand!2 plug-in on an Instrument track

Insert

selector
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4 A plug-in window appears showing the Xpand!2 plug-in.You can now select a sound preset to play using

MIDI.

To select a preset sound in the Xpand!2 plug-in:

 At the top of the plug-in window, click the Librarian menu (<factory default>) and select a preset from

any of the sub-menus. With Xpand!2, presets are grouped in sub-menus by category.

For more information about the Xpand!2 plug-in, see the AIR Creative Collection Plug-Ins Guide.
Introduction to Pro Tools
Selecting an Xpand!2 factory preset from the Plug-In Librarian menu
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Playing a Virtual Instrument
You can play a virtual instrument (such as

Xpand!2) using a MIDI sequence or from an

external MIDI controller.

To play a virtual instrument using an Instrument

track, do one of the following:

 If you have a MIDI controller connected, you

can play the virtual instrument as long as the

Instrument track on which it is inserted is

selected or record enabled. You can record your

performance as a MIDI sequence while you

play.

 Import a MIDI sequence (or program a MIDI

sequence) to the Instrument track on which the

virtual instrument is inserted, and then start

playback.

Recording MIDI with an External 
Controller
Pro Tools lets you record MIDI data from a MIDI

controller.

To record MIDI on an Instrument Track:

1 Make sure your MIDI controller is connected

either to a MIDI interface with MIDI cables or

directly to your computer with a USB cable.

2 Create a stereo Instrument track and insert

Xpand!2 on it (see “Creating an Instrument

Track with an Instrument Plug-In” on page 21).

3 Select a bass preset (also known as a “patch”).

4 Select Options > MIDI Thru. (Verify that MIDI

Thru is checked; if not, select it.)

5 Click the track’s Record Enable button to enable

the Instrument track for MIDI recording.

6 In the Transport window, click the Record

button.
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7 Play your MIDI controller’s keyboard. You

should hear the sound you selected.

8 When you are ready to start recording, click Play

or press the Spacebar. To stop, click Stop or

press the Spacebar.

9 Click the track Record Enable button again to

take it out of record enable and play back what

you just recorded.

Penciling In a MIDI Sequence
You can program a MIDI sequence in Pro Tools

using the Pencil tool.

To insert a MIDI Note on a track in the Edit window:

1 In the Edit window, set the Instrument track (or

MIDI track) to Notes view.

Recorded MIDI data on an Instrument track

When inserting MIDI notes or other MIDI
data with the Pencil tool, MIDI clip
boundaries are created on the nearest
barlines.

Selecting Notes view on an Instrument track
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2 Select the Pencil tool and make sure it is set to

Free Hand. The cursor will change to the Pencil

tool when located over the playlist area of a

MIDI or Instrument track in Notes view.

3 To insert quarter notes on the beat, do the

following:

• Set the Main Time Scale to Bars|Beats.

• Set the Edit mode to Grid.

• Set the Grid value to quarter note.

• Set the Default Note Duration value either to

quarter note (or to Follow Grid).

4 Move the Pencil tool into the playlist area for the

MIDI or Instrument track. Use the Edit

window’s ruler and the track’s mini-keyboard as

a reference to locate the pitch and time location

you want.

When using the Pencil tool, the Cursor location and

value are displayed in the Window Toolbar.

Cursor location and value

Cursor pitch location

Cursor Timeline location

Pencil Cursor
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5 When you reach the pitch and time location you

want, click to insert the note.

The velocity for inserted notes is determined by the

Default Note On Velocity setting. The duration is

determined by the Default Note Duration value.

When in Grid mode, the Note On location is deter-

mined by the Grid value.

If the Play MIDI Notes When Editing option is en-

abled, each note sounds as it is inserted.

The Pencil tool can be dragged after clicking (and

before releasing) to adjust the note’s pitch or

duration. Drag right to lengthen the note without

changing its start point. Drag left to shorten the

note without changing its end point.

Editing MIDI Notes
MIDI notes can be edited in the Edit window or in

a MIDI Editor window, including start and end

points, duration, pitch, and velocity. The Selector,

Grabber, Trim, and Pencil tools can operate on

individual notes or groups of notes.

MIDI note inserted with the Pencil tool

With Grid mode enabled, the start point of the
MIDI note snaps to the nearest Grid
boundary by default. With the Free Hand
Pencil tool, hold Command (Mac) or Control
(Windows) while clicking to temporarily
suspend Snap to Grid.

With the Grid mode enabled, the end point of
the MIDI note snaps to the nearest Grid
boundary by default. Command-drag (Mac)
or Control-drag (Windows) with the Pencil
tool to temporarily suspend Snap to Grid.
24



Selecting MIDI Notes

MIDI notes must be selected before they can be

edited.

To select MIDI notes:

1 Set the MIDI or Instrument track to Notes view.

2 Do one of the following:

 With the Pencil tool or any Grabber tool, Shift-

click each note.

 With any Grabber tool, move the cursor to where

there are no notes (the Marquee appears) and

draw a rectangle around the group of notes you

want to edit.

When using a Grabber tool, if any portion of the

rectangle touches a note (either its start or end

point), the note is included in the selection.

 With the Selector tool, drag across a range of

notes.

When using the Selector tool, a note’s start point

must be included in order for it to be selected.

Selecting notes with a Grabber tool

Selecting notes with the Selector tool
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Transposing Notes

MIDI notes can be transposed by dragging them up

or down with the Pencil tool or any Grabber tool. If

several notes are selected before dragging, each

note is transposed.

To transpose a MIDI note:

1 Set the MIDI or Instrument track to Notes view.

2 Select the Pencil tool or any Grabber tool.

3 While holding Shift, drag the note up or down.

The Shift key ensures that the transposed note

maintains its original start point on the Pro Tools

Timeline.

While dragging, each new note sounds and the

Cursor Location Value indicator (in the Edit

window) indicates the number of semitones and

direction (+/–) for the transposition.

Transposing with a Grabber tool

Hold Control (Mac) or Start (Windows) and
press Plus (+) on the numeric keypad to
transpose the selected MIDI notes up by one
semitone, or press Minus (–) on the numeric
keypad to transpose the selected MIDI notes
down by one semitone.

To transpose a copy of the note, leaving the
original unchanged, hold Option (Mac) or Alt
(Windows) while dragging.
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Moving Notes

Like clips, MIDI notes can be dragged left or right

with the Pencil tool or any Grabber tool to change

their start point on the Pro Tools Timeline. If

several notes are selected before dragging, they are

all moved together.

To move a MIDI note:

1 Set the MIDI or Instrument track to Notes view.

2 With the Pencil tool or any Grabber tool, drag

the note left or right (press Shift while dragging

to preserve the note’s pitch).

As the note is dragged, the Cursor Location Value

indicator (in the Edit window) displays the new

start point.

If the Edit mode is set to Grid, the dragged note

snaps to the nearest Grid boundary. If the Edit

mode is set to Spot, the Spot dialog opens.

To copy the selected notes, leaving the
originals intact, hold Option (Mac) or Alt
(Windows) while dragging.
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Trimming Note Start and End Times

Like clips, start and end points for MIDI notes can

be adjusted with the Trim tool. If several notes are

selected when performing the trim, each note is

changed.

To change the start or end points for a group of

MIDI notes:

1 Set the MIDI or Instrument track to Notes view.

2 Select the notes you want to trim.

3 Do one of the following:

• Select the Trim tool.

• Use the Pencil tool.

4 Move the cursor near the beginning of any of the

highlighted notes, so the Trim tool appears.

Drag right to shorten the notes, or drag left to

lengthen them.

If the Edit mode is set to Grid, the dragged start or

end point snaps to the nearest Grid boundary. If the

Edit mode is set to Spot, the Spot dialog opens,

where you can enter the new location for the note’s

start or end point.

Changing note end times with the Trim tool

When in Grid mode, use the Command key
(Mac) or the Control key (Windows) to tem-
porarily disable Grid mode.
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Manually Editing Note Velocities

When a MIDI or Instrument track is set to Velocity

view, or when the Velocity lane is revealed under a

track, each note’s attack velocity is represented

with a velocity stalk. The taller the velocity stalk,

the higher the velocity value (0–127).

To edit MIDI velocity in the Edit window:

1 Do one of the following:

• Set the MIDI or Instrument track to Velocity

view.

• Reveal the Controller lane for the MIDI or In-

strument track and show Velocity.

2 Select any Grabber tool.

3 Drag the top (diamond) of the velocity stalk up

or down.

Revealing the Velocity Lane

Dragging a velocity stalk

The velocities for a range of notes can be
edited with any Pencil tool.
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Deleting MIDI Notes

In addition to deleting selected notes with the Clear

command in the Edit menu, individual notes can

also be deleted with the Pencil tool.

To delete a group of MIDI notes with the Clear

command:

1 Select the notes to be deleted.

2 Do one of the following:

• Choose Edit > Clear to delete the selected notes.

The track’s underlying controller data remains

intact.

• With any Edit tool, Right-click any selected note

and choose Clear.

• Press the Delete (Mac) or the Backspace (Win-

dows) key.

To delete a single MIDI note with the Pencil tool:

 With the Pencil tool selected, Option-click

(Mac) or Alt-click (Windows) the note. The

Pencil tool changes to an Eraser when Option

(Mac) or Alt (Windows) is pressed.

When deleting MIDI notes within a time
range selection, all underlying controller
and automation data is also deleted.

Deleting a note with Pencil tool

Program change events and Sysex events can
also be deleted by Option-clicking (Mac) or
Alt-clicking (Windows) them with the Pencil
tool.
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Mixing and Plug-In 
Processing
Mixing in Pro Tools involves working with

elements of audio signal flow, including inputs,

outputs, buses, inserts, and sends, for purposes of

submixing and mixdown.

In addition to the final mixdown, mixing tasks can

occur any time during a session.

During mixing, real-time plug-ins and hardware

inserts provide effects and signal processing.

Pro Tools comes with a suite of audio effects

processing plug-ins that you can use to change the

sounds you’ve recorded. This section shows two

examples of how to use plug-ins to process your

sound.

For detailed information about the plug-ins
included with Pro Tools, see the Audio Plug-
Ins Guide (Help > Audio Plug-Ins Guide).
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Applying Equalization and 
Compression
Typically, when mixing audio, you will want to

apply equalization and compression on individual

tracks to get your audio to sound just right.

Equalization (EQ) Lets you shape the frequency

spectrum of the sound. A simple example equaliza-

tion is the bass and treble controls on many stereo

systems. You can use these controls to boost (make

louder) or attenuate (make quieter) the low fre-

quencies and the high frequencies of the audio.

You can use EQ to help separate the bass and gui-

tar, to sharpen the drums, emphasize the vocals,

and even to cut out unwanted noise. Pro Tools pro-

vides several different types of EQ plug-ins for

sculpting your sound.

Compression Lets you smooth the dynamics of

your audio. It acts like an automatic volume control

by keeping the loud parts from getting too loud.

You can use compression to make vocals sound

more intimate, or to keep cymbals from sounding

too shrill. Use a limiter to keep peaks in the audio

signal from exceeding a certain threshold without

affecting audio that doesn’t exceed that level.

Pro Tools provides several different types of dy-

namics plug-ins for shaping the dynamics your

sound.
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To apply EQ to a track:

1 Choose Window > Mix.

2 In the top part of the track, click the next Track

Insert selector and choose EQ 3 7-Band from the

EQ submenu.

Insert selector for a track in the Mix window
Introduction to Pro Tools
3 The EQ III Plug-In window opens. You can use

the plug-in presets as a starting point for

exploring how different settings affect the

sound.

4 Start playback to hear the effect.

EQ III Plug-In window, Plug-In Preset selector
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To apply compression to a track:

1 Choose Window > Mix.

2 In the top part of the track, click the next Track

Insert selector and choose Dyn 3

Compressor/Limiter from the Dynamics

submenu. Pro Tools inserts the Dynamics III

Compressor/Limiter plug-in on your track and

opens its plug-in window.

3 The Dyn III Plug-In window opens.You can use

the plug-in presets as a starting point for

exploring how different settings affect the

sound.

4 Start playback to hear the effect.

Dyn III Plug-In window, Plug-In Preset selector
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Using Reverberation
Reverberation (Reverb) provides a sense of room

acoustics. Reverb effects are essentially a bunch of

delays that are used to mimic the reflection of

sound off of surfaces in different rooms, halls, and

other spaces. You can use reverb effects to create a

sense of space for your entire mix using sends from

your source tracks and processing using an

Auxiliary Input track. Reverb effects can make

your mix sound like it is in a big concert hall, an

intimate room, or even a narrow hallway.

One of the best ways to incorporate reverb in your

mix is in a “send-and-return” configuration. In

Pro Tools, using sends from tracks makes it easy to

route audio from multiple tracks to and through the

same reverb effect. This way, your source tracks

will all sound as if they are in the same room.
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To use reverb with an Auxiliary Input track and multiple source tracks:

1 Choose Window > Mix.

2 Choose Track > New, and set it to create 1 stereo Auxiliary Input track, then click Create.

3 On the Auxiliary Input track you just added, click the Track Input selector and select Bus > Bus 1–2.

Creating a new Auxiliary Input track
Introduction to Pro Tools
Selecting Bus 1–2 from the Input selector on an Auxiliary Input track

Track Input

selector
31



4 Click Send selector A on your source track as shown below and select Bus > Bus 1-2.
Introduction to Pro Tools
5 Repeat the previous step for each additional track that you want to send to the Auxiliary Input track for

reverb processing.

Selecting Bus 1–2 for Send A on an audio track

Send A

selector
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6 Insert a Reverb plug-in on the Auxiliary Input track.
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7 You can use individual Send Output windows to adjust the Send level from source tracks; or, you can set

the Sends view to display the send controls for a particular send (for example, select View > Sends A–E

> Send A).

8 Press the Spacebar and slowly raise the small fader in the Send Output window or in the Sends track

controls. This adjusts how much of the source track you are sending to the Auxiliary Input track for

Reverb processing.

9 Keep playing and listening, adjusting the individual track send levels, and checking out different plug-in

settings to find just the right effect for your mix.

Bussing sends from audio tracks to an Auxiliary Input track for reverb processing with D-Verb
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Using Automation
Pro Tools features dynamic automation of mixing

controls on each of the track types. You can write

automation moves and view them in real time

during playback of your session. You can also edit

automation data with many if the same techniques

you use to edit audio and MIDI data.

Writing Automation

You can write automation for all write-enabled

controls by moving those controls during playback.

To write automation on tracks:

1 Choose Window > Automation.

2 Make sure the automation type is write-enabled.

Automation window, volume automation enabled

Automation

window

Track

Automation

Mode

selector

Moving Volume

Fader during

playback
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3 In the Mix or Edit window, click the Automation

Mode selector on each of the tracks you want to

automate, and set the Automation mode. For the

initial automation pass, select Write.

4 Start playback to begin writing automation.

5 Move the controls you want to automate (such

as a track Volume fader).

6 When you have finished, stop playback.

7 Switch the Automation mode back to Read to

play back the automation you just wrote.

Manually Editing Automation

For all tracks in a session, Pro Tools provides

several ways to edit automation data. You can edit

automation data graphically by adjusting

breakpoints in any automation playlist. You can

also cut, copy, and paste automation data in the

same manner as audio and MIDI data.

Automation data takes the form of a line graph with

editable breakpoints.

After the first automation pass, you can write
additional automation to the track without
completely erasing the previous pass by
choosing Touch mode or Latch mode. These
modes add new automation only when you
actually move a control.

Automation breakpoint
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By dragging these breakpoints, you can modify the

automation data directly in the Edit window and

MIDI Editor windows. When you drag an

automation breakpoint up or down, the change in

value is indicated.

Dragging an automation breakpoint to the left or

right adjusts the timing of the automation event.

To view the breakpoint automation type on any

track, either select the corresponding Track View

or reveal the corresponding Automation or

Controller lane under the track. For example, you

can view and edit Volume, Panning, Mute, MIDI

controller data, or even plug-in automation.

Automation breakpoint value

Track View and Automation lanes

Track View

selector

Automation

Type selector

Automation

lanes

Volume

automation

track view
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Using the Grabber Tools

The Grabber tools let you create new breakpoints

by clicking on the graph line, or adjust existing

breakpoints by dragging them. Option-click (Mac)

or Alt-click (Windows) breakpoints with a Grabber

tool to remove them.

Using the Pencil Tool

The Pencil tool lets you create new breakpoints by

clicking once on the graph line. Option-click (Mac)

or Alt-click (Windows) breakpoints with the Pencil

tool to remove them.

Using the Trim Tools

The Trim tools let you adjust all selected

breakpoints up or down by dragging anywhere

within that selection.

Using the Grabber tool to create a new breakpoint

Using the Pencil tool to delete a breakpoint

Using the Trim tool to move breakpoints
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Exporting Your Mix
After you’ve finished recording, editing, and mixing tracks in a Pro Tools session, you’re ready to mix down
your session and export the results for burning to CD or publishing on the Internet. You can use the Bounce

to Disk command to export your mix from the session to a single audio file.

To export the mix from your session as a stereo audio file:

1 Use the Selector to select the length of the session in the Timeline (or on a track).
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Making a Timeline selection to Bounce to Disk

Timeline selection

Session audio

selected and ready

to Bounce to Disk

Selector tool
2 Choose File > Bounce to > Disk.

Bounce dialog
3 In the Bounce Options dialog, do the following:

• Select the as the Bounce Source (this will be the

main channel path for your mix, such as main

(Stereo) –> Analog 1–2).

• Select the File Type (for example, WAV).

• Select Interleaved for the Format.

• If you will be burning the bounced audio file to

CD, select 16 Bit for the Bit Depth.

• If you will be burning the bounced audio file to

CD, select 44.1 kHz for the Sample Rate.

• For faster than real-time Bounce, select the

Offline option.

4 Click Bounce. (If you didn’t make a Timeline

selection, the entire session will bounce from

start to finish.)
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5 In the Save dialog, type the name for the audio

file you are bouncing, and select the location

where you want it saved.

6 Click Save.

Pro Tools begins the bounce to disk.

If the Offline option is not enabled, Pro Tools

bounces are done in real time, so you can hear

audio playback of your mix during the bounce.

(However, you cannot adjust any Pro Tools

controls during a bounce.)

Burning Your Mix to CD
After the bounce is completed, you will have an

audio file that you can burn to an audio CD using

CD burning software (such as iTunes or Roxio

Toast) that can be played on standard CD players.

Listening to a reference CD in an environment

other than your studio is a time-tested way to hear

how your mix translates to other systems and

listening environments.
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Learn More
We hope this quick introduction to Pro Tools has

inspired you to make music. To learn more about

any of the topics presented here, see the Pro Tools
Reference Guide (Help > Pro Tools Reference

Guide) for complete details on all Pro Tools

systems and software. The Pro Tools Reference
Guide provides a thorough explanation of all

Pro Tools features and concepts, organized by

audio and music production tasks (such as

Recording, Editing, and Mixing).

You can also use the online Pro Tools Help

(Help > Pro Tools Help) to search for specific

topics.
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Introduction à Pro Tools
Ce guide est destiné aux nouveaux utilisateurs de

Pro Tools® | Software. Il fournit des exemples

présentant les méthodes d'enregistrement, d'édition

et de mixage audio ainsi que d'utilisation du MIDI

dans Pro Tools.

Si vous n'avez pas encore installé Pro Tools, suivez

les instructions du Guide d'installation de Pro Tools.
Pour obtenir des informations de connexion et

d'installation des pilotes de votre matériel audio,

reportez-vous à sa documentation.
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Connexion d'un casque ou de 
haut-parleurs
Pour entendre l'audioprovenantde Pro Tools, connectez

un casque ou des haut-parleurs à votre matériel audio

(ce guide prend l'exemple d'une interface audio

Pro Tools | Mbox®). Si vous utilisez un casque,

baissez tout d'abord son niveau (sens inverse des

aiguilles d'une montre). Pour des haut-parleurs,

baissez le niveau de volume Master (sens inverse des

aiguilles d'une montre). Il est important de partir

d'un volume suffisamment faible afin d'éviter

d'endommager votre ouïe ou votre matériel. Après

avoir lancé Pro Tools et ouvert ou créé une session,

ajustez les commandes de volume pour définir un

niveau d'écoute confortable.
Connecteurs et commandes du panneau avant d'une Mbox

Connecteurs pour haut-parleurs du panneau arrière d'une Mbox

Volume du casque

Bouton de volume Master

Prise casque 6,35 mm
38



Lecture de la session de 
démonstration
Utilisez la session de démonstration pour tester

votre casque et vos haut-parleurs et commencer à

découvrir les possibilités de Pro Tools.

Pour installer et ouvrir la session de démonstration :

1 Effectuez l'une des opérations suivantes :

• Insérez le disque d'installation de Pro Tools dans

votre lecteur DVD, recherchez et ouvrez le dossier

Additional Files, puis faites glisser le dossier Demo

Session sur votre disque dur (pour des performances

optimales, utilisez un disque dur externe qualifié

par Avid plutôt que le disque système).

• Depuis votre compte Avid en ligne, téléchargez

la session de démonstration de Pro Tools sur votre

disque dur (pour des performances optimales,

utilisez un disque dur externe qualifié par Avid

plutôt que le disque système).
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2 Démarrez Pro Tools.

3 Effectuez l'une des opérations suivantes, selon

ce qui est affiché à l'écran :

• Si la boîte de dialogue Démarrage rapide

s'affiche, cliquez sur Ouvrir une session, puis sur

OK. Naviguez jusqu'au fichier Demo Session

(.ptx), sélectionnez-le, puis cliquez sur Ouvrir.

• Si la boîte de dialogue Démarrage rapide

n'apparaît pas, sélectionnez Fichier > Ouvrir une

session puis naviguez jusqu'au fichier Demo

Session (.ptx), sélectionnez-le et cliquez sur Ouvrir.

Pour de plus amples informations sur la session
de démonstration, reportez-vous au fichier
Lisez-moi associé.
Pistes

Barre

d'outils
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Pour lancer la lecture de la session de démonstration :

1 Baissez le volume sur votre interface audio afin que

le niveau de lecture audio ne soit pas trop élevé.

2 Lancez la lecture de la session de démonstration

dans Pro Tools. Pour lancer ou interrompre la

lecture dans Pro Tools, effectuez l'une des

opérations suivantes :

• Appuyez sur la barre d'espace de votre clavier.

• Cliquez sur le bouton Play ou Stop de la fenêtre

de transport (Fenêtre > Transport) ou de la barre

d'outils de la fenêtre d'édition.

3 Pendant que la session est en cours de lecture,

montez le volume sur votre interface audio pour

obtenir un niveau d'écoute confortable.

4 Explorez Pro Tools en poursuivant la lecture de

la session de démonstration (découvrez les

différentes options du menu Fenêtre) :

• La fenêtre d'édition présente les données audio,

MIDI, vidéo et d'automation du mixeur sur une

timeline, réparties sur des pistes qui permettent

d'enregistrer, d'éditer et d'organiser vos projets.

Utilisez la fenêtre d'édition pour éditer et

manipuler les données audio, MIDI et

d'automation de votre session.

Commandes Play et Stop de la fenêtre de transport

LectureArrêt
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• La fenêtre de mixage affiche les pistes sous la

forme de tranches, comme sur une console de

mixage, avec des indicateurs de niveau et des

commandes pour les inserts de plug-ins et

matériels, les départs, les assignations d'entrée et

de sortie, le panoramique, le volume, les fonctions

solo et mute et l'activation pour l'enregistrement.

Utilisez la fenêtre de mixage pour le routing et le

mixage audio et MIDI de votre session.

• La fenêtre de transport fournit des commandes

exécutant des fonctions relatives au transport, telles

que lecture, arrêt, enregistrement, avance

rapide et retour rapide.

• Les fenêtres de plug-in fournissent des commandes

pour les plug-ins de traitement audio et d'instrument

virtuel.

• La fenêtre de l'éditeur MIDI permet d'éditer les

données MIDI à partir d'une interface de type

« rouleau à musique », d'ajuster les points

d'automation ou même de les afficher sous forme

de notation musicale traditionnelle.

• La fenêtre de l'éditeur de partition permet d'éditer

les données MIDI de la session sous la forme de

notation musicale traditionnelle. Vous pouvez

également imprimer la partition directement à

partir de Pro Tools.

• L'espace de travail permet d'accéder à une base

de données interactive constituée de tous les médias

présents dans votre session ainsi que sur votre

système.

5 Appuyez sur la barre d'espace ou cliquez sur le

bouton Stop pour interrompre la lecture.
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6 Lorsque vous aurez découvert l'ensemble de la

session de démonstration, sélectionnez Ficher >

Fermer la session.

La session de démonstration est un exemple
typique de projet arrangé, édité, mixé, puis
finalisé. Les sections suivantes de ce guide ne
se réfèrent pas à la session de démonstration,
mais vous pouvez la réutiliser ultérieurement,
une fois que vous saurez utiliser plus de
fonctionnalités de Pro Tools.
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Affichage des fenêtres d'édition 
et de mixage
Les fenêtre d'édition et de mixage sont les deux

principales zones de travail dans Pro Tools. Tout

au long de ce guide, vous trouverez des exemples

d'utilisation de ces deux fenêtres pour différentes

tâches de production.

Affichage de la fenêtre d'édition

Pour afficher la fenêtre d'édition :

 Sélectionnez Fenêtre > Édition.

Pour afficher tous les composants de la fenêtre

d'édition :

 Sélectionnez Afficher > Vue de la fenêtre

d'édition > Tout.
Fenêtre d'édition
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Affichage de la fenêtre de mixage

Pour afficher la fenêtre de mixage :
 Sélectionnez Fenêtre > Mixage.
Introduction à Pro Tools
Pour afficher tous les composants de la fenêtre de mixage :
 Sélectionnez Afficher > Vue de la fenêtre de

mixage > Tout.
Fenêtre de mixage (avec fenêtres de transport et de plug-in)
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Création d'une nouvelle 
session
Cette section explique comment créer une nouvelle

session. Vous pouvez créer une nouvelle session

immédiatement après avoir lancé Pro Tools, ou

lorsqu'il est en cours d'exécution.

Pour créer une nouvelle session :

1 Si Pro Tools n'est pas en cours d'exécution,

lancez l'application.

2 Effectuez l'une des opérations suivantes :

• Lors du lancement de Pro Tools, si la boîte de

dialogue Démarrage rapide s'ouvre,

sélectionnez Créer une session vierge et cliquez

sur OK.

• Sélectionnez Fichier > Nouvelle session. Si une

autre session est ouverte, un message vous

invitera à enregistrer les modifications. Dans la

boîte de dialogue Nouvelle session,

sélectionnez Créer un session vierge et cliquez

sur OK.

3 Dans la boîte de dialogue d'enregistrement, donnez

un nom à la session, sélectionnez l'emplacement

où vous souhaitez l'enregistrer, puis cliquez sur

Enregistrer.

Vous venez de créer une nouvelle session qui ne

contient encore aucune piste. Vous devez ensuite

connecter un câble de microphone ou d'instrument

et créer de nouvelles pistes d'enregistrement audio.
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Enregistrement audio
Cette section explique comment connecter un

microphone ou un instrument tel qu'une guitare ou

un clavier à une Mbox, puis enregistrer de l'audio.

Connexion d'un microphone ou d'un 
instrument à une Mbox

Pour connecter un microphone ou un instrument :

1 Effectuez l'une des opérations suivantes :

• Si vous utilisez un microphone, connectez-le à

une entrée micro/ligne de la Mbox à l'aide d'un

câble XLR.

• Si vous utilisez un instrument, connectez-le à une

entrée DI de la Mbox à l'aide d'un câble 6,35 mm.

2 Effectuez l'une des opérations suivantes :

• Avec une Mbox, assurez-vous que le commutateur

Front/Rear est sur la position appropriée

(connexion sur le panneau avant ou arrière).

• Avec une Mbox Mini, assurez-vous que le

commutateur Line/DI ou Mic/Line est sur la position

appropriée en fonction du type de connexion et

d'entrée utilisée.
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Introduction à Pro Tools
Connexion d'un micro avec un câble XLR à l'entrée micro/ligne 1 du panneau arrière d'une Mbox

Sélecteur de source

de l'entrée 1 (bouton

Front/Rear) Entrée 1

Entrée micro/ligne
Création d'une piste

Pro Tools utilise des pistes pour enregistrer des

données audio et MIDI dans une session. Avant de

pouvoir enregistrer de l'audio, vous devez créer une

piste audio.

Pour créer une piste audio et la préparer à

l'enregistrement :

1 Créez une nouvelle session, ou ouvrez une

session existante

2 Sélectionnez Piste > Nouvelle.

3 Pour enregistrer un seul micro ou instrument

connecté à votre interface audio, configurez les

options de la boîte de dialogue Nouvelles pistes

comme suit : 1 Piste Audio Mono, en

Échantillons, puis cliquez sur Créer.

Si vous souhaitez enregistrer les deux entrées

simultanément, créez une piste stéréo ou deux pistes

mono selon le type de source à enregistrer et le

matériel utilisé :

Création d'une nouvelle piste audio mono
• Pour enregistrer deux sources différentes, telles

qu'un micro chant et une guitare électrique, créez

2 pistes audio Mono.Vous pourrez ainsi enregistrer

les deux signaux d'entrée simultanément. Après

l'enregistrement, vous pourrez éditer, traiter et

mixer ces pistes indépendamment.

• Pour enregistrer une source stéréo sur deux canaux

telle qu'un clavier stéréo, créez 1 piste audio Stéréo.

4 Ouvrez la fenêtre de mixage en sélectionnant

Fenêtre > Mixage.

5 Au milieu de la tranche du canal de la nouvelle

piste se trouve un sélecteur sur lequel l'information

Analog 1 (Mono) est affichée. Ce sélecteur indique

quel canal d'entrée (Entrée 1 ou 2) est assigné à

cette piste. En cliquant sur le sélecteur du chemin

d'entrée audio, vous pouvez sélectionner l'autre

canal.

Sélecteur de

chemin

d'entrée

audio
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Enregistrement d'une performance sur 
une piste

Pour enregistrer une piste audio :

1 Cliquez sur le bouton d'activation pour

l'enregistrement de la piste afin qu'elle soit prête

à enregistrer un signal audio. Le bouton clignote

en rouge.

2 Chantez ou jouez de votre instrument.

Augmentez le gain d'entrée de votre interface audio

tout en surveillant l'indicateur de niveau de la piste

dans Pro Tools. Notez que les faders à l'écran

n'agissent pas sur les niveaux d'entrée. Ils contrôlent

uniquement les niveaux de monitoring.

3 Montez le gain d'entrée sur votre interface audio

jusqu'à ce que le niveau de la piste soit affiché

dans le segment vert de l'indicateur la plupart du

temps, ou dans le segment jaune pour les passages

les plus forts.

• Si le niveau de la piste atteint la zone rouge de

l'indicateur, votre gain est trop élevé et vous devez

alors le réduire.

• Si le niveau n'apparaît que sporadiquement dans

le segment vert, votre gain est trop faible et vous

devez alors l'augmenter.

Activation d'une piste pour l'enregistrement dans la
fenêtre de mixage

Bouton d'activation pour

l'enregistrement

Gain de l'entrée 1 (Mbox)
Introduction à Pro Tools
Indicateur de niveau

de piste
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4 Dans la fenêtre de transport, cliquez sur le bouton

de retour à zéro si vous souhaitez que la lecture

parte du début de la session.

5 Cliquez sur le bouton Enregistrement de la

fenêtre de transport pour préparer la session à

l'enregistrement. Le bouton clignote en rouge.

Vous indiquez ainsi à Pro Tools que vous êtes

prêt à enregistrer. Ce bouton est une sorte de

commande globale d'activation pour

l'enregistrement de la session.

6 Sélectionnez Fenêtre > Édition afin de pouvoir

visualiser ce qui se produit lorsque vous enregistrez.

7 Lorsque vous êtes prêt à lancer l'enregistrement,

appuyez sur la barre d'espace ou cliquez sur le

bouton Play de la fenêtre de transport. Au cours

de l'enregistrement, le bouton Enregistrement de

la fenêtre de transport et le bouton activer la

piste pour l'enregistrement de la piste cessent

de clignoter et restent allumés.

8 Pour arrêter l'enregistrement, appuyez de nouveau

sur la barre d'espace ou cliquez sur le bouton Stop

de la fenêtre de transport. Le bouton

Enregistrement de la fenêtre de transport est

désenclenché, mais le bouton activer la piste

pour l'enregistrement de la piste reste activé et

clignotera en rouge jusqu'à ce que vous cliquiez

dessus.

Retour à zéro Lecture Enregistrement
Introduction à Pro Tools
Vous venez d'enregistrer votre première piste audio.

Écoute de votre enregistrement
Après avoir enregistré de l'audio, vous pouvez

lancer la lecture pour l'écouter, l'éditer et le mixer.

Pour lire une piste enregistrée :

1 Cliquez de nouveau sur le bouton activer la

piste pour l'enregistrement de la piste pour la

sortir du mode d'enregistrement. Le bouton

activer la piste pour l'enregistrement arrête de

clignoter en rouge.

2 Pour lancer la lecture, appuyez sur la barre d'espace

ou cliquez sur le bouton Play de la fenêtre de

transport.

3 Pour arrêter la lecture, appuyez sur la barre d'espace

ou cliquez sur le bouton Stop de la fenêtre de

transport.

Enregistrement sur d'autres pistes

Répétez simplement les mêmes étapes pour créer une

seconde piste audio (mono ou stéréo) et enregistrer

d'autres prises. Vous pouvez enregistrer des parties

supplémentaires sur les pistes utilisées pour les

enregistrements précédents. Il s'agit d'une technique

de production courante permettant d'ajouter plusieurs

couches d'enregistrement pour créer un arrangement

de morceau.

Une piste audio mono après enregistrement
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Mesure du temps en minutes et secondes ou en mesures et 
temps
Pro Tools permet de mesurer le temps en minutes et secondes (temps absolu) ou en mesures et temps (temps

relatif). Pour la production musicale, il est conseillé de se baser sur les mesures et temps. La répartition

temporelle des temps est relative car elle est liée au tempo. Celle des mesures est également relative car elle

est liée à la signature rythmique.

Pro Tools permet de définir les changements de tempo et de mesure en plaçant des marqueurs sur la timeline de

la session située en haut de la fenêtre d'édition. Ces paramètres déterminent le rapport entre les valeurs

temporelles relatives en mesures et temps et les valeurs absolues en minutes et secondes (ou échantillons). Dans

Pro Tools, cette distinction apparaît sous la forme de valeurs temporelles basées sur le tempo (relatives) ou

sur les échantillons (absolues). Les données audio et MIDI peuvent être référencées par rapport à l'un ou

l'autre de ces types de valeurs, piste par piste (pour plus d'informations, reportez-vous au Guide de référence
Pro Tools).
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L'échelle temporelle principale de Pro Tools pour la timeline de la session est définie par défaut sur

Min:Secs (minutes et secondes). Vous pouvez également l'afficher en Mesures|Temps si vous souhaitez

enregistrer avec une piste de clic, à une signature rythmique et un tempo spécifiques. Une échelle temporelle

principale basée sur les mesures et temps est également utile pour la création, l'édition et la manipulation de

données audio et MIDI sur une grille graduée en mesures et temps.

Timeline et compteur principal de Pro Tools (l'échelle temporelle principale est définie sur minutes et secondes)

Compteur principal

Timeline

Mode Grid

Règles de

base de

temps
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Modification de l'échelle 
temporelle principale
Pour définir l'échelle temporelle principale,

effectuez l'une des opérations suivantes :

 Cliquez sur le sélecteur de compteur principal

(situé en haut de la fenêtre d'édition ou de la

fenêtre de transport lorsque l'affichage des

compteurs est activé) et sélectionnez une échelle

temporelle.

 Si une règle de base de temps est déjà affichée,

cliquez sur son nom. Il s'affiche alors en surbrillance.

Sélecteur de compteur principal (dans la fenêtre
d'édition)

Lorsque vous définissez l'échelle temporelle
principale sur la base de temps affichée dans
le compteur secondaire, les deux échelles
temporelles sont modifiées. En d'autres termes,
l'échelle temporelle secondaire prend l'ancienne
valeur de la référence temporelle de l'échelle
principale.

Définition de l'échelle temporelle principale sur
Mesures|Temps
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Enregistrement avec une piste 
de métronome (clic)
Une piste de métronome produit des battements de

métronome que vous pouvez utiliser comme

référence en enregistrement. Définissez l'echelle

principale sur Mesures|Temps pour enregistrer et

éditer le contenu de votre piste en vous basant sur la

métrique et le tempo spécifiés plutôt que sur une

valeur exprimée en Min:Secs.

Pour créer une piste de métronome :

1 Sélectionnez Piste > Créer une piste de

métronome.

Pro Tools ajoute une nouvelle piste d'entrée auxiliaire

avec le plug-in Click sur le premier insert. Lorsque

vous lancez la lecture ou l'enregistrement, vous

entendez un décompte suivi de battements respectant

la métrique et le tempo définis sur la timeline de

Pro Tools.

2 Sélectionnez Afficher > Transport >

Commandes MIDI pour afficher les commandes

MIDI de la fenêtre de transport.

3 Assurez-vous que les boutons du métronome et de

décompte de la fenêtre de transport soient activés.

4 Si vous souhaitez que le clic suive le tempo de la

session (défini sur la timeline), activez également

le bouton du chef d'orchestre. Désactivez-le si

vous souhaitez ajuster le tempo manuellement.
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5 Appuyez sur la barre d'espace ou cliquez sur le

bouton Play de la fenêtre de transport pour lancer

la lecture et entendre le clic.

Pour configurer les paramètres du clic :

1 Sélectionnez Configuration > Clic/Décompte.

2 Choisissez l'une des options suivantes :

• En cours de lecture et d'enregistrement : le clic

est audible pendant la lecture et l'enregistrement

• En cours d'enregistrement uniquement : le clic

n'est audible que pendant l'enregistrement, et non

pendant la lecture

• En cours de décompte uniquement : le clic n'est

audible que pendant le décompte précédant le

début de la lecture ou de l'enregistrement

Sélecteur de compteur principal (dans la fenêtre
d'édition)

Tempo

Bouton de décompte

Bouton du métronome

Bouton du chef d'orchestre
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3 Cliquez sur OK.

Pour couper le son de la piste de clic, effectuez

l'une des opérations suivantes :

 Mutez la piste de clic en cliquant sur son bouton

M (Mute) parmi les commandes de cette piste.

 Désactivez le bouton du métronome de la fenêtre

de transport ; il ne doit plus être allumé en bleu.

Désactivez ensuite le bouton de décompte qui

lui aussi n'apparaîtra plus en surbrillance. Cette

procédure coupe le son de la piste de clic et

désactive le décompte.

Définition de la métrique de la 
session
Veillez à définir la métrique de la session afin qu'elle

corresponde à celle de votre musique. Si la métrique

d'une session ne correspond pas à celle de la musique

que vous enregistrez, les temps forts de la piste de

clic ne tomberont pas sur ceux de votre musique.

Par conséquent, les données enregistrées risquent

de ne pas être alignées sur les intervalles en mesures

et temps de la grille de la fenêtre d'édition.

Pour définir la métrique d'une session :

1 Double-cliquez sur la métrique actuelle affichée

dans la zone Meter de la fenêtre de transport.

Bouton de la métrique actuelle
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2 Saisissez la métrique de la session et définissez

la valeur du champ Location sur 1|1|000 afin que

l'événement de métrique inséré remplace celui

créé par défaut.

3 Dans le menu déroulant Clic, sélectionnez une

valeur de note pour les battements. Pour une mesure

en 6/8 par exemple, sélectionnez une noire pointée.

4 Cliquez sur OK pour insérer le nouvel événement

de métrique.

Définition du tempo de la 
session
Dans Pro Tools, les nouvelles sessions sont créées

avec un tempo par défaut de 120 BPM. Si vous

souhaitez enregistrer à un tempo différent de 120 BMP,

ajustez le tempo en conséquence.

Pour modifier le tempo de la session :

1 Effectuez l'une des opérations suivantes :

• Double-cliquez sur le marqueur de début de

morceau de la fenêtre d'édition.

• Cliquez sur le bouton Ajouter un changement de

tempo (+), situé au début de la règle de tempo.

Fenêtre Changement de métrique
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2 Dans la boîte de dialogue Changement de

tempo, entrez la valeur du tempo de la session en

BPM.

3 Définissez la valeur du champ Emplacement sur

1|1|000 afin que l'événement de tempo inséré

remplace celui créé par défaut.

4 Dans le menu déroulant Métrique, sélectionnez

une valeur de note pour les temps. Pour une mesure

en 6/8 par exemple, sélectionnez une noire pointée.

5 Cliquez sur OK.

Règle de tempo

Fenêtre Changement de tempo

Vous pouvez saisir un tempo spécifique ou
utiliser la touche T pour battre la mesure.

Marqueur de début de morceau

Bouton d'ajout de changement de tempo

Règle de

tempo
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Utilisation du mode de tempo 
manuel
En mode de tempo manuel, Pro Tools ignore les

événements de tempo de la règle de tempo et suit

un tempo manuel à la place. Ce tempo peut être

déterminé automatiquement en battant la mesure.

Pour définir le tempo manuellement :

1 Assurez-vous que les commandes MIDI de la

fenêtre de transport sont bien affichées en

sélectionnant Afficher > Transport >

Commandes MIDI.

2 Désactivez la règle de tempo à partir de la fenêtre

de transport en cliquant sur le bouton du chef

d'orchestre. Le bouton doit être éteint. Pro Tools

passe en mode de tempo manuel. Dans ce mode,

tous les événements de tempo de la règle de

tempo sont ignorés.

3 Cliquez sur le sélecteur de résolution du tempo et

sélectionnez une valeur de note. Pour une mesure

en 6/8 par exemple, sélectionnez une noire pointée,

ou une noire pour une mesure en 3/4.

Mode de tempo manuel

Résolution du tempo

Bouton du chef

d'orchestre

Tempo
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4 Pour entrer un nouveau tempo, effectuez l'une

des opérations suivantes :

• Cliquez sur la valeur du tempo, tapez une nouvelle

valeur et appuyez sur Entrée.

• Cliquez sur la valeur de tempo et faites glisser

votre souris vers le haut ou le bas pour modifier

le tempo en conséquence. Pour un contrôle plus

précis, maintenez la touche Ctrl (Windows) ou

Commande (Mac) enfoncée pendant que vous

faites glisser votre souris.

• Cliquez sur la valeur de tempo et appuyez à plusieurs

reprises sur la touche T du clavier de votre ordinateur

en battant la mesure au tempo souhaité.

Importation de fichiers audio
Des boucles audio ainsi que des samples issus de

bibliothèques sont fréquemment utilisés dans les

workflows de production musicale. Vous pouvez

par exemple utiliser des boucles de batterie à la

place d'une piste de clic en tant que référence de

tempo pour l'enregistrement. Il est également possible

de mélanger plusieurs boucles audio avec des samples

« one-shot » (sons séparés) provenant de diverses

sources pour créer des morceaux entièrement inédits.

Pro Tools propose plusieurs méthodes d'importation

de fichiers audio à partir de différentes sources pour

les exploiter dans une session. Vous pouvez importer

de l'audio à partir d'un disque dur, d'un volume réseau,

d'un CD audio ou d'un support amovible à l'aide de

la commande Importer l'audio ou en faisant glisser

un fichier à partir d'un navigateur de l'espace de

travail, du Finder (Mac) ou de l'Explorateur

(Windows).
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Utilisation de la commande 
Import Audio
La commande Import Audio permet d'importer des

fichiers et clips audio dans votre session Pro Tools.

Pour importer des fichiers ou des clips audio dans

une session à l'aide de la commande Import Audio :

1 Sélectionnez Fichier > Importer > Audio.

2 Dans la boîte de dialogue Importer l'audio,

localisez et sélectionnez un fichier audio afin

d'afficher ses propriétés et les clips associés.

Boîte de dialogue Importer l'audio
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3 Pour écouter un fichier ou un clip sélectionné

avant de l'importer, cliquez sur le bouton Play de

la boîte de dialogue Importer l'audio. Cliquez

sur le bouton Stop pour arrêter la lecture. Pour

régler le volume de pré-écoute, déplacez le

curseur vertical. Pour accéder à un endroit

particulier du fichier, déplacez le curseur

horizontal qui se trouve sous les boutons Play et

Stop.

4 Effectuez l'une des opérations suivantes :

• Pour ajouter un fichier ou un clip à la liste

d'importation, sélectionnez le fichier puis cliquez

sur Ajouter ou Convertir.

• Pour importer tous les fichiers et clips présents

dans le répertoire actuel, cliquez sur Ajouter tout

ou Convertir tout.

• Pour supprimer un fichier ou un clip de la liste

d'importation, sélectionnez cet élément et cliquez

sur Enlever.

• Pour supprimer l'ensemble des fichiers et clips,

cliquez sur Enlever tout.

La commande de volume de pré-écoute de la
boîte de dialogue Importer l'audio détermine
également le volume de pré-écoute des clips
dans la liste des clips.

Pro Tools permet d'ajouter des fichiers dont
la fréquence d'échantillonnage est différente
de celle de la session. Dans le champ des
commentaires de la boîte de dialogue
Importer l'audio, un avertissement indique
que ces fichiers ne seront pas lus à la bonne
vitesse et à la bonne hauteur s'ils ne sont pas
convertis.
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5 Lorsque vous avez ajouté tous les fichiers et clips

audio à la liste d'importation, vous pouvez convertir

les fréquences d'échantillonnage en effectuant

les opérations suivantes :

• Activez l'option Appliquer SRC.

• Spécifiez la fréquence d'échantillonnage d'origine

dans le champ Fréquence échantillonnage

source en tapant sa valeur ou en sélectionnant

une fréquence dans le menu déroulant.

• Sélectionnez la qualité de conversion de la fréquence

d'échantillonnage dans le menu déroulant Qualité.

Ce paramètre prime sur le paramètre Qualité de

conversion de fréquence d'échantillonnage de la

page des préférences de traitement.

6 Cliquez sur Terminé.

7 Si vous copiez ou convertissez des fichiers,

sélectionnez un emplacement de stockage des

nouveaux fichiers comme par exemple le dossier

Audio Files de la session actuelle. Lorsque vous

ajoutez des fichiers, leur emplacement d'origine

est référencé.

8 Dans la boîte de dialogue Options d'importation

audio, indiquez à quel emplacement les fichiers

doivent être importés dans la session :

Boîte de dialogue Options d'importation audio
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Nouvelle piste : chaque fichier audio est importé

sur une piste individuelle et dans la liste des clips.

Liste des clips : les fichiers audio sont importés

dans la liste des clips et aucune piste n'est créée.

Les fichiers audio importés apparaissent dans la

liste des clips et vous pouvez les faire glisser vers

des pistes audio.

9 Si vous choisissez la première option, sélectionnez

l'emplacement auquel les fichiers doivent être

importés sur les pistes :

Début de session : les fichiers ou clips sont placés

au début de la session.

Début de morceau : le début des fichiers ou clips

est aligné sur le marqueur de début du morceau.

Sélection : le début des fichiers ou clips est aligné

sur le curseur d'édition ou le début d'une sélection

de timeline.

Spot : affiche la boîte de dialogue Spot qui permet

de placer les fichiers ou les clips à un emplacement

précis en se basant sur les échelles temporelles

disponibles.

10 Cliquez sur OK.
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Importation de fichiers par glisser-déposer
Pro Tools permet d'importer des fichiers audio, MIDI, vidéo et de session en faisant glisser les fichiers à

partir d'un navigateur de l'espace de travail, du Finder Mac ou de l'Explorateur Windows, puis en les déposant

sur l'icône de l'application Pro Tools, la timeline de la session, une piste, la liste des pistes ou la liste des clips.
Introduction à Pro Tools
Importation par glisser-déposer à partir de l'espace de travail

Espace de travail

Déposez des fichiers médias

ou de session sur des pistes

existantes ou sur la liste des

pistes pour les ajouter sur de

nouvelles pistes Déposez des fichiers

sur la liste des clips

pour les importer
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La figure précédente illustre certaines options

disponibles pour l'importation de fichiers par

glisser-déposer depuis un navigateur de l'espace de

travail.

Pour importer des fichiers dans la liste des clips :

1 Sélectionnez des fichiers audio, vidéo, MIDI, REX,

ACID ou de groupe de clips dans un navigateur

de l'espace de travail, le Finder Mac ou l'Explorateur

Windows.

2 Faites glisser les fichiers sélectionnés vers la

liste des clips.

Pour importer des fichiers sur une piste existante :

1 Sélectionnez les fichiers à importer dans un

navigateur de l'espace de travail, le Finder Mac

ou l'Explorateur Windows.

2 Faites glisser les fichiers sélectionnés vers

l'emplacement souhaité sur une piste compatible.

Pour importer des fichiers en créant de nouvelles

pistes :

1 Sélectionnez les fichiers à importer dans un

navigateur de l'espace de travail, le Finder Mac

ou l'Explorateur Windows.

2 Effectuez l'une des opérations suivantes :

• Maintenez la touche Maj enfoncée et faites glisser

les fichiers vers la fenêtre d'édition.

• Faites glisser les fichiers vers la liste des pistes.

• Faites glisser les fichiers vers un espace vide de

la fenêtre d'édition, en dessous ou entre des

pistes.
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Édition audio
De nombreuses opérations d'édition de l'audio des

pistes de Pro Tools peuvent être réalisées : trim,

séparation, couper ou copier et coller, déplacement,

réorganisation, etc.

Trim des clips audio
L'exemple suivant montre comment effectuer une

opération d'édition simple pour ajuster la position

du point de départ d'un morceau. Dans ce cas

particulier, on peut entendre le décompte du batteur

(« 1...2...1, 2, 3... ») avant le début du morceau (les

overheads ont probablement été enregistrés sur

cette piste stéréo). Voici à quoi ressemble l'audio

dans Pro Tools.

Les formes d'onde stéréo permettent de visualiser

les différentes parties du morceau. L'interface « ce

que vous voyez est ce que vous entendez » de

Pro Tools permet de supprimer rapidement le

décompte en effectuant une opération de « trim »

sur le début du morceau.

Début du

morceau

Décompte Formes d'onde

(canaux gauche

et droit)
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Pour effectuer une opération de trim sur un clip

audio :

1 Cliquez sur l'outil de trim de la barre d'outils de

la fenêtre d'édition.

2 Cliquez sur la piste après le décompte et avant le

début du morceau ; vous constaterez que le pointeur

se transforme en icône de trim. Faites glisser vers

la droite pour raccourcir le début du clip, ou vers

la gauche pour l'allonger.

Vous pouvez récupérer le début du clip en cliquant

puis en faisant glisser son début vers la gauche avec

l'outil de trim. Vous pourrez alors constater que le

segment audio précédemment supprimé (le décompte)

est toujours présent. Il s'agit d'un exemple simple

du mode d'édition non-destructif de Pro Tools.

Copier-coller de clips
L'exemple suivant montre comment copier et coller

un clip audio d'une piste vers d'autres endroits de la

timeline ou d'autres pistes de la session. Une boucle

audio rythmique importée sera utilisée.

Outil de trim

Début du

morceau
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Pour copier et coller un clip :

1 Importez une boucle audio rythmique dans une

session Pro Tools (reportez-vous à la section

« Importation de fichiers audio » à la page 51).

2 Cliquez sur la Main ou le Sélecteur sur la barre

d'outils de la fenêtre d'édition.

3 Si vous utilisez la Main, cliquez sur le clip que

vous souhaitez copier. Si vous utilisez le Sélecteur,

double-cliquez sur le clip que vous souhaitez copier.

4 Sélectionnez Édition > Copier.

5 Avec le Sélecteur, positionnez le curseur d'édition

à l'emplacement auquel vous souhaitez coller le

clip copié.

Outils d'édition

Utilisez l'outil Smart afin que le curseur
d'édition alterne entre différents outils d'édition
en fonction de la partie du clip sur lequel vous le
placez.

Sélection d'un clip avec la Main

Outil Smart

Sélecteur

Outil de saisie (Main)
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6 Sélectionnez Édition > Coller.

Séparation et réorganisation des 
clips
Il existe plusieurs façons de créer de nouveaux clips

audio dans Pro Tools. Vous pouvez importer ou

enregistrer des clips audio de fichier entier. Il est

également possible de créer des clips audio qui ne

se réfèrent qu'à certaines parties de fichiers audio

en effectuant des opérations de trim (reportez-vous

à la section « Trim des clips audio » à la page 55)

ou en séparant des clips de fichier entier.

L'exemple suivant présente diverses méthodes de

séparation et de réorganisation des clips audio d'une

session. Une boucle audio rythmique importée sera

utilisée.

Collage d'un clip à un emplacement temporel différent
et sur une autre piste

Appuyez sur Commande+C (Mac) ou Ctrl+C
(Windows) pour copier la sélection d'édition
actuelle dans le presse-papiers. Appuyez sur
Commande+V (Mac) ou Ctrl+V (Windows)
pour coller le contenu du presse-papiers à
l'emplacement actuel de la fenêtre d'édition.
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Séparation de clips sur la sélection 
d'édition
Pour séparer un clip sur la sélection d'édition actuelle :

1 Créez une sélection d'édition à l'intérieur d'un

clip audio avec le Sélecteur.

2 Sélectionnez Édition > Séparer le clip > Au

niveau de la sélection.

Création d'un sélection d'édition

Appuyez sur Commande+E (Mac) ou Ctrl+E
(Windows) pour séparer des clips sur la sélection
d'édition actuelle.

Nouveaux clips créés suite à la séparation du clip
parent aux limites de la sélection d'édition
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Réorganisation de clips séparés

Il existe plusieurs techniques de réorganisation des

clips dans Pro Tools. Le mode d'édition actif

(sélectionné dans la section la plus à gauche de la

barre d'outils de la fenêtre d'édition) détermine de

quel manière les clips audio peuvent être déplacés

dans Pro Tools. Les instructions suivantes ne

présentent qu'une partie des possibilités de

réorganisation des clips audio de votre session

Pro Tools.

Pour réorganiser des clips, effectuez l'une des

opérations suivantes :

 Avec l'outil Main en mode Slip, faites glisser un

clip audio vers un nouvel emplacement. Le clip

est déplacé à l'emplacement exact où vous l'avez

fait glisser.

 Avec l'outil Main en mode Grid, faites glisser un

clip audio vers un nouvel emplacement. Le clip

s'aligne sur la limite de grille la plus proche de

l'emplacement où vous l'avez fait glisser.

Utilisez la commande Édition > Séparer le clip >
Sur la grille pour séparer la sélection audio sur les
limites de la grille actuelle. Cette méthode est
particulièrement utile lorsque vous travaillez avec
de l'audio sur une grille Mesures|Temps. Utilisez la
commande Édition > Séparer le clip > Au niveau
des transitoires pour séparer la sélection audio sur
les attaques successives de l'audio. Vous pouvez
ainsi séparer l'audio en « sons » individuels,
comme par exemple un coup de caisse claire dans
une boucle de batterie ou une note d'un riff de
guitare.

Modes d'édition, mode Grid sélectionné
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 Avec l'outil Main en mode Spot, faites glisser un

clip audio vers un nouvel emplacement. La boîte

de dialogue Spot s'ouvre et vous pouvez spécifier

un emplacement temporel précis pour le clip.

 Avec l'outil Main en mode Shuffle, faites glisser

un clip audio vers un nouvel emplacement situé

entre d'autres clips. Un espace est créé entre les

clips adjacents pour le clip déplacé.

 Sélectionnez un clip avec la Main ou le Sélecteur,

puis choisissez Édition > Dupliquer. Le clip

sélectionné est dupliqué et positionné

immédiatement après la sélection actuelle.

 Sélectionnez un clip avec la Main ou le Sélecteur,

puis sélectionnez Édition > Répéter. Dans la

boîte de dialogue Repeat, entrez le nombre de

répétitions de la sélection souhaitées et cliquez

sur OK. La sélection est répétée en utilisant des

clips séparés placés les uns à la suite des autres.

Une boucle audio séparée sur les transitoires et
réorganisée

Pour plus d'informations sur l'édition et
l'organisation des clips audio, reportez-vous
aux sections du Guide de référence Pro Tools
relatives aux modes et outils d'édition, aux
groupes de clips et au traitement Elastic Audio.
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Programmation MIDI avec un 
plug-in d'instrument virtuel
Cette section présente un exemple de programmation

d'une séquence MIDI sur une piste d'instrument qui

sera jouée par un plug-in d'instrument virtuel. Le

plug-in Xpand!2 de AIR Music Technology sera

utilisé.

Qu'est-ce que le MIDI ?
Les données MIDI (Musical Instrument Digital

Interface) ne sont pas de l'audio, elles ne produisent

aucun son. Le MIDI est un protocole permettant aux

périphériques compatibles MIDI tels que les

synthétiseurs, sampleurs, contrôleurs, claviers et

séquenceurs de communiquer en échangeant des

données de contrôle. En d'autres termes, le MIDI

indique aux périphériques capables de produire du

son (tels que des synthétiseurs ou sampleurs matériels

ou des instruments virtuels logiciels) ce qu'ils doivent

jouer.

Les interfaces MIDI compatibles USB et FireWire

échangent des messages MIDI avec l'ordinateur via

un câble USB ou FireWire. Les instruments MIDI

matériels sont reliés à l'aide de câbles MIDI aux entrées

et sorties MIDI de votre interface MIDI. Les

instruments virtuels sont insérés sous la forme de

plug-ins sur les pistes d'instrument de Pro Tools et

sont accessibles directement à partir de Pro Tools.

Le plug-in Xpand!2 fait partie de la AIR Creative
Collection, fournie en téléchargement avec
Pro Tools sous la forme d'un programme
d'installation distinct. Assurez-vous de bien avoir
installé cette collection de plug-ins et leurs
contenus avant de poursuivre avec cet exemple.
Pour plus d'informations, reportez-vous au
Guide des plug-ins AIR Creative Collection.
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Création d'une piste d'instrument avec un plug-in d'instrument
Dans Pro Tools, vous pouvez enregistrer, programmer et lire des séquences MIDI sur une piste d'instrument

ou une piste MIDI. Si vous travaillez avec des plug-ins d'instrument virtuel tels que le AIR Xpand!2, vous

utiliserez la plupart du temps une piste d'instrument. Les pistes d'instrument permettent à la fois de travailler

avec des séquences MIDI et de prendre en charge le monitoring audio.

Vous pouvez également les utiliser avec des périphériques MIDI externes.

Pour créer une piste d'instrument et insérer un plug-in d'instrument :

1 Sélectionnez Piste > Nouvelle. Dans la boîte de dialogue Nouvelles Pistes, procédez comme suit :

• Sélectionnez Stéréo.

• Cliquez sur le menu déroulant où apparaît l'option Type de Piste et sélectionnez Piste Instrument.

• Cliquez sur Créer.

2 Si nécessaire, sélectionnez Fenêtre > Mixage pour afficher la fenêtre de mixage.

3 Cliquez sur le sélecteur d'insert de piste situé dans la partie supérieure de la piste d'instrument et sélectionnez

Xpand2 à partir du sous-menu Instrument.

Boîte de dialogue Nouvelles Pistes , options Stéréo et Piste Instrument sélectionnées
Introduction à Pro Tools
Insertion du plug-in Xpand!2 sur une piste d'instrument

Sélecteur

d'insert
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4 Une fenêtre de plug-in apparaît avec l'interface du plug-in Xpand!2. Vous pouvez maintenant sélectionner

un préréglage de son qui sera utilisé pour jouer en MIDI.

Pour sélectionner un preset de son du plug-in Xpand!2 :

 En haut de la fenêtre de plug-in, cliquez sur le menu de bibliothèque (<valeur d'usine>) et sélectionnez

un préréglage dans l'un des sous-menus. Les presets du plug-in Xpand!2 sont classés par catégorie dans

des sous-menus.

Pour plus d'informations sur le plug-in Xpand!2, reportez-vous au Guide des plug-ins AIR Creative Collection.
Introduction à Pro Tools
Sélection d'un préréglage d'usine Xpand!2 à partir du menu de bibliothèque du plug-in
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Utilisation d'un instrument 
virtuel pour produire de l'audio
Un instrument virtuel tel que Xpand!2 peut produire

de l'audio à partir d'une séquence MIDI ou d'un

contrôleur MIDI externe.

Pour jouer d'un instrument virtuel via une piste

d'instrument, effectuez l'une des opérations

suivantes :

 Si un contrôleur MIDI est connecté, vous pouvez

jouer de l'instrument virtuel tant que la piste

d'instrument sur laquelle il est inséré est

sélectionnée ou activée pour l'enregistrement.

Vous pouvez enregistrer les parties que vous

interprétez sous la forme d'une séquence MIDI.

 Importez ou programmez une séquence MIDI

sur la piste d'instrument sur laquelle l'instrument

virtuel est inséré, puis lancez la lecture.

Enregistrement MIDI avec un 
contrôleur externe
Vous pouvez enregistrer dans Pro Tools des données

MIDI provenant d'un contrôleur MIDI.

Pour enregistrer du MIDI sur une piste d'instrument :

1 Assurez-vous que votre contrôleur MIDI est

connecté à une interface MIDI avec des câbles

MIDI ou directement à votre ordinateur via un

câble USB.

2 Créez une piste d'instrument stéréo et insérez le

plug-in Xpand!2 (reportez-vous à la section

« Création d'une piste d'instrument avec un

plug-in d'instrument » à la page 60).

3 Sélectionnez un préréglage de basse (aussi

appelé « patch »).

4 Sélectionnez Options > MIDI Thru. (Vérifiez si

l'option MIDI Thru est cochée et sélectionnez-la

si elle ne l'est pas.)
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5 Cliquez sur le bouton d'activation pour

l'enregistrement de la piste d'instrument afin de

la préparer à l'enregistrement MIDI.

6 Dans la fenêtre de transport, cliquez sur le bouton

Enregistrer.

7 Jouez sur le clavier de votre contrôleur MIDI.

Vous devriez entendre la partie que vous jouez

avec le son sélectionné.

8 Dèsquevousêtesprêt àcommencer l'enregistrement,

cliquez sur le bouton Play ou appuyez sur la barre

d'espace. Pour interrompre l'enregistrement, cliquez

sur le bouton Stop ou appuyez sur la barre d'espace.

9 Cliquez une nouvelle fois sur le bouton Activer

l'enregistrement de la piste pour la sortir du mode

d'activation pour l'enregistrement et écouter ce que

vous venez d'enregistrer.

Programmation d'une séquence 
MIDI avec le Crayon
Vous pouvez programmer une séquence MIDI dans

Pro Tools en utilisant l'outil Crayon.

Données MIDI enregistrées sur une piste d'instrument

Lorsque vous insérez des notes MIDI ou
d'autres données MIDI avec le Crayon, des
limites de clip MIDI sont créées sur les barres
de mesure les plus proches.
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Pour insérer une note MIDI sur une piste de la

fenêtre d'édition :

1 Dans la fenêtre d'édition, affichez la piste MIDI

ou d'instrument en vue Notes.

2 Sélectionnez le Crayon et assurez-vous qu'il soit

en mode Main levée. Le curseur se transforme

en crayon lorsque vous le placez sur la playlist

d'une piste MIDI ou d'une piste d'instrument en

vue Notes.

3 Pour insérer des noires sur les temps, effectuez

les opérations suivantes :

• Définissez l'échelle temporelle principale sur

Mesures|Temps.

• Sélectionnez le mode d'édition Grid.

• Définissez la valeur de grille sur une noire.

• Définissez la valeur Durée des notes par défaut

sur une noire (ou sur Suivre la grille).

4 Déplacez le Crayon dans la zone de la playlist de

la piste MIDI ou d'instrument. Utilisez la règle

de la fenêtre d'édition et le mini-clavier de la

piste pour repérer la hauteur et l'emplacement

temporel souhaités.

Sélection de la vue Notes sur une piste d'instrument
Introduction à Pro Tools
Lorsque le Crayon est activé, la position et la hauteur

de note de l'emplacement ciblé par le curseur sont

affichées dans la barre d'outils de la fenêtre.

5 Lorsque vous avez atteint la hauteur de note et

l'emplacement temporel, cliquez pour créer la note.

Position et hauteur de note ciblées par le curseur

Note MIDI insérée avec le crayon

En mode Grid, le point de début de la note
MIDI est aligné par défaut sur la limite de
grille la plus proche. Avec le Crayon en mode
Main levée, cliquez et maintenez enfoncé le
bouton de la souris puis appuyez sur la touche
Ctrl (Windows) ou Commande (Mac) pour
désactiver momentanément l'alignement sur
la grille.

Hauteur de note ciblée par le curseur

Position du curseur sur la timeline

Curseur du Crayon
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La vélocité des notes insérées est déterminée par le

paramètre Vélocité des notes par défaut. La durée

est déterminée par la valeur Durée des notes par

défaut. En mode Grid, l'emplacement de l'attaque

de la note est déterminé par la valeur de grille.

Si l'option Lecture des notes MIDI pendant l'édition

est activée, un son est émis à chaque fois qu'une note

est insérée.

Vous pouvez faire glisser le Crayon après avoir cliqué

(et avant d'avoir relâché le bouton de la souris), pour

ajuster la hauteur et la durée de la note. Faites glisser

la souris vers la droite pour allonger la note sans en

modifier le point de début et vers la gauche pour

raccourcir la note sans en modifier le point de fin.

Édition de notes MIDI
Les notes MIDI peuvent être éditées dans la fenêtre

d'édition ou une fenêtre de l'éditeur MIDI pour

ajuster leurs points de début et de fin, leurs durées,

hauteurs et vélocités. Le Sélecteur, la Main et le

Crayon agissent sur des notes individuelles ou des

groupes de notes.

Sélection de notes MIDI

Vous devez sélectionner les notes MIDI avant de

pouvoir les éditer.

Pour sélectionner des notes MIDI :

1 Affichez la piste MIDI ou d'instrument en vue

Notes.

2 Effectuez l'une des opérations suivantes :

Lorsque le mode Grid est activé, le point de
fin de la note MIDI est aligné par défaut sur
la limite de grille la plus proche. Pour
désactiver momentanément l'alignement sur
la grille, maintenez la touche Commande
(Mac) ou Ctrl (Windows) enfoncée pendant
que vous faites glisser le Crayon.
Introduction à Pro Tools
 Cliquez sur chaque note avec la Main ou le Crayon

tout en maintenant la touche Maj enfoncée.

 Avec l'un des outils de saisie, positionnez le

curseur à un emplacement vide (un pointeur de

sélection apparaît) et tracez un rectangle autour

du groupe de notes à éditer.

Lorsque vous utilisez un outil de saisie, si une partie

du rectangle touche une note (que ce soit son point

de début ou de fin), celle-ci est incluse dans la

sélection.

 Faites glisser le sélecteur sur une plage de notes.

Lorsque vous utilisez le sélecteur, une note n'est

sélectionnée que si son point de début est inclus.

Transposition des notes

Vous pouvez transposer les notes MIDI en les faisant

glisser avec un outil de saisie ou le Crayon vers le

haut ou le bas. Si plusieurs notes sont sélectionnées

avant de faire glisser l'outil de saisie, elles sont toutes

transposées.

Sélection de notes à l'aide d'un outil de saisie

Sélection de notes avec le sélecteur
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Pour transposer une note MIDI :

1 Affichez la piste MIDI ou d'instrument en vue

Notes.

2 Sélectionnez le Crayon ou un outil de saisie.

3 Maintenez la touche Maj enfoncée et faites

glisser la note vers le haut ou le bas.

La touche Maj garantit que la note transposée conserve

son point de début d'origine sur la timeline de Pro Tools.

Vous entendez les notes à mesure que vous les faites

glisser et l'indicateur de valeur d'emplacement du

curseur (dans la fenêtre d'édition) indique le

nombre de demi-tons et le sens (+/-) de la

transposition.

Transposition à l'aide d'un outil de saisie

Maintenez la touche Ctrl (Mac) ou Windows
(Windows) enfoncée et appuyez sur la touche
Plus (+) du pavé numérique pour transposer
les notes MIDI sélectionnées d'un demi-ton
vers le haut, ou sur la touche Moins (–) pour
les transposer d'un demi-ton vers le bas.

Pour créer une copie de la note afin de la
transposer en conservant la note d'origine,
maintenez la touche Option (Mac) ou Alt
(Windows) enfoncée pendant que vous faites
glisser la note.
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Déplacement des notes

Tout comme les clips, le point d'entrée des notes

MIDI peut être déplacé vers la gauche ou la droite

sur la timeline de Pro Tools avec un outil de saisie

ou le Crayon. Si plusieurs notes sont sélectionnées

avant de faire glisser la sélection, elles sont déplacées

ensemble.

Pour déplacer une note MIDI :

1 Affichez la piste MIDI ou d'instrument en vue

Notes.

2 Avec un outil de saisie ou le Crayon, faites glisser

la note vers la gauche ou la droite (appuyez sur

Maj pour conserver la hauteur de la note).

Au fur et à mesure que vous faites glisser la note,

l'indicateur de valeur d'emplacement du curseur

(dans la fenêtre d'édition) affiche le nouveau point

de début.

En mode d'édition Grid, la note déplacée s'aligne

sur la limite de grille la plus proche. En mode

d'édition Spot, la boîte de dialogue Spot s'ouvre.

Pour copier les notes sélectionnées et
conserver les notes d'origine, maintenez la
touche Option (Mac) ou Alt (Windows)
enfoncée pendant que vous faites glisser
les notes.
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Trim des points de début et de fin d'une 
note

Tout comme les clips, vous pouvez ajuster les points

de début et de fin des notes MIDI avec l'outil de trim.

Si plusieurs notes sont sélectionnées lorsque vous

utilisez l'outil de trim, elles sont toutes modifiées.

Pour ajuster la position des points de début ou de

fin d'un groupe de notes MIDI :

1 Affichez la piste MIDI ou d'instrument en vue Notes.

2 Sélectionnez les notes sur lesquelles vous souhaitez

réaliser l'opération de trim.

3 Effectuez l'une des opérations suivantes :

• Sélectionnez l'outil de trim.

• Utilisez le Crayon.

4 Déplacez le curseur près du début de l'une des

notes sélectionnées ; le pointeur de l'outil de trim

apparaît. Faites-le glisser vers la droite pour

raccourcir les notes ou vers la gauche pour les

rallonger.

En mode d'édition Grid, le point de début ou de fin

déplacé s'aligne sur la limite de grille la plus proche.

En mode d'édition Spot, la boîte de dialogue Spot

s'ouvre et vous invite à entrer le nouvel emplacement

des points de début et de fin de la note.

Modification de la position de fin des notes avec l'outil
de trim

En mode Grid, appuyez sur la touche Ctrl
(Windows)ouCommande (Mac)pourdésactiver
momentanément le mode Grid.
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Édition manuelle de la vélocité des notes

Lorsqu'une piste MIDI ou d'instrument est affichée

en vue Velocity ou si la ligne de vélocité est affichée

sous une piste, la vélocité d'attaque des notes est

représentée par une barre verticale. Plus elle est

haute, plus la valeur de vélocité est élevée (0 à 127).

Pour modifier la vélocité MIDI dans la fenêtre

d'édition :

1 Effectuez l'une des opérations suivantes :

• Affichez la piste MIDI ou d'instrument en vue

Velocity.

• Affichez la ligne de contrôleur de la piste MIDI

ou d'instrument et affichez les vélocités.

2 Sélectionnez un outil de saisie.

3 Faites glisser l'extrémité supérieure (losange) de

la barre de vélocité vers le haut ou le bas.

Affichage de la ligne de vélocité

Déplacement d'une barre de vélocité

Les vélocités d'une plage de notes peuvent
être éditées à l'aide du Crayon.
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Suppression de notes MIDI

Il est possible de supprimer des notes sélectionnées

via la commande Effacer du menu d'édition ; des

notes individuelles peuvent également être

supprimées avec le Crayon.

Pour supprimer un groupe de notes MIDI à l'aide de

la commande Effacer :

1 Sélectionnez les notes à supprimer.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Édition > Effacer pour supprimer les

notes sélectionnées. Les données de contrôleur

sous-jacentes de la piste demeurent intactes.

• Avec un outil d'édition, effectuez un clic droit sur

une note sélectionnée, puis sélectionnez Effacer.

• Appuyez sur la touche Retour arrière (Windows)

ou Suppr (Mac).

Pour supprimer une seule note MIDI avec le Crayon :

 Sélectionnez le Crayon, puis cliquez sur la note

tout en appuyant sur la touche Alt (Windows) ou

Option (Mac). Le Crayon se transforme en gomme.

Lorsque vous supprimez des notes MIDI dans
une sélection de plage temporelle, toutes les
données de contrôleur et d'automation sous-
jacentes sont également supprimées.

Suppression d'une note avec le Crayon

Vous pouvez également supprimer des
événements de changement de programme et
Sysex en maintenant la touche Option (Mac)
ou Alt (Windows) enfoncée puis en cliquant
dessus avec le Crayon.
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Mixage et traitement de 
plug-in
Le mixage dans Pro Tools consiste à travailler avec

des éléments du flux des signaux audio, dont les

entrées, les sorties, les bus, les inserts et les départs,

pour les mélanger au sein d'un sous-groupe ou d'un

mixdown final.

Les tâches de mixage peuvent être réalisées à tout

moment dans une session, y compris avant le

mixdown final.

Au cours du mixage, des plug-ins en temps réel et

des inserts matériels sont utilisés pour les effets et

le traitement des signaux. Pro Tools est livré avec

une suite de plug-ins d'effets audio qui permettent

de modifier les sons enregistrés. Cette section

fournit deux exemples d'utilisation de ces plug-ins

pour le traitement de vos sons.

Pour des d'informations détaillées sur les
plug-ins fournis avec Pro Tools, consultez le
Guide des plug-ins audio (Aide > Guide des
plug-ins audio).
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Application d'une égalisation et 
d'une compression
Habituellement, lorsque vous mixez de l'audio, vous

appliquerez une égalisation ainsi qu'une compression
aux pistes individuelles pour améliorer leur son.

Égalisation (EQ) : permet d'agir sur le spectre

fréquentiel du son. Les réglages de basses et d'aigus

de la plupart des systèmes stéréo sont un exemple

simple d'égaliseur. Ces réglages permettent de relever
(augmenter le niveau) ou atténuer (baisser le niveau)

des basses et hautes fréquences de l'audio. Vous

pouvez utiliser un EQ pour vous aider à séparer les

fréquences d'une basse et d'une guitare, pour rendre

la batterie plus agressive, mettre les voix en avant

ou même supprimer des bruits parasites. Pro Tools

propose plusieurs types différents de plug-ins

d'égalisation afin de mettre en forme vos sons.

Compression : permet d'homogénéiser la dynamique

de votre audio. Une compression est une sorte de

contrôle automatique du volume agissant sur le niveau

des passages les plus forts. Utilisez la compression

pour donner plus de proximité aux voix ou rendre

les sons de cymbale moins stridents. Un limiteur
agit sur les crêtes du signal audio dépassant un certain

seuil, sans affecter l'audio n'excédant pas ce niveau.

Pro Tools propose plusieurs types différents de

plug-ins de traitement de la dynamique de vos sons.
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Pour appliquer un EQ sur une piste :

1 Sélectionnez Fenêtre > Mixage.

2 Dans la partie supérieure de la piste, cliquez sur le

premier sélecteur d'insert de piste disponible et

sélectionnez EQ 3 7-Band dans le sous-menu EQ.

Sélecteur d'insert d'une piste de la fenêtre de mixage
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3 La fenêtre du plug-in EQ III s'ouvre. Utilisez les

presets du plug-in comme point de départ et

découvrez comment chaque paramètre de

l'égaliseur agit sur le son.

4 Lancez la lecture pour entendre l'effet.

Pour appliquer une compression à une piste :

1 Sélectionnez Fenêtre > Mixage.

2 Dans la partie supérieure de la piste, cliquez sur

le premier sélecteur d'insert de piste disponible

et sélectionnez Dyn 3 Compressor/Limiter dans

le sous-menu Dynamics. Pro Tools insère le

plug-in Dynamics III Compressor/Limiter sur la

piste et affiche la fenêtre du plug-in.

3 La fenêtre du plug-in Dyn III s'ouvre. Utilisez

les presets du plug-in comme point de départ et

découvrez comment chaque paramètre de

l'égaliseur agit sur le son.

Sélecteur de preset de la fenêtre du plug-in EQ III
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4 Lancez la lecture pour entendre l'effet.

Utilisation d'une réverbération
Une réverbération (ou reverb) reproduit les

caractéristiques acoustiques d'un lieu. Les effets de

reverb sont en réalité formés d'une série de retards

(échos) recréant les réflexions du son sur les surfaces

de diverses pièces, salles et autres lieux. Employez

les effets de reverb pour simuler une sensation d'espace

acoustique pour votre mix. Utilisez pour cela les

départs de vos pistes source pour les envoyer sur

une piste d'entrée auxiliaire. Les effets de reverb

peuvent donner l'illusion que votre musique a été

enregistrée dans une grande salle de concert, une

pièce feutrée ou même un couloir étroit.

La configuration « départ-retour » est l'une des plus

efficaces afin d'incorporer une reverb à un mix. Dans

Pro Tools, les départs des pistes permettent de router

très facilement l'audio provenant de plusieurs pistes

vers un même effet de reverb. Les pistes source

sembleront ainsi toutes avoir été enregistrées dans

la même pièce.

Sélecteur de preset de la fenêtre du plug-in Dyn III
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Pour utiliser une reverb avec une piste d'entrée auxiliaire et plusieurs pistes source :

1 Sélectionnez Fenêtre > Mixage.

2 Sélectionnez Piste > Nouvelle, choisissez d'ajouter 1 piste d'entrée auxiliaire stéréo puis cliquez sur

Créer.

3 Cliquez sur le sélecteur d'entrée de piste de la piste d'entrée auxiliaire que vous venez de créer et sélectionnez

Bus > Bus 1–2.

Création d'une nouvelle piste d'entrée auxiliaire
Introduction à Pro Tools
Sélection du Bus 1-2 à partir du sélecteur d'entrée d'une piste d'entrée auxiliaire

Sélecteur d'entrée

de piste
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4 Cliquez sur le sélecteur du départ A de votre piste source comme illustré sur la figure ci-dessous, et

sélectionnez Bus > Bus 1-2.
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5 Répétez l'étape précédente pour chaque piste supplémentaire que vous souhaitez envoyer vers la piste

d'entrée auxiliaire pour le traitement de reverb.

Sélection du Bus 1–2 pour le départ A d'une piste audio

Sélecteur du

départ A
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6 Insérez un plug-in de reverb sur la piste d'entrée auxiliaire.
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7 Utilisez les fenêtres de départs individuelles pour ajuster le niveau du départ des pistes source. Vous

pouvez également configurer la vue Départs étendus afin que les commandes d'un départ particulier soient

affichées (sélectionnez par exemple Afficher > Départs étendus > Départ A).

8 Appuyez sur la barre d'espace et montez doucement le petit fader de la fenêtre de sortie du départ ou des

commandes de piste du départ. Vous ajustez ainsi la quantité de signal source envoyée sur la piste

d'entrée auxiliaire pour le traitement de reverb.

9 Continuez à écouter votre mix et ajustez les niveaux des départs de piste individuels et expérimentez

différents paramétrages du plug-in pour obtenir l'effet souhaité.

Routing des départs de pistes audio vers une piste d'entrée auxiliaire pour leur traitement dans la reverb D-Verb
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Utilisation de l'automation
Les commandes de mixage de chaque type de piste

de Pro Tools peuvent être automatisées de manière

dynamique. Vous pouvez écrire des mouvements

d'automation et les voir en temps réel au cours de la

lecture d'une session. Vous pouvez également modifier

des données d'automation à l'aide des techniques

d'édition des données audio et MIDI.

Écriture d'une automation

Vous pouvez écrire une automation pour toutes les

commandes activées en écriture, en les déplaçant

durant la lecture.

Pour écrire une automation sur des pistes :

1 Sélectionnez Fenêtre > Automation.

2 Assurez-vous que l'écriture est activée pour ce

type d'automation.

Fenêtre d'automation, automation de volume activée

Fenêtre

Automation

Sélecteur de

mode

d'automation

de piste

Déplacementdu

fader de volume

pendant la

lecture
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3 Dans la fenêtre de mixage ou d'édition, cliquez

sur le sélecteur de mode d'automation de chaque

piste à automatiser, puis définissez le mode

d'automation. Pour un premier passage

d'automation, optez pour le mode Écrire.

4 Lancez la lecture pour démarrer l'écriture de

l'automation.

5 Déplacez les commandes que vous souhaitez

automatiser (tel qu'un fader de volume de piste).

6 Une fois l'opération terminée, arrêtez la lecture.

7 Repassez en mode d'automation Lire pour lire

l'automation que vous venez d'écrire.

Édition manuelle d'une automation

Pro Tools propose plusieurs méthodes d'édition des

données d'automation des pistes d'une session. Vous

pouvez modifier les données d'automation

graphiquement, en ajustant les points d'une playlist
d'automation. Vous pouvez également couper, copier

et coller les données d'automation comme s'il s'agissait

de données audio ou MIDI.

Les données d'automation se présentent sous la forme

d'une ligne graphique avec des points d'inflexion

modifiables.

Après la première passe d'automation, vous
pouvezécrired'autresmouvementsd'automation
sur la piste sans effacer complètement le
passage précédent, en mode Touch ou Latch.
Ces modes ajoutent des données d'automation
uniquement lorsque vous déplacez une
commande.

Point d'automation
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Faites glisser ces points d'inflexion pour modifier

les données d'automation directement dans la

fenêtre d'édition et les fenêtres de l'éditeur MIDI.

Lorsque vous déplacez un point d'automation vers

le haut ou le bas, la variation de la valeur est

affichée.

Le déplacement d'un point d'automation vers la gauche

ou la droite permet d'ajuster la position temporelle

de l'événement d'automation.

Pour afficher un type d'automation de piste spécifique,

sélectionnez la vue de piste correspondante ou affichez

la ligne d'automation ou de contrôleur correspondante

sous la piste. Vous pouvez par exemple afficher et

éditer les données de volume, panoramique, mute,

de contrôleur MIDI, et même d'automation de plug-in.

Variation de la valeur d'un point d'automation

Vue de piste et lignes d'automation

Sélecteurde

vue de piste

Sélecteur de

type

d'automation

Lignes

d'automation

Vue de piste

d'automation

du volume
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Utilisation des outils de saisie

Les outils de saisie permettent de créer de nouveaux

points d'automation en cliquant sur la ligne du graphique

ou d'ajuster la position de points existants en les

déplaçant. Maintenez la touche Option (Mac) ou

Alt (Windows) enfoncée et cliquez sur des points

d'automation avec un outil de saisie pour les supprimer.

Utilisation du Crayon

Le Crayon permet de créer des points d'automation

en cliquant une fois sur la courbe de gain. Maintenez

la touche Option (Mac) ou Alt (Windows) enfoncée

et cliquez sur des points d'automation avec le Crayon

pour les supprimer.

Utilisation des outils de trim

Les outils de trim permettent de déplacer les points

d'automation sélectionnés vers le haut ou le bas en

les faisant glisser à partir d'un point quelconque de

la sélection.

Création d'un point d'automation avec la Main

Suppression d'un point d'automation avec le Crayon

Déplacement de points d'automation avec l'outil de trim
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Exportation de votre mix
Après avoir enregistré, édité et mixé les pistes d'une session Pro Tools, vous êtes prêt à créer le mix final de

votre session et à l'exporter pour le graver sur CD ou le publier sur Internet. Utilisez la commande Bounce

sur disque pour exporter le mix de la session dans un fichier audio unique.

Pour exporter le mix de votre session dans un fichier audio stéréo :

1 Utilisez le Sélecteur pour créer une sélection sur la timeline (ou sur une piste) de la durée de votre session.
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Sélection de timeline pour un bounce sur disque

Sélection de timeline

Sélection audio de la

session prête pour le

bounce sur disque

Sélecteur
2 Sélectionnez Ficher > Bounce sur > Disque.

Boîte de dialogue Bounce
3 Dans la boîte de dialogue des options de bounce,

effectuez les opérations suivantes :

• Sélectionnez une source dans le menu Source du

bounce (chemin principal de sortie des canaux

de votre mix, tel que main (Stereo) –> Analog

1–2).

• Sélectionnez un type de fichier dans le menu

Type de fichier (WAV par exemple).

• Sélectionnez Entrelacé dans le menu Format.

Vous obtiendrez ainsi un fichier stéréo.

• Si vous souhaitez graver sur CD le fichier résultant,

sélectionnez 16 Bit dans le menu Résolution.

• Si vous souhaitez graver sur CD le fichier résultant,

sélectionnez 44,1 kHz dans le menu Fréquence

d'échantillonnage.

• Pour un bounce plus rapide qu'en temps réel,

sélectionnez l'option Offline.
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4 Cliquez sur Bounce. Si aucune sélection de timeline

n'est active, l'opération de bounce s'appliquera à

la durée totale de la session, du début à la fin.

5 Dans la boîte de dialogue Enregistrer, entrez le

nom du fichier audio qui sera généré et

sélectionnez son emplacement d'enregistrement.

6 Cliquez sur Enregistrer.

Pro Tools lance l'opération de bounce sur disque.

Si l'option Offline n'est pas activée, le processus de

bounce de Pro Tools est réalisé en temps réel et

vous pouvez entendre la lecture audio de votre mix

pendant l'opération. Cependant, il est impossible de

modifier les paramètres d'un mix Pro Tools

pendant cette procédure.

Gravure de votre mix sur CD
Lorsque l'opération de bounce est terminée, vous

obtenez un fichier audio que vous pouvez graver

sur un CD audio à l'aide d'un logiciel de gravure tel

qu'iTunes ou Roxio Toast. Ce CD pourra être lu par

n'importe quel lecteur CD standard. Écouter un CD

de référence dans un autre environnement que votre

studio est un excellent moyen de se rendre compte

si votre mix sonne correctement sur d'autres

systèmes et environnements d'écoute.
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Pour en savoir plus
Nous espérons que cette rapide présentation du logiciel

Pro Tools vous a donné envie de vous mettre à l'œuvre.

Pour en savoir plus sur les fonctionnalités abordées

dans ce document, reportez-vous au Guide de
référence Pro Tools (Aide > Guide de référence de

Pro Tools). Vous accéderez à des informations

détaillées sur tous les logiciels et systèmes

Pro Tools. Le Guide de référence Pro Tools fournit

des explications exhaustives sur l'ensemble des

aspects et fonctionnalités de Pro Tools, classés par

tâche de production audio et musique (comme

Enregistrement, Édition et Mixage).

Vous pouvez également utiliser l'aide en ligne de

Pro Tools (Aide > Aide de Pro Tools) pour

rechercher des informations spécifiques.
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Einführung in Pro Tools
Nehmen Sie sich Zeit, dieses Handbuch zu lesen,

wenn Sie mit Pro Tools® | Software noch nicht

vertraut sind. In diesem Handbuch wird anhand

von Beispielen erläutert, wie Sie in Pro Tools

Audiomaterial aufnehmen, bearbeiten und mischen

sowie MIDI verwenden.

Sollten Sie Pro Tools noch nicht installiert haben,

tun Sie dies gemäß den Anweisungen im

Pro Tools-Installationshandbuch. Hinweise zum

Anschließen Ihrer Audio-Hardware und zur

Installation der dazugehörigen Treiber finden Sie

in der jeweiligen Dokumentation Ihrer Hardware.
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Anschließen von Kopfhörern 
oder Lautsprechern
Zum Abhören des Audiomaterials in Pro Tools

schließen Sie Kopfhörer oder Lautsprecher an Ihre

Audio-Hardware an (in diesem Handbuch wird das

Pro Tools | Mbox®-Audio-Interface als Beispiel

verwendet). Wenn Sie Kopfhörer verwenden ,

verringern Sie den Kopfhörerpegel (indem Sie den

Regler gegen den Uhrzeigersinn drehen). Wenn Sie

Lautsprecher verwenden, verringern Sie den Master-

Lautstärkepegel (indem Sie den Regler gegen den

Uhrzeigersinn drehen). Es ist äußerst wichtig, dass

Sie mit einer niedrigen Lautstärke beginnen, damit

Sie weder Ihr Gehör noch Ihr Equipment

beschädigen. Sobald Sie Pro Tools gestartet und eine

Session geöffnet haben (oder eine neue erstellt

haben), können Sie die Lautstärkepegel auf eine

angenehme Lautstärke regeln.
Bedienelemente und Anschlüsse auf der Mbox-Vorderseite

Lautsprecheranschlüsse auf der Mbox-Rückseite

Kopfhörerpegel

Master-Lautstärkepegel

6,3-mm-Kopfhörerbuchse
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Wiedergabe der Demo-
Session
Verwenden Sie die Demo-Session, um Ihre Kopfhörer

und Lautsprecher zu testen und herauszufinden,

was Sie alles mit Pro Tools machen können.

So installieren und öffnen Sie die Demo-Session:

1 Sie haben folgende Möglichkeiten:

• Legen Sie die Installations-DVD für Pro Tools in

das DVD-Laufwerk ein, suchen und öffnen Sie

den Additional Files-Ordner und ziehen Sie den

Demo Session-Ordner auf Ihre Festplatte (das

beste Ergebnis erzielen Sie mit einer von Avid

qualifizierten externen Festplatte anstatt mit dem

Systemlaufwerk).
Einführung in Pro Tools
• Laden Sie die Pro Tools-Demo von Ihrem Online-

Avid-Konto auf Ihre Festplatte herunter (das beste

Ergebnis erzielen Sie mit einer vonAvid qualifizierten

externen Festplatte anstatt mit dem Systemlaufwerk).

2 Starten Sie Pro Tools.

3 Je nachdem, was Sie auf Ihrem Bildschirm sehen,

wählen Sie eine der folgenden Vorgehensweisen:

• Wenn das Schnellstart-Dialogfeld erscheint,

klicken Sie auf Session öffnen und dann auf OK.

Navigieren Sie zur Demo Session-Datei (.ptx),

wählen Sie sie aus und klicken Sie auf Öffnen.

• Wenn das Schnellstart-Dialogfeld nicht

erscheint, gehen Sie auf Datei > Session öffnen,

navigieren Sie zur Demo Session-Datei (.ptx),

wählen Sie sie aus und klicken Sie auf Öffnen.

Weitere Informationen zur Demo-Session finden
Sie im Readme-Dokument zur Demo-Session.
Spuren

Symbol-

leiste
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So geben Sie die Demo-Session wieder:

1 Drehen Sie die Lautstärke Ihres Audio-Interfaces

herunter, damit Sie das Audio nicht in einer

unangenehm hohen Lautstärke wiedergeben.

2 Starten Sie die Wiedergabe der Demo-Session in

Pro Tools. So starten oder beenden Sie Pro Tools:

• Drücken Sie die Leertaste auf Ihrer Computertastatur.

• Klicken Sie auf die Play- oder Stop-Schaltfläche

im Transport-Fenster (Fenster > Transport) oder

in der Symbolleiste des Edit-Fensters.

3 Stellen Sie den Monitorpegel auf eine angenehme

Lautstärke ein, während die Session abgespielt wird.

4 Erkunden Sie Pro Tools, während die Demo-

Session abgespielt wird (verschiedene Optionen

hierzu finden Sie im Fenster-Menü):

• Das Edit-Fenster bietet eine Timeline-Ansicht von

Audio-, Video- und MIDI-Daten und

Mischautomation zum Aufnehmen, Editieren und

Anordnen von Spuren. Verwenden Sie das Edit-

Fenster zum Bearbeiten und Arrangieren von

Audio-, MIDI- und Automationsdaten Ihrer

Session.

• Im Mix-Fenster erscheinen Spuren als Kanalzüge –

wie auf einem Mischpult – mit Pegelanzeigen und

Steuerelementen für Plug-In- und Hardware-

Inserts, Sends, Eingangs- und Ausgangszuweisungen,

Panoramaregler, Lautstärke, Solo, Mute und

Scharfschalten. Verwenden Sie das Mix-Fenster

zum Routen und Mixen von Audio und MIDI in

Ihrer Session.

Stop- und Play-Schaltflächen im Transport-Fenster

AbspielenStoppen
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• Das Transport-Fenster beinhaltet Steuerelemente

für Transport-Funktionen wie Abspielen, Stoppen,

Aufnahme, Vor- und Zurückspulen.

• Plug-In-Fenster bieten Steuerungen für Audio-

Bearbeitung und Virtual Instrument-Plug-Ins.

• In MIDI Editor-Fenstern bearbeiten Sie MIDI-

Daten mit Hilfe eines Interfaces im Notenrollen-

Stil, mit Breakpoint-Editing und mit

herkömmlicher Notenschrift.

• Im Noten-Editor-Fenster bearbeiten Sie die

MIDI-Daten einer Session mit Hilfe herkömmlicher

Notenschrift. Sie können die Partitur sogar direkt

von Pro Tools ausdrucken.

• DerWorkspace bietet eine interaktive Datenbank für

alle Medien in Ihrer Session und für Ihr gesamtes

System.

5 Drücken Sie die Leertaste oder klicken Sie auf die

Stop-Schaltfläche, um die Wiedergabe anzuhalten.

6 Wenn Sie nicht länger nur die Demo-Session

betrachten wollen, wählen Sie Datei > Session

schließen.

Die Demo-Session ist ein Beispiel für ein
umfassendes und abgeschlossenes Projekt, das
arrangiert, bearbeitet und gemischt wurde. Die
Demo-Session ist für die weiteren Inhalte
dieses Handbuchs nicht erforderlich. Sie
können sie aber wieder aufrufen, wenn Sie
weitere Funktionen von Pro Tools
kennengelernt haben.
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Anzeigen des Edit- und des Mix-Fensters
Das Edit-Fenster und das Mix-Fenster sind die zwei wichtigsten Arbeitsbereiche von Pro Tools. In diesem

Handbuch finden Sie Beispiele für die Verwendung beider Fenster für unterschiedliche Produktionsabläufe.

Anzeigen des Edit-Fensters

So blenden Sie das Edit-Fenster ein:
 Wählen Sie Fenster > Edit.
Einführung in Pro Tools
So zeigen Sie die Darstellungsoptionen im Edit-Fenster an:

 Wählen Sie Ansicht > Edit-Fenster-Ansichten > Alle.

Edit-Fenster
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Anzeigen des Mix-Fensters

So blenden Sie das Mix-Fenster ein:
 Wählen Sie Fenster > Mix.
Einführung in Pro Tools
So zeigen Sie die Darstellungsoptionen im Mix-Fenster an:

 Wählen Sie Ansicht > Mix-Fenster-Ansichten > Alle.
Mix-Fenster (mit eingeblendeten Transport- und Plug-In-Fenstern)
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Erstellen einer neuen Session
In diesem Abschnitt erfahren Sie, wie Sie eine neue

Session erstellen. Sie können eine neue Session

entweder gleich beim Start von Pro Tools erstellen

oder auch, wenn die Software bereits läuft.

So erstellen Sie eine neue Session:

1 Wenn Pro Tools noch nicht ausgeführt wird, öffnen

Sie Pro Tools.

2 Sie haben folgende Möglichkeiten:

• Wenn Sie Pro Tools starten und das Schnellstart-

Dialogfeld geöffnet wird, wählen Sie Leere

Session erstellen und klicken Sie auf OK.

• Wählen Sie Datei > Neue Session. Wenn bereits

eine Session geöffnet ist, werden Sie aufgefordert,

Ihre Änderungen zu speichern. Wählen Sie im

Neue Session-Dialogfeld die Leere Session

erstellen-Option und klicken Sie auf OK.

3 Geben Sie im Speichern-Dialogfeld an, wo die

Session gespeichert werden soll, geben Sie ihr

einen Namen und klicken Sie auf Speichern.

Sie haben soeben eine neue Session ohne Spuren

erstellt. Als Nächstes schließen Sie ein Mikrofon-

oder Instrumentenkabel an und erstellen neue

Spuren für die Audioaufnahme.
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Aufnehmen von Audio
In diesem Abschnitt wird erläutert, wie Sie ein

Mikrofon oder ein Instrument (z. B. Gitarre oder

Keyboard) an eine Mbox anschließen und Audio

aufnehmen.

Anschließen eines Mikrofons oder 
Instruments an eine Mbox

So schließen Sie ein Mikrofon oder ein Instrument an:

1 Sie haben folgende Möglichkeiten:

• Wenn Sie ein Mikrofon verwenden, schließen

Sie es mit einem XLR-Kabel an einen Mic-/Line-

Eingang einer Mbox an.

• Wenn Sie ein Instrument verwenden, schließen

Sie es mit einem Instrumentenkabel an einen

DI-Eingang einer Mbox an.

2 Sie haben folgende Möglichkeiten:

• Bei Verwendung einer Mbox stellen Sie sicher,

dass die Taste zum Umschalten zwischen vorne

und hinten für die richtige Verbindung (Vorder-

oder Rückseite) eingestellt ist.

• BeiVerwendung einer Mbox Mini stellen Sie sicher,

dass entweder der Line/DI-Schalter oder der

Mic/Line-Schalter für die jeweilige Verbindung

richtig eingestellt ist – je nachdem, welchen

Eingang Sie verwenden.
Anschließen eines Mikrofons mit einem XLR-Kabel an den Mic/Line-Eingang 1 auf der Rückseite einer Mbox

Quellen-Selektor für

Eingang 1 (Front-

/Rear-Taste) Eingang 1

Mic/Line-Eingang
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Erstellen einer Spur

Pro Tools verwendet Spuren zum Aufnehmen von

Audio und MIDI in einer Session. Bevor Sie eine

Audioaufnahme starten können, müssen Sie eine

Audiospur erstellen.

So erstellen Sie eine Instrumentenspur und

bereiten sie für die Aufnahme vor:

1 Erstellen Sie eine neue Session oder öffnen Sie

eine bestehende Session.

2 Wählen Sie Spur > Neu.

3 Um von einem einzelnen an Ihr Audio-Interface

angeschlossenen Mikrofon oder einem Instrument

aufzunehmen, wählen Sie im Neue Spuren-

Dialogfeld 1 Mono-Audiospur in Samples und

klicken Sie auf Erstellen.

Wenn Sie beide Eingänge gleichzeitig aufnehmen

möchten, erstellen Sie je nach angeschlossenen

Geräten und der gewünschten Aufnahmequelle eine

Stereospur oder zwei Monospuren:

• Zur Aufnahme zweier unterschiedlicher Quellen

(z. B. einer Gesangsstimme und einer E-Gitarre)

erstellen Sie zwei Mono-Audiospuren. Auf diese

Weise können Sie zwei Eingangssignale gleichzeitig

aufnehmen. Nach der Aufnahme können diese

unabhängig voneinander editiert, verarbeitet und

abgemischt werden.

• Erstellen Sie zum Aufnehmen einer Zweikanal-

Stereo-Quelle (z. B. eines Stereo-Keyboards)

eine Stereo-Audiospur.

4 Öffnen Sie das Mix-Fenster, indem Sie Fenster > Mix

auswählen.

Erstellen einer neuen Mono-Audiospur
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5 In der Mitte des Kanalzugs der neuen Spur wird

„Analog 1 (Mono)“ angezeigt. Dies zeigt an,

welcher Eingangskanal (Eingang 1 oder

Eingang 2) dieser Spur zugewiesen ist. Sie können

einen anderen Eingangskanal angeben, indem

Sie auf den Audioeingangspfad-Selektor klicken

und den anderen Kanal wählen.

Aufnehmen Ihrer Performance in einer 
Spur

So nehmen Sie eine Audiospur auf:

1 Klicken Sie auf die Scharfschalten-Schaltfläche,

um die Spur zum Aufnehmen scharfzuschalten.

Das Steuerelement blinkt rot.

2 Singen oder spielen Sie in das Mikro oder spielen

Sie Ihr Instrument.

Behalten Sie die Pegelanzeige in Ihrer Pro Tools-

Spur im Auge, während Sie die Eingangsverstärkung

(„input gain“) auf Ihrem Audio-Interface erhöhen.

(Beachten Sie, dass es keinen Einfluss auf den

Eingangspegel hat, wenn Sie die Fader auf der

Softwareoberfläche bewegen – diese sind nur für

die Abhörpegel.)

Scharfschalten einer Spur im Mix-Fenster

Audio-

eingangspfad

-Selektor

Scharfschalten-Schaltfläche
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3 Drehen Sie den Eingangs-Gain auf Ihrem Audio-

Interface im Uhrzeigersinn, bis die Pegelanzeige

auf dem Bildschirm meistens grün ist und nur

bei lauteren Passagen gelb.

• Wenn die Pegelanzeige rot wird, ist dieVerstärkung

zu hoch. Verringern Sie den Eingangs-Gain.

• Wird kaum ein grüner Pegel angezeigt, ist die

Verstärkung zu gering. Erhöhen Sie den

Eingangs-Gain.

Gain für Eingang 1 (Mbox)

Pegelanzeige der Spur
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4 Klicken Sie im Transport-Fenster auf „Zurück

zu Null“, wenn Sie die Wiedergabe am Anfang

der Session beginnen möchten.

5 Klicken Sie im Transport-Fenster auf die

Aufnahme-Schaltfläche, um die Session zum

Aufnehmen scharfzuschalten. Das

Steuerelement blinkt rot. (Das teilt Pro Tools

mit, dass Sie zur Aufnahme bereit sind. Diese

Schaltfläche ist quasi der Hauptschalter für die

Session.)

6 Wählen Sie Fenster > Edit, damit Sie beobachten

können, was während der Aufnahme geschieht.

7 Wenn Sie zurAufnahme bereit sind, drücken Sie

die Leertaste oder klicken Sie auf die Abspielen-

Schaltfläche im Transport-Fenster. Die

Aufnahme-Schaltfläche im Transport-Fenster und

die Scharfschalten-Schaltfläche der Spur

leuchten während der Aufnahme rot.

8 Zum Beenden derAufnahme drücken Sie entweder

erneut die Leertaste oder klicken Sie auf die

Stoppen-Schaltfläche im Transport-Fenster.

(Die Aufnahme-Schaltfläche im Transport-

Fenster wird deaktiviert, doch die

Scharfschalten-Schaltfläche der Spur bleibt

aktiviert und blinkt rot, bis Sie darauf klicken.)

Zurück zu Null Abspielen Aufnahme
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Sie haben soeben Ihre erste Audiospur aufgenommen.

Abhören Ihrer Aufnahme

Nachdem Sie Audiomaterial aufgenommen haben,

können Sie es zum Überprüfen, Editieren und Mixen

wiedergeben.

So geben Sie eine aufgenommene Spur wieder:

1 Klicken Sie erneut auf die Scharfschalten-

Schaltfläche, um den Aufnahme-Modus zu

deaktivieren. Die Scharfschalten-Schaltfläche

hört auf, rot zu blinken.

2 Um mit der Wiedergabe zu beginnen, drücken

Sie die Leertaste oder klicken Sie im Transport-

Fenster auf die Abspielen-Schaltfläche.

3 Zum Beenden der Wiedergabe drücken Sie

entweder erneut die Leertaste oder klicken Sie

im Transport-Fenster auf die Stoppen-

Schaltfläche.

Aufnehmen von mehr Spuren

Wiederholen Sie einfach dieselben Schritte, um eine

weitere Audiospur (Mono oder Stereo) zu erstellen,

und fahren Sie mit der Aufnahme weiterer Spuren

fort. Auf diese Art können Sie vor dem Hintergrund

derbereitsaufgenommenenSpurenzusätzlicheStimmen

aufnehmen. Dies ist eine gängige Produktionstechnik,

um verschiedene Stimmen übereinanderzulegen

und ein Songarrangement zu erstellen.

Eine Mono-Audiospur nach der Aufnahme
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Zeitmessung in Minuten und 
Sekunden oder Takten und 
Schlägen
In Pro Tools können Sie Zeit in Minuten und
Sekunden (absolute Zeitangabe) oder Takten und
Schlägen (relative Zeitangabe) messen. Für die

Musikproduktion empfiehlt es sich zumeist, die

Zeitmessung in Takten und Schlägen zu wählen.

Das Timing von Schlägen ist relativ, da es vom

Tempo abhängt. Das Timing von Takten ist relativ,

da es von der Taktart abhängt.

In Pro Tools können Sie Tempo- und Taktartwechsel

mit Hilfe von Marken in der Session-Timeline oben

im Edit-Fenster setzen. Anhand dieser Einstellungen

wird die relative Dauer von Takten und Schlägen
im Vergleich mit der absoluten Dauer von Minuten
und Sekunden (oder Samples) berechnet.

Unterschiedlichen Zeitmessungen werden in

Pro Tools als tickbasierte (relative) Zeit im

Gegensatz zu samplebasierter (absoluter) Zeit

bezeichnet und sowohl Audio- als auch MIDI-

Daten können so eingerichtet werden, dass sie einer

dieser Einstellungen auf einer Spur-zu-Spur-Basis

folgen (nähere Informationen hierzu finden Sie im

Pro Tools-Referenzhandbuch).
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Einführung in Pro Tools
Pro Tools-Timeline und -Hauptzähler (mit der Haupt-Zeitskala in Minuten und Sekunden)

Hauptzähler

Timeline

Grid-

Modus

(Raster-

Modus)

Timebase-

Leiste
In dieser Pro Tools-Session ist die Haupt-Zeitskala
für die Timeline standardmäßig auf Min:Sek

(Minuten und Sekunden) eingestellt. Sie können die

Haupt-Zeitskala jedoch zu Takte|Schläge ändern,

wenn Sie mit einer Metronomspur in einer

festgelegten Taktart und einem festgelegten Tempo

aufnehmen möchten. Die Haupt-Zeitskala auf Takte
und Schläge zu setzen ist auch dann hilfreich, wenn

Sie Audio und MIDI in einem Takte|Schläge-Raster

erstellen, bearbeiten und arrangieren möchten.

Ändern der Haupt-Zeitskala

So stellen Sie die Haupt-Zeitskala ein:

 Klicken Sie auf einen Hauptzähler-Selektor

(oben im Edit- oder Transport-Fenster, wenn

Zähler angezeigt werden) und wählen Sie eine

Zeitskala aus.

Hauptzähler-Selektor (im Edit-Fenster)
 Wenn eine Zeitbasis-Leiste angezeigt wird, klicken

Sie auf ihren Namen, sodass sie hervorgehoben

wird.

Wenn Sie die Haupt-Zeitskala auf die derzeit
im Nebenzähler angezeigte Zeitbasis einstellen,
werden die zwei Zeitskalen vertauscht, d. h.,
die Sub-Zeitskala wird auf die Haupt-Zeitskala
eingestellt.

Einstellen der Haupt-Zeitskala auf „Takte|Schläge“
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Aufnehmen mit einer 
Metronomspur
Eine „Klick“-Spur (Metronomspur) bietet während der

Aufnahme einen Metronom-Klick als Temporeferenz.

Setzen Sie die Haupt-Zeitskala auf Takt|Schläge

statt auf Min:Sek, um Ihr Material mit der

festgelegten Taktart und dem festgelegten Tempo

aufzunehmen und zu bearbeiten.

So erstellen Sie eine Metronomspur:

1 Wählen Sie Spur > Metronomspur erstellen.

Pro Tools erstellt mit dem Klick II-Plug-In auf dem

Insert der ersten Spur eine neue Auxiliary-Eingangs-

Spur. Wenn Sie mit der Wiedergabe oder

Aufnahme beginnen, zählt Ihnen der Klick das

Tempo vor und bietet je nach Taktart und Tempo-

Karte in der Pro Tools-Timeline eine fortlaufende

Referenz.

2 Wählen Sie Ansicht > Transport > MIDI

Bedienelemente, um die MIDI-Steuerelemente

im Transportfenster anzuzeigen.

3 Stellen Sie sicher, dass im Transport-Fenster die

Metronom- und die Vorzählen-Schaltflächen

aktiviert sind.

4 Wenn Sie möchten, dass der Klick dem Session-

Tempo (in der Timeline) folgt, aktivieren Sie die

Dirigent-Schaltfläche. Wenn Sie das Tempo

manuell anpassen möchten, deaktivieren Sie die

Dirigenten-Schaltfläche.

5 Drücken Sie die Leertaste oder klicken Sie auf

die Abspielen-Schaltfläche im Transport-

Fenster, um die Wiedergabe zu starten und den

Klick zu hören.
Einführung in Pro Tools
So passen Sie die Metronom-Einstellungen an:

1 Wählen Sie Setup > Klick/Vorzählen.

2 Wählen Sie eine der folgenden Optionen:

• Bei Wiedergabe und Aufnahme – der Klick ist

während der Wiedergabe und der Aufnahme zu

hören.

• Nur bei Aufnahme – der Klick ist nur während

der Aufnahme, nicht während der Wiedergabe zu

hören.

• Nur beim Vorzählen – der Klick ist nur beim

Vorzählen, vor Beginn von Aufnahme oder

Wiedergabe, zu hören.

3 Klicken Sie auf OK.

Hauptzähler-Selektor (im Edit-Fenster)

Tempo

Vorzählen-Schaltfläche

Metronom (Schaltfläche)

Dirigent (Schaltfläche)
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Zum Stummschalten einer Metronomspur wählen

Sie eine der folgenden Methoden:

 Klicken Sie auf die M-Schaltfläche (M für Mute)

in den Spur-Steuerelementen auf der

Metronomspur, um sie stummzuschalten.

 Deaktivieren Sie im Transport-Fenster die

Metronom-Schaltfläche, sodass sie nicht mehr

blau hervorgehoben ist. Dann deaktivieren Sie

die Vorzählen-Schaltfläche, sodass sie nicht

mehr hervorgehoben ist. (Wenn Sie diese beiden

Optionen deaktivieren, wird die Metronomspur

stummgeschaltet und das Vorzählen ausgeschaltet.)

Festlegen der Taktart der Session
Achten Sie darauf, die Session-Taktart so zu wählen,

dass sie zu Ihrer Musik passt. Wenn die Taktart einer

Session nicht zu der Musik passt, die Sie aufnehmen,

stimmen die betonten Klicks nicht mit der gespielten

Musik überein. Das führt dazu, dass auch das

aufgenommene Material nicht in das Takte- und

Schläge-Raster im Edit-Fenster passt.

So legen Sie die Taktart für eine Session fest:

1 Doppelklicken Sie im Transport-Fenster auf die

Aktuelle Taktart-Schaltfläche.

2 Geben Sie die Taktart (Meter) für die Session ein

und stellen Sie Position auf „1|1|000“ (um das

Standard-Event durch das eingefügte Taktart-

Event zu ersetzen).

Aktuelle Taktart-Schaltfläche
Einführung in Pro Tools
3 Wählen Sie im Klick-Popup-Menü einen Notenwert

für den Takt. (Bei 6/8 wählen Sie beispielsweise

eine punktierte Viertelnote.)

4 Klicken Sie auf OK, um das neue Taktart-Event

einzufügen.

Festlegen des Tempos der Session
Neue Sessions in Pro Tools werden mit einem

Standardtempo von 120 BPM geöffnet. Wenn Sie

ein Metronom mit einem anderen Tempo als 120 BPM

zur Aufnahme benutzen möchten, stellen Sie das

Tempo entsprechend ein.

So ändern Sie das Tempo einer Session:

1 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie im Edit-Fenster auf den

Songstart-Marker.

• Klicken Sie auf das Symbol zum Hinzufügen

eines Tempowechsels (+) oben in der Tempo-

Leiste.

Taktartwechsel-Fenster
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2 Geben Sie im Tempowechsel-Dialogfeld den

BPM-Wert für die Session ein.

3 Stellen Sie Position auf „1|1|000“ (um das

Standard-Event durch das eingefügte Tempo-

Event zu ersetzen).

4 Wählen Sie im Auflösung-Popup-Menü einen

Notenwert für den Takt aus. (Bei 6/8 wählen Sie

beispielsweise eine punktierte Viertelnote.)

5 Klicken Sie auf OK.

Tempoleiste

Tempowechsel-Fenster

Sie können ein bestimmtes Tempo eingeben
oder mit der T-Taste das Tempo „klopfen“.

Songstart-Marker

Tempowechsel hinzufügen (Schaltfläche)

Tempoleiste
Einführung in Pro Tools
Verwenden des Manuell 
Tempo-Modus
Im Manuell Tempo-Modus ignoriert Pro Tools die

Tempo-Events in der Tempo-Leiste und gibt stattdessen

ein manuelles Tempo wieder. Das manuelle Tempo

kann durch „Klopfen“ eingegeben werden.

So geben Sie Tempo manuell ein:

1 Stellen Sie sicher, dass die MIDI-Steuerelemente

im Transport-Fenster angezeigt werden (unter

Ansicht > Transport > MIDI Bedienelemente).

2 Deaktivieren Sie im Transport-Fenster die Tempo-

Leiste – klicken Sie dazu auf die Dirigent-

Schaltfläche, sodass sie nicht hervorgehoben ist.

Pro Tools schaltet in den Manuell Tempo-

Modus um. In diesem Modus werden sämtliche

Tempo-Events in der Tempo-Leiste ignoriert.

3 Klicken Sie auf den Tempo-Auflösung-Selektor

und wählen Sie einen Notenwert. (Bei 6/8 wählen

Sie beispielsweise eine punktierte Viertelnote

oder bei 3/4 eine Viertelnote.)

4 So geben Sie ein neues Tempo ein:

• Klicken Sie auf den Tempowert, geben Sie eine

neue Zahl ein und drücken Sie die Eingabetaste.

• Klicken Sie auf den Tempowert und ziehen Sie ihn

nach oben oder unten, um die Einstellung zu ändern.

Um detailliertere Anpassungen vorzunehmen,

halten Sie beim Ziehen die Befehlstaste (Mac)

bzw. die Strg-Taste (Windows) gedrückt.

• Klicken Sie auf den Tempowert und drücken Sie

die T-Taste auf Ihrer Computertastatur im

gewünschten Tempo, um einen Wert festzulegen.

Manuell Tempo-Modus

Tempoauflösung

Dirigent

(Schaltfläche)

Tempo
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Importieren von Audiodateien
In vielen Musikproduktions-Workflows werden

Audio-Loops und Audio aus Sample-Bibliotheken

verwendet. So können Sie beim Aufnehmen etwa

Drum-Loops anstelle einer Metronomspur verwenden.

Sie können sogar Audio-Loops und One-Shot-Samples

aus einer Vielfalt von Quellen kombinieren und

arrangieren, um ein ganz neues Musikstück zu

erstellen.

Pro Tools bietet eine Reihe von Möglichkeiten, um

Audiodateien verschiedener Quellen in eine Session

zu importieren. Sie können Audiodateien von einer

Festplatte, einem Netzwerkdatenträger, einer

Audio-CD oder Wechselmedien über den Import

Audio-Befehl oder durch Ziehen aus einem

Workspace-Browser oder aus dem Finder (Mac) bzw.

Windows Explorer (Windows) importieren.

Über den Import Audio-Befehl
Mit dem Import Audio-Befehl können Sie Audiodateien

oder -Clips in Ihre Pro Tools-Session importieren.

So importieren Sie Audiodateien oder -Clips in eine

Session mit Hilfe des Import Audio-Befehls:

1 Wählen Sie Datei > Importieren > Audio.

2 Wählen Sie im Audio importieren-Dialogfeld

eine Audiodatei aus, um ihre Eigenschaften und

die dazugehörigen Clips anzuzeigen.
Einführung in Pro Tools
3 Um vor dem Importieren eine Vorschau einer

ausgewählten Datei oder eines Clips anzuzeigen,

klicken Sie auf die Abspielen-Schaltfläche im

Audio importieren-Dialogfeld. Klicken Sie auf

die Stoppen-Schaltfläche, um die Vorschau zu

beenden. Passen Sie die Vorschaulautstärke mit

dem vertikalen Regler an. Mit dem horizontalen

Regler unterhalb der Abspielen- und Stoppen-

Schaltflächen können Sie zu einer bestimmten

Stelle in der Datei navigieren.

4 Sie haben folgende Möglichkeiten:

• Um eine Datei oder einen Clip in die Importliste

zu übernehmen, wählen Sie sie aus und klicken

Sie auf Hinzufügen oder Konvertieren.

• Um alle Dateien und Clips im aktuellen Verzeichnis

zu importieren, klicken Sie auf Alle hinzufügen

oder Alles konvertieren.

• Um eine Datei oder einen Clip aus der Importliste

zu entfernen, wählen Sie sie aus und klicken Sie

auf Entfernen.

Audio importieren-Dialogfeld

Über den Vorschaulautstärkeregler im
Audioimportieren-Dialogfeld beeinflussen
Sie die Lautstärke der Vorschau beim
Abhören von Clips in der Clipliste.
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• Um alle Dateien oder Clips zu entfernen, klicken

Sie auf Alles entfernen.

5 Wenn Sie alle gewünschten Audiodateien und -

Clips zur Importliste hinzugefügt haben, können

Sie die Konvertierung der Samplerate wie im

Folgenden beschrieben anwenden:

• Aktivieren Sie SRC anwenden.

• Geben Sie die Quell-Sample-Rate an, indem Sie

eine Zahl eingeben oder im Popup-Menü eine

Samplerate auswählen.

• Wählen Sie die Konvertierung der Samplerate im

Qualität-Popup-Menü aus. Diese Einstellung

setzt die Sample Rate-Konvertierungsqualität-

Einstellung in dem Voreinstellungen-Menü

“Bearbeitung” außer Kraft.

6 Klicken Sie auf Fertig.

7 Wenn Sie Dateien kopieren oder konvertieren,

wählen Sie einen Speicherort für die neuen

Dateien, etwa den Audiodateien-Ordner der

aktuellen Session. Beim Hinzufügen von Dateien

wird auf den ursprünglichen Speicherort der

Datei verwiesen.

8 Wählen Sie im Audio-Importoptionen-

Dialogfeld aus, wo die importierten Dateien in

der Session platziert werden sollen.

Mit Pro Tools können Sie einer Session
Dateien mit abweichenden Samplerates
hinzufügen. Im Kommentare-Feld des Import
Audio-Dialogfelds wird eine Warnmeldung
angezeigt, dass diese Dateien mit der falschen
Geschwindigkeit und Tonhöhe wiedergegeben
werden, wenn sie nicht konvertiert werden.
Einführung in Pro Tools
Neue Spur – jede Audiodatei wird in eine eigene

Spur und in die Clipliste importiert.

Clipliste – Audiodateien werden in die Clipliste

importiert, ohne dass eine neue Spur erstellt wird.

Importierte Audiodateien werden in der Clipliste

angezeigt und können dann in Audiospuren

gezogen werden.

9 Beim Erstellen einer neuen Spur wählen Sie eine

Position für die importierte Datei in der Spur aus:

Session-Start – platziert die Datei oder den Clip am

Start der Session.

Song-Start – setzt den Beginn der Datei oder des Clips

an den Songstart-Marker.

Auswahl – setzt den Beginn der Datei oder des Clips

auf den Edit-Cursor oder auf den Beginn einer

Auswahl in der Timeline.

Spot – zeigt das Spot-Dialogfeld an, über das Sie

die Datei oder den Clip an präzisen Positionen,

basierend auf einer der verfügbaren Zeitskalen,

positionieren können.

10 Klicken Sie auf OK.

Audio-Importoptionen-Dialogfeld
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Importieren von Dateien durch Ziehen
Mit Pro Tools können Sie Audio-, MIDI-, Video- und Session-Dateien durch Ziehen von Dateien aus einem

Workspace-Browser, dem Mac Finder oder Windows Explorer auf das Pro Tools-Anwendungssymbol, in

die Session-Timeline, in eine Spur, in die Spuren-Liste oder in die Clipliste importieren.
Einführung in Pro Tools
Importieren aus dem Workspace durch Ziehen

Workspace

Ziehen von Medien oder Session-

Dateien in bestehende Spuren

oder die Spuren-Liste, um sie als

neue Spuren hinzuzufügen

Ziehen von Dateien in

die Clipliste, um sie zu

importieren
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Die folgende Abbildung zeigt einige Optionen für

das Importieren von Dateien durch Ziehen aus einem

Workspace-Browser.

So importieren Sie Dateien in die Clipliste:

1 Wählen Sie Audio-, Video-, MIDI-, Clipgruppen-,

REX- oder ACID-Dateien in einem Workspace-

Browser, im Mac Finder oder im

Windows Explorer aus.

2 Ziehen Sie die ausgewählten Dateien auf die

Clipliste.

So importieren Sie Dateien in eine vorhandene Spur:

1 Wählen Sie in einem Workspace-Browser, im

Mac Finder oder imWindows Explorer die Dateien

für den Import aus.

2 Ziehen Sie die ausgewählte Datei auf eine Position

in einer kompatiblen Spur.

So importieren Sie Dateien als neue Spur:

1 Wählen Sie in einem Workspace-Browser, im

Mac Finder oder imWindows Explorer die Dateien

für den Import aus.

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie die Dateien bei gedrückter Umschalttaste

an eine beliebige Stelle im Edit-Fenster.

• Ziehen Sie die Dateien in die Spuren-Liste.

• Ziehen Sie die Dateien in einen leeren Bereich des

Edit-Fensters (unter einer Spur oder zwischen

Spuren).
Einführung in Pro Tools
Bearbeiten von Audiomaterial
In Pro Tools können Sie Audiomaterial in Spuren

mit verschiedenen Optionen für Trimmen, Trennen,

Ausschneiden bzw. Kopieren und Einfügen,

Verschieben, Neuarrangieren und mehr bearbeiten.

Trimmen von Audioclips
Das folgende Beispiel zeigt, wie Sie durch einfaches

Editieren die Stelle ändern können, an der ein Song

beginnt. In diesem Beispiel hört man, wie der

Schlagzeuger das Tempo „vorzählt“

(„1...2...1.2.3...“), bevor der Song beginnt (gehen

wir davon aus, dass diese Stereospur von einem der

Overhead-Mikros des Schlagzeugs stammt). So sieht

das Audiomaterial in Pro Tools aus:

Die Stereo-Wellenformen geben eine Vorstellung

von den unterschiedlichen Abschnitten des Songs.

Dieses „Was Sie sehen, ist was Sie hören“-Prinzip

von Pro Tools kann dafür genutzt werden, das

Vorzählen ganz einfach durch Trimmen des

Songanfangs zu entfernen.

Song-BeginnVorzählen
Wellenformen

(linker und

rechter Kanal)
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So trimmen Sie einen Audioclip:

1 Wählen Sie das Trim-Tool aus (in der Symbolleiste

des Edit-Fensters).

2 Klicken Sie dort in die Spur, wo das Vorzählen

aufhört und der Song anfängt (der Cursor zeigt

das Trim-Symbol an). Ziehen Sie den Beginn

des Clips nach rechts, um ihn (zeitlich gesehen)

nach vorne zu verschieben, oder ziehen Sie den

Beginn des Clips nach links, um ihn nach hinten

zu verschieben.

Sie können das Trimmen des Clips rückgängig

machen, indem Sie den Clip mit dem Trim-Tool

zurück nach links ziehen. Sie werden feststellen,

dass das ursprüngliche Audiomaterial (das

Vorzählen) noch da ist. Dieses Beispiel zeigt

Ihnen, wie Sie in Pro Tools nichtdestruktiv
editieren.

Kopieren und Einfügen von Clips
Im folgenden Beispiel wird gezeigt, wie Sie einen

Audioclip auf einer Spur auf andere Timeline- und

Spur-Positionen kopieren und einfügen. Dieses

Beispiel verwendet einen importierten

rhythmischen Audio-Loop.

Trim-Tool

Song-Beginn
Einführung in Pro Tools
So kopieren Sie einen Clip und fügen ihn ein:

1 Importieren Sie einen rhythmischen Audio-

Loop in eine Pro Tools-Session (siehe Abschnitt

Importieren von Audiodateien auf Seite 90).

2 Wählen Sie das Grabber-Tool oder das Selektor-

Tool aus (in der Symbolleiste des Edit-Fensters).

3 Wenn Sie das Grabber-Tool verwenden, klicken

Sie auf den Clip, den Sie kopieren und einfügen

möchten. Wenn Sie das Selektor-Tool verwenden,

doppelklicken Sie auf den Clip, den Sie kopieren

und einfügen möchten.

4 Wählen Sie Bearbeiten > Kopieren.

5 Platzieren Sie den Edit-Cursor mit dem

Selektor-Tool an der Position, an der Sie den

kopierten Clip einfügen möchten.

Edit-Tools

Verwenden Sie das Smart-Tool, damit der
Edit-Cursor zwischen verschiedenen Edit-
Tools umschaltet – je nachdem, wo Sie ihn
über einem Clip platzieren.

Auswählen eines Clips mit dem Grabber-Tool

Smart-Tool

Selektor-Tool

Grabber-Tool
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6 Wählen Sie Bearbeiten > Einfügen.

Trennen und Neuarrangieren von 
Clips
Es gibt verschiedenste Möglichkeiten, neue Audio-

Clips in Pro Tools zu erstellen. Sie können Audioclips

als ganze Datei importieren oder aufnehmen

(Ganze Datei-Clips). Oder Sie erstellen

Audioclips, die sich nur auf Teile von

Audiodateien beziehen, indem Sie eine ganze

Clipdatei trimmen (siehe Abschnitt Trimmen von

Audioclips auf Seite 93) oder trennen.

Im folgenden Beispiel sehen Sie verschiedene

Möglichkeiten, Audioclips in einer Session zu trennen

und neu zu arrangieren. Dieses Beispiel verwendet

einen importierten rhythmischen Audio-Loop.

Einfügen eines Clips an einer anderen Zeitposition auf
einer anderen Spur

Drücken Sie Befehl + C (Mac) oder Strg + C
(Windows), um die aktuelle Edit-Selektion in
die Zwischenablage zu kopieren. Drücken Sie
Befehl + V (Mac) oder Strg + V (Windows),
um den Inhalt der Zwischenablage in die
aktuelle Edit-Position einzufügen.
Einführung in Pro Tools
Trennen von Clips an der Edit-Selektion
So trennen Sie einen Clip an der aktuellen Edit-

Position:

1 Nehmen Sie mit dem Selektor-Tool eine Edit-

Selektion in einem Audioclip vor.

2 Wählen Sie Bearbeiten > Clip trennen > An

Auswahl.

Vornehmen einer Edit-Selektion

Drücken Sie Befehl + E (Mac) oder Strg + E
(Windows), um Clips an der aktuellen Edit-
Selektion zu trennen.

Erstellen neuer Clips durchTrennen des übergeordneten
Clips an den Grenzen der Edit-Selektion
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Neuarrangieren getrennter Clips

Clips können in Pro Tools auf verschiedene Arten

neu arrangiert werden. Der gewählte Edit-Modus

(wird ganz links in der Symbolleiste des Edit-Fensters

eingestellt) bestimmt, wie Pro Tools mit Audioclips

umgeht, wenn diese verschoben werden. Im folgenden

Abschnitt sehen Sie einige der vielen Möglichkeiten

zum Arrangieren von Audioclips in Ihrer

Pro Tools-Session.

Sie haben folgende Möglichkeiten, um Clips neu zu

arrangieren:

 Ziehen Sie mit dem Grabber-Tool im Slip-Modus

einen Audioclip an eine neue Position. Der Clip

wird an genau die Position verschoben, an die

Sie ihn gezogen haben.

 Ziehen Sie mit dem Grabber-Tool im Grid-

Modus einen Audioclip an eine neue Position.

Der Clip wird, nachdem Sie ihn loslassen, an der

nächsten Grid-Position ausgerichtet.

Verwenden Sie „Bearbeiten > Clip trennen >
Am Raster“, um die Audio-Auswahl
entsprechend dem aktuellen Raster zu trennen.
Dies ist nützlich, wenn Sie mit Audio auf einem
Takte|Schläge-Raster arbeiten. Verwenden Sie
„Bearbeiten > Clip trennen > An Transienten“,
um die Audio-Auswahl entsprechend
individueller Attacks im Audio zu trennen. Dies
ist nützlich für das Herausfiltern individueller
„Hits“ aus dem Audiomaterial – etwa jeden
Schlag in einem Drum-Loop oder jede Note in
einem Gitarrenriff.

Edit-Modi, Grid-Modus ausgewählt
Einführung in Pro Tools
 Ziehen Sie mit dem Grabber-Tool im Spot-

Modus einen Audioclip an eine neue Position.

Das Spot-Dialogfeld öffnet sich und Sie können

eine exakte Zeitposition für den Clip angeben.

 Ziehen Sie mit dem Grabber-Tool im Shuffle-

Modus einen Audioclip an eine neue Position

zwischen anderen Clips. Angrenzende Clips

reihen sich direkt an den verschobenen Clip an.

 Wählen Sie einen Clip mit dem Grabber- oder

Selektor-Tool aus und gehen Sie auf

Bearbeiten > Duplizieren. Der ausgewählte Clip

wird dupliziert und direkt nach der aktuellen

Auswahl angereiht.

 Wählen Sie einen Clip mit dem Grabber- oder

Selektor-Tool aus und gehen Sie auf

Bearbeiten > Wiederholen. Geben Sie im

daraufhin erscheinenden Wiederholen-

Dialogfeld eine Zahl ein, mit der Sie bestimmen,

wie oft die Auswahl wiederholt werden soll, und

klicken Sie dann auf OK. Die Auswahl wird als

separate, aneinandergereihte Clips wiederholt.

Rhythmischer Audio-Loop, an Transienten getrennt
und im Shuffle-Modus aneinandergereiht

Weitere Informationen zum Editing und
Arrangieren von Audiomaterial entnehmen Sie
bitte den Abschnitten zu Edit-Modi und Edit-
Tools, Clipgruppen und Elastic Audio im
Pro Tools-Referenzhandbuch.
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MIDI-Sequencing mit einem 
Virtual Instruments-Plug-In
Im Folgenden wird anhand eines Beispiels erläutert,

wie Sie eine MIDI-Sequenz auf einer

Instrumentenspur programmieren, um ein Plug-In

für virtuelle Instrumente zu spielen. Dieses Beispiel

verwendet das Xpand!2-Plug-In von AIR Music

Technology.

Das Xpand!2-Plug-In ist Teil der AIR Creative
Collection, die im Bundle mit Pro Tools als
separates Installationsprogramm zum Download
verfügbar ist. Führen Sie das AIR Creative
Collection-Installationsprogramm mit den
dazugehörigen Inhalten aus, bevor Sie mit
diesem Beispiel fortfahren. Weitere Informationen
finden Sie im AIR Creative Collection Plug-Ins
Handbuch.
Einführung in Pro Tools
Was ist MIDI?
Bei MIDI-Daten (Musical Instrument Digital

Interface) handelt es sich nicht um Audiodaten.

MIDI erzeugt keinen Sound. MIDI ist ein Standard,

über den MIDI-fähige Geräte – wie Synthesizer,

Sampler, Controller, Keyboards und Sequencer –

Steuerinformationen austauschen, also miteinander

kommunizieren können. Im Grunde teilt MIDI

klangerzeugenden Geräten (wie Hardware-

Synthesizern oder -Samplern oder virtuellen

Software-Instrumenten) mit, was sie spielen sollen.

Das Senden und Empfangen der MIDI-Daten erfolgt

über USB oder FireWire zwischen USB- und

FireWire-kompatiblen MIDI-Interfaces und dem

Computer. Hardware-MIDI-Instrumente werden

über MIDI-Kabel an IhrMIDI-Interface angeschlossen.

Virtuelle Instrumente werden in Pro Tools als

Plug-Ins auf Instrumentenspuren eingeschleift. Sie

können in Pro Tools direkt geöffnet werden.
97



Erstellen einer Instrumentenspur mit einem Instrumenten-Plug-In
Sie können entweder eine Instrumentenspur oder eine MIDI-Spur verwenden, um MIDI-Sequenzen in Pro Tools

aufzunehmen, zu programmieren und wiederzugeben. Wenn Sie mit Virtual Instruments-Plug-Ins (wie Xpand!2

von AIR) arbeiten, ist es empfehlenswert, eine Instrumentenspur zu erstellen. In Instrumentenspuren können

Sie sowohl mit MIDI-Sequenzen arbeiten als auch Audio abhören.

Sie können auch Instrumentenspuren mit externen MIDI-Geräten verwenden.

So erstellen Sie eine Instrumentenspur und schleifen ein Instrumenten-Plug-In ein:

1 Wählen Sie Spur> Neu. Nehmen Sie im Neue Spuren-Dialogfeld die folgenden Einstellungen vor:

• Wählen Sie Stereo.

• Klicken Sie auf das Popup-Menü, in dem Audiospur steht, und wählen Sie Instrumentenspur.

• Klicken Sie auf Erstellen.

2 Wählen Sie Fenster > Mix, um das Mix-Fenster anzuzeigen.

3 Klicken Sie auf den Insert-Selektor oben in der Instrumentenspur und wählen Sie Xpand!2 im

Instrument-Untermenü.

Neue Spuren-Dialogfeld; „Stereo“ und „Instrumentenspur“ ausgewählt
Einführung in Pro Tools
Einschleifen des Xpand!2-Plug-Ins auf einer Instrumentenspur

Insert-

Selektor
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4 Ein Plug-In-Fenster mit dem Xpand!2-Plug-In erscheint. Sie können nun ein Sound-Preset für die

Wiedergabe mit MIDI auswählen.

So wählen Sie ein Sound-Preset im Xpand!2-Plug-In:

 Klicken Sie oben im Plug-In-Fenster auf das Bibliothek-Menü (<Werkstandard>) und wählen Sie ein

Preset aus einem der Untermenüs. Bei Xpand!2 sind Presets in Untermenüs nach Kategorie geordnet.

Weitere Informationen zum Xpand!2-Plug-In finden Sie im AIR Creative Collection Plug-Ins Handbuch.
Einführung in Pro Tools
Auswählen eines werkseitigen Presets im Bibliothek-Menü des Xpand!2-Plug-Ins.
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Spielen eines virtuellen 
Instruments
Sie können ein virtuelles Instrument (wie Xpand!2)

mit einer MIDI-Sequenz oder über einen externen

MIDI-Controller spielen.

So spielen Sie ein virtuelles Instrument in einer

Instrumentenspur:

 Wenn Sie einen MIDI-Controller angeschlossen

haben, können Sie das virtuelle Instrument spielen,

solange die Instrumentenspur, auf der es

eingeschliffen ist, ausgewählt oder

scharfgeschaltet ist. Während Sie spielen, können

Sie Ihre Performance als MIDI-Sequenz aufnehmen.

 Importieren Sie eine MIDI-Sequenz (oder

programmieren Sie eine MIDI-Sequenz) in die

Instrumentenspur, auf der das virtuelle Instrument

eingeschliffen ist, und starten Sie die Wiedergabe.

MIDI-Aufnahme mit externem 
Controller
Sie können in Pro Tools MIDI-Daten über einen

MIDI-Controller aufnehmen.

So nehmen Sie MIDI auf einer Instrumentenspur auf:

1 Vergewissern Sie sich, dass Ihr MIDI-Controller

entweder mit einem MIDI-Kabel an ein MIDI-

Interface oder über ein USB-Kabel direkt an Ihren

Computer angeschlossen ist.

2 Erstellen Sie eine neue Stereo-Instrumentenspur

und schleifen Sie Xpand!2 ein (siehe Abschnitt

Erstellen einer Instrumentenspur mit einem

Instrumenten-Plug-In auf Seite 98).
Einführung in Pro Tools
3 Wählen Sie ein Bass-Preset (auch bekannt als

„Patch“).

4 Wählen Sie Optionen > MIDI Thru. (Prüfen Sie,

ob MIDI Thru aktiviert ist. Ist dies nicht der Fall,

aktivieren Sie es.)

5 Klicken Sie auf die Scharfschalten-Schaltfläche

der Spur, um die Instrumentenspur für die

MIDI-Aufnahme scharfzuschalten.

6 Klicken Sie im Transport-Fenster auf die

Aufnahme-Schaltfläche.

7 Spielen Sie auf dem Keyboard Ihres MIDI-

Controllers. Nun sollten Sie den Sound hören,

den Sie ausgewählt haben.

8 Klicken Sie auf Abspielen oder drücken Sie die

Leertaste, wenn Sie mit der Aufnahme beginnen

möchten. Zum Anhalten klicken Sie auf Stoppen

oder drücken Sie erneut die Leertaste.

9 Klicken Sie erneut auf die Scharfschalten-

Schaltfläche der Spur, um die Scharfschaltung

aufzuheben, und geben Sie wieder, was Sie soeben

aufgenommen haben.

Erstellen einer MIDI-Sequenz
Sie können eine MIDI-Sequenz in Pro Tools mit

Hilfe des Stift-Tools programmieren.

Aufgenommene MIDI-Daten in einer Instrumentenspur

Beim Einfügen von MIDI-Noten oder anderen
MIDI-Daten mit dem Stift-Tool werden die
Grenzen von MIDI-Clips an den
nächstgelegenen Taktstrichen erstellt.
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So fügen Sie eine MIDI-Note in einer Spur im Edit-

Fenster ein:

1 Stellen Sie im Edit-Fenster für die MIDI- oder

Instrumentenspur die Notendarstellung ein.

2 Wählen Sie das Stift-Tool aus. Es muss auf

„Freihand“ eingestellt sein. Wenn Sie in der

Notendarstellung den Cursor auf den Playlist-

Bereich einer MIDI-Spur setzen, nimmt er die

Form eines Bleistifts (Stift-Tool) an.

Auswahl der Notendarstellung in einer
Instrumentenspur
Einführung in Pro Tools
3 So fügen Sie Viertelnoten im Takt ein:

• Stellen Sie die Haupt-Zeitskala auf

„Takten|Schläge“ ein.

• Setzen Sie den Edit-Modus auf „Grid“.

• Stellen Sie den Raster-Wert auf Viertelnoten ein.

• Legen Sie den Wert für „Dauer der MIDI-Noten“

auf Viertelnoten (oder auf Raster folgen) fest.

4 Bewegen Sie das Stift-Tool über die Playlist der

MIDI- oder Instrumentenspur. Verwenden Sie

die Leiste im Edit-Fenster und das Mini-

Keyboard der Spur als Referenz, um die gewünschte

Tonhöhe und zeitliche Position zu bestimmen.

Beim Arbeiten mit dem Stift-Tool werden

Cursorposition und -wert in der Symbolleiste des

Fensters angezeigt.

Cursorposition und -wert

Cursor-Tonhöhen-Position

Cursor-Timeline-Position

Stift-Cursor
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5 Wenn Sie die gewünschten Werte für Tonhöhe

und Zeit der einzufügenden Note erreicht haben,

fügen Sie die Note mit einem Mausklick ein.

Der Velocity-Wert für eingefügte Noten wird von

der Einstellung „Velocity der MIDI-Noten“

bestimmt. Die Dauer wird durch den Wert für

„Default Note Duration“ bestimmt. Im Grid-Modus

wird die Position für den Notenanfang durch den

Rasterwert bestimmt.

Wenn die Option MIDI-Noten während Editing

abspielen aktiviert ist, erklingt jede Note beim

Einfügen.

So lange Sie die Maustaste gedrückt halten, können

Sie mit dem Stift-Tool ziehen und so Tonhöhe und

Dauer der eingefügten Note verändern. Ziehen Sie

die Note nach rechts, um sie zu verlängern, ohne

dabei ihren Anfangspunkt zu verändern. Ziehen Sie

die Note nach links, um sie zu verkürzen, ohne dabei

ihren Endpunkt zu verändern.

Mit dem Stift-Tool eingefügte MIDI-Note

Bei aktiviertem Grid-Modus wird der
Anfangspunkt der MIDI-Note automatisch an
der nächstgelegenen Rastergrenze ausgerichtet.
Drücken Sie bei ausgewähltem Freihand-
Stift-Tool die Befehlstaste (Mac) bzw. die
Strg-Taste (Windows), während Sie
gleichzeitig klicken, um die Ausrichtung am
Raster vorübergehend auszusetzen.
Einführung in Pro Tools
Editieren von MIDI-Noten
MIDI-Noten können im Edit-Fenster oder in einem

MIDI Editor-Fenster bearbeitet werden, einschließlich

Anfangs- und Endpunkt, Notendauer, Tonhöhe und

Velocity-Werte. Selektor-, Grabber-, Trim- und

Pencil-Tool können auf einzelne Noten, aber auch

auf ganze Notengruppen angewendet werden.

Selektieren von MIDI-Noten

MIDI-Noten müssen vor dem Editieren selektiert

werden.

So selektieren Sie MIDI-Noten:

1 Zeigen Sie die MIDI- oder Instrumentenspur in

der Notendarstellung an.

2 Sie haben folgende Möglichkeiten:

 Klicken Sie bei gedrückter Umschalttaste mit

dem Stift-Tool oder einem Grabber-Tool auf

jede Note.

 Klicken Sie mit dem Grabber-Tool auf eine Stelle

ohne Noten (das Fadenkreuz erscheint) und ziehen

Sie ein Rechteck um die Notengruppe, die Sie

editieren möchten.

Bei aktiviertem Grid-Modus wird der Endpunkt
derMIDI-Noteautomatischamnächstgelegenen
Rasterpunkt ausgerichtet. Drücken Sie die
Befehlstaste (Mac) bzw. die Strg-Taste
(Windows) und ziehen Sie das Stift-Tool, um
die Ausrichtung am Raster vorübergehend zu
deaktivieren.

Selektieren einer Notengruppe mit einem Grabber-Tool
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Wenn bei Verwendung eines Grabber-Tools ein Teil

des Rechtecks eine Note berührt (ihren Anfangs-

oder Endpunkt), wird diese Note in die Selektion

aufgenommen.

 Ziehen Sie mit dem Selektor-Tool über den

gewünschten Notenbereich.

Bei Verwendung des Selektor-Tools werden nur

solche Noten in die Selektion aufgenommen, deren

Anfangspunkt im Selektionsbereich liegt.

Transponieren von Noten

Sie können MIDI-Noten transponieren, indem Sie

sie mit dem Stift-Tool oder einem Grabber-Tool

nach oben oder unten ziehen. Wenn mehrere Noten

selektiert wurden, werden sie alle transponiert.

So transponieren Sie eine MIDI-Note:

1 Zeigen Sie die MIDI- oder Instrumentenspur in

der Notendarstellung an.

2 Aktivieren Sie das Stift-Tool oder eines der

Grabber-Tools.

Auswählen von Noten mit dem Selektor-Tool
Einführung in Pro Tools
3 Ziehen Sie die Note bei gedrückter

Umschalttaste nach oben oder unten.

Durch das Drücken der Umschalttaste wird

sichergestellt, dass die transponierte Note ihren

Anfangspunkt behält.

Während des Ziehens wird jede neue Note akustisch

wiedergegeben und die aktuelle Cursorpositionswert-

Anzeige im Edit-Fenster zeigt die Anzahl der

Halbtonschritte sowie die Richtung (+/–) der

Transposition an.

Transponieren mit einem Grabber-Tool

Halten Sie die Ctrl-Taste (Mac) oder die
Windowstaste (Windows) gedrückt und
drücken Sie Plus (+) auf dem numerischen
Ziffernblock, um die ausgewählten MIDI-
Noten um einen Halbton nach oben zu
transponieren, oder drücken Sie Minus (–)
auf dem numerischen Ziffernblock, um die
ausgewählten MIDI-Noten um einen Halbton
nach unten zu transponieren.

Um die Kopie einer Note zu transponieren,
ohne dabei die Originalnote zu ändern, drücken
Sie beim Ziehen der Note die Wahltaste
(Mac) bzw. die Alt-Taste (Windows).
103



Verschieben von Noten

Ähnlich wie Clips können auch MIDI-Noten mit

dem Stift-Tool oder einem Grabber-Tool nach

rechts oder links verschoben werden, um ihren

Anfangspunkt in der Pro Tools-Timeline zu ändern.

Wenn vor dem Verschieben mehrere Noten selektiert

sind, werden alle gemeinsam verschoben.

So verschieben Sie eine MIDI-Note:

1 Zeigen Sie die MIDI- oder Instrumentenspur in

der Notendarstellung an.

2 Ziehen Sie die Note mit dem Stift-Tool oder

einem Grabber-Tool nach rechts oder links.

(Halten Sie die Umschalttaste gedrückt, wenn

Sie die Tonhöhe der Note beibehalten möchten.)

Beim Verschieben der Note zeigt die aktuelle

Cursorpositionswert-Anzeige im Edit-Fenster den

jeweiligen neuen Anfangspunkt an.

Wenn der Edit-Modus auf „Grid“ eingestellt ist,

wird die verschobene Note automatisch am

nächstgelegenen Rasterpunkt ausgerichtet. Wenn

der Edit-Modus auf „Spot“ eingestellt ist, öffnet

sich das Spot-Dialogfeld.

Trimmen der Anfangs- und Endpunkte 
von Noten

Ähnlich wie bei Clips können auch die Anfangs-

und Endpunkte von MIDI-Noten mit dem Trim-

Tool geändert werden. Wenn mehrere Noten selektiert

wurden, werden all diese Noten verändert.

Um die ausgewählten Noten zu kopieren,
ohne die Originalnoten dabei zu ändern,
halten Sie beim Ziehen der Noten die
Wahltaste (Mac) bzw. die Alt-Taste
(Windows) gedrückt.
Einführung in Pro Tools
So ändern Sie die Anfangs- und Endpunkte einer

Gruppe von MIDI-Noten:

1 Zeigen Sie die MIDI- oder Instrumentenspur in

der Notendarstellung an.

2 Selektieren Sie die Noten, die Sie trimmen

möchten.

3 Sie haben folgende Möglichkeiten:

• Wählen Sie das Trim-Tool.

• Verwenden Sie das Stift-Tool.

4 Bewegen Sie den Cursor an den Anfang einer

beliebigen ausgewählten Note, sodass das Trim-

Tool erscheint. Ziehen Sie nach rechts, um die

Dauer der Noten zu verkürzen, oder nach links,

um sie zu verlängern.

Wenn der Edit-Modus auf „Grid“ eingestellt ist, wird

der verschobene Anfangs- oder Endpunkt automatisch

am nächstgelegenen Rasterpunkt ausgerichtet. Wenn

der Edit-Modus auf „Spot“ eingestellt ist, öffnet sich

das Spot-Dialogfeld, in das Sie die neue Position

des Anfangs- bzw. Endpunkts der Note eingeben

können.

Ändern der Endpunkte von Noten mit dem Trim-Tool

Wenn der Grid-Modus aktiviert ist, können
Sie ihn mit Hilfe der Befehlstaste (Mac) bzw.
der Strg-Taste (Windows) vorübergehend
deaktivieren.
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Manuelles Bearbeiten der Velocity-Werte 
von Noten

Wenn für eine MIDI- oder Instrumentenspur die

Velocity-Darstellung eingestellt ist oder die Velocity-

Spur unter einer Spur angezeigt wird, wird die Attack-

Velocity jeder Note mit einem Velocity-Balken

dargestellt. Je länger der Velocity-Balken, desto

höher ist der Velocity-Wert (0–127).

So bearbeiten Sie die MIDI-Velocity im Edit-Fenster:

1 Sie haben folgende Möglichkeiten:

• Zeigen Sie die MIDI- oder Instrumentenspur in

der Velocity-Darstellung an.

• Zeigen Sie die Controller-Spur für die MIDI- oder

Instrumentenspur sowie die Velocity an.

2 Wählen Sie ein Grabber-Tool.

3 Ziehen Sie die Spitze des Velocity-Balkens

(Raute) nach oben oder unten.

Anzeigen der Velocity-Spur

Ziehen eines Velocity-Balkens

Die Velocity-Werte eines Notenbereichs
können mit einem Stift-Tool bearbeitet
werden.
Einführung in Pro Tools
Löschen von MIDI-Noten

Selektierte Noten können mit dem Löschen-Befehl

im Bearbeiten-Menü gelöscht werden. Darüber

hinaus haben Sie die Möglichkeit, selektierte

Noten mit dem Stift-Tool zu löschen.

So löschen Sie eine Gruppe von MIDI-Noten mit

dem Löschen-Befehl:

1 Wählen Sie die Noten aus, die gelöscht werden sollen.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Bearbeiten > Löschen, um die

ausgewählten Noten zu löschen. Die der Spur

zugewiesenen Controller-Daten bleiben

unverändert.

• Klicken Sie mit einem beliebigen Edit-Tool mit

der rechten Maustaste auf eine selektierte Note

und wählen Sie Löschen.

• Drücken Sie die Entf-Taste (Mac) bzw. die Rücktaste

(Windows).

Wenn Sie MIDI-Noten innerhalb eines
selektierten Zeitbereichs löschen, werden
gleichzeitig auch alle zugewiesenen
Controller- und Automation-Daten gelöscht.
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So löschen Sie eine einzelne MIDI-Note mit dem

Stift-Tool:

 Klicken Sie mit dem Stift-Tool bei gedrückter

Wahltaste (Mac) bzw. Alt-Taste (Windows) auf

die Note. Bei gedrückter Wahltaste (Mac) bzw.

Alt-Taste (Windows), wird aus dem Stift-Tool

ein Radierer-Tool.

Löschen einer Note mit dem Stift-Tool

Programmwechselbefehle und Sysex-Events
können ebenfalls durch Anklicken mit dem
Stift-Tool bei gedrückter Wahltaste (Mac)
bzw. Alt-Taste (Windows) gelöscht werden.
Einführung in Pro Tools
Mischen und Plug-In-
Verarbeitung
Dieses Kapitel befasst sich mit den Grundlagen des

Mischens in Pro Tools. Behandelt werden der

Signalfluss der Audiosignale, u. a. Ausgänge, Busse,

Inserts und Sends für Submixe und Mixdown.

Vor dem endgültigen Mixdown können schon während

einer Session verschiedene Mischvorgänge anfallen.

Während des Abmischens ermöglichen Echtzeit-

Plug-Ins und Hardware-Inserts die Verwendung von

Effekten und die Verarbeitung von Signalen. In

Pro Tools ist bereits eine Plug-In-Suite für die

Audioeffektbearbeitung enthalten, die Sie zum

ändern bereits aufgenommener Sounds verwenden

können. In diesem Abschnitt wird anhand zweier

Beispiele erläutert, wie Sie Ihren Sound mit Hilfe

von Plug-Ins bearbeiten können.

Ausführliche Informationen zu den mit
Pro Tools gelieferten Plug-Ins finden Sie im
Audio-Plug-Ins-Handbuch (Hilfe > Audio
Plug-ins Handbuch).
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Anwenden von Equalizern und 
Kompression
Beim Mixen von Audiomaterial ist es für ideale

Ergebnisse üblich, auf einzelnen Spuren Equalizer
und Kompression anzuwenden.

Equalizer (EQ) – lässt Sie das Frequenzspektrum des

Sounds gestalten. Ein einfaches Beispiel für EQs

sind die Bass- und Höhenregler auf vielen

Stereosystemen. Mit diesen Reglern können Sie die

tiefen und die hohen Frequenzen von Audio verstärken
(lauter machen) oder dämpfen (leiser machen). Sie

können EQs etwa dazu verwenden, Gitarre und Bass

voneinander zu trennen, am Drumsound zu feilen,

Stimmen zu betonen und sogar ungewollte Geräusche

herauszufiltern. In Pro Tools haben Sie eine ganze

Reihe von EQ-Plug-Ins zum Gestalten Ihres Sounds

zur Verfügung.

Kompression – lässt Sie den Dynamikverlauf Ihres

Audiomaterials glätten. Dabei kann man den

Kompressor mit einer automatischen

Lautstärkesteuerung vergleichen, die dafür sorgt,

dass die lauten Passagen nicht zu laut werden. Sie

können Kompression dazu verwenden, Gesang inniger

erscheinen oder Becken nicht zu schrill klingen zu

lassen. Ein Limiter sorgt etwa dafür, dass die Spitzen

des Audiosignals einen bestimmten Schwellenwert

nicht überschreiten, ohne dabei das Audiomaterial

anzugreifen, das diesen Wert nicht überschreitet. In

Pro Tools haben Sie eine ganze Reihe von

Dynamik-Plug-Ins zum Gestalten der Dynamik

Ihres Sounds zur Verfügung.
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So wenden Sie EQs auf einer Spur an:

1 Wählen Sie Fenster > Mix.

2 Klicken Sie oben in der Spur auf den nächsten

Insert-Selektor und wählen Sie die EQ 3 7-Band-

Option aus dem EQ-Untermenü.

Insert-Selektor für eine Spur im Mix-Fenster
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3 Das EQ III-Plug-In-Fenster öffnet sich. Für den

Anfang können Sie die Plug-In-Presets verwenden,

um auszuprobieren, wie sich die verschiedenen

Einstellungen auf Ihren Sound auswirken.

4 Starten Sie dieWiedergabe, um den Effekt zu hören.

So komprimieren Sie eine Spur:

1 Wählen Sie Fenster > Mix.

2 Klicken Sie oben in der Spur auf den nächsten

Insert-Selektor und wählen Sie Dyn 3

Compressor/Limiter aus dem Dynamics-

Untermenü. Pro Tools schleift das

Dynamics III Compressor/Limiter-Plug-In in

die Spur ein und öffnet das entsprechende Plug-

In-Fenster.

3 Das Dyn III-Plug-In-Fenster öffnet sich. Für den

Anfang können Sie die Plug-In-Presets verwenden,

um auszuprobieren, wie sich die verschiedenen

Einstellungen auf Ihren Sound auswirken.

EQ III-Plug-In-Fenster, Plug-In-Preset-Selektor
Einführung in Pro Tools
4 Starten Sie dieWiedergabe, um den Effekt zu hören.

Verwenden von Hall
Hall (Reverb) vermittelt den Eindruck einer

Raumakustik. Halleffekte sind im Grunde eine

Aneinanderreihung von Delays, die die Sound-

Reflexion von Oberflächen in verschiedenen Räumen,

Sälen und anderen Orten nachbilden. Sie können

Halleffekte verwenden, um einen künstlichen

Raumeffekt für Ihren gesamten Mix zu erzeugen,

indem Sie Sends aus Ihrer Quellspur verwenden

und zur Verarbeitung des Signals auf einer

Auxiliary-Eingangs-Spur zurückführen. Mit

Halleffekten können Sie Ihren Mix so klingen

lassen, als wäre er in einer großen Konzerthalle, in

einem kleinen Raum oder sogar in einem engen

Gang aufgenommen worden.

Eine gute Möglichkeit zum Hinzufügen von Hall in

Ihrem Mix ist eine Send/Return-Konfiguration. In

Pro Tools ermöglicht es das Verwenden von Sends

aus Spuren, Audiomaterial mehrerer Spuren auf

und durch denselben Halleffekt zu routen. Auf diese

Weise werden Ihre gesamten Quellspuren so klingen,

als ob sie im selben Raum aufgenommen wurden.

Dyn III-Plug-In-Fenster, Plug-In-Preset-Selektor
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So verwenden Sie Hall mit einer Auxiliary-Eingangs-Spur und mehreren Quellspuren:

1 Wählen Sie Fenster > Mix.

2 Wählen Sie Spur > Neu und erstellen Sie eine Stereo-Auxiliary-Eingangs-Spur. Klicken Sie dann auf

Erstellen.

3 Klicken Sie auf der eben erstellten Auxiliary-Eingangs-Spur auf den Input-Selektor und wählen Sie

Bus > Bus 1–2.

Erstellen einer neuen Auxiliary-Eingangs-Spur
Einführung in Pro Tools
Auswählen von Bus 1-2 aus dem Input-Selektor auf einer Auxiliary-Eingangs-Spur

Input-Selektor
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4 Wählen Sie Send A auf Ihrer Quellspur (siehe Abbildung unten) und wählen Sie Bus > Bus 1–2.
Einführung in Pro Tools
5 Für weitere Spuren, die Sie zur Hallbearbeitung an die Auxiliary-Eingangs-Spur senden möchten,

wiederholen Sie den letzten Schritt.

Auswählen von Bus 1–2 für Send A auf einer Audiospur

Send A-Selektor
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6 Fügen Sie der Auxiliary-Eingangs-Spur ein Hall-Plug-In hinzu.
Einführung in Pro Tools
7 Zum Einstellen der Send-Pegel von Quellspuren können Sie einzelne Send-Output-Fenster verwenden.

Alternativ können Sie auch die Sends-Ansicht so einstellen, dass die Send-Steuerelemente für einen

bestimmten Send angezeigt werden (wählen Sie etwa Ansicht > Erweiterte Sends > Send A).

8 Drücken Sie die Leertaste und schieben Sie langsam den kleinen Fader im Send-Output-Fenster oder in

den Sends-Spur-Steuerelementen nach oben. Damit legen Sie fest, wie viel Ihrer Quellspur für die

Reverb-Verarbeitung an die Auxiliary-Eingangs-Spur gesendet wird.

9 Hören Sie sich das Resultat an, passen Sie die Send-Pegel der einzelnen Spuren an und testen Sie die

verschiedenen Plug-In-Einstellungen, bis Sie den richtigen Effekt für Ihren Mix gefunden haben.

Bus-Sends von einer Audiospur auf eine Auxiliary-Eingangs-Spur zur Reverb-Bearbeitung mit D-Verb
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Verwenden von Automation
Pro Tools ermöglicht die dynamische Automation

von Mixing-Einstellungen auf den einzelnen Spurarten.

Sie können Automationsbewegungen aufzeichnen

und sie in Echtzeit während der Wiedergabe Ihrer

Session anzeigen. Sie können Automationsdaten

auch mit denselben Methoden editieren, die Sie für

Audio- und MIDI-Daten verwenden.

Schreiben von Automationsdaten

Sie können Automationsdaten aller für die

Aufzeichnung aktivierten Steuerelemente schreiben,

indem Sie diese während der Wiedergabe bewegen.

So schreiben Sie Automationsdaten auf Spuren:

1 Wählen Sie Fenster > Automation.

2 Stellen Sie sicher, dass der Automationstyp für

die Aufzeichnung aktiviert (Für Aufnahme

aktiv) ist.

3 Klicken Sie im Mix- oder Edit-Fenster auf den

Automation Mode-Selektor jeder Spur, die Sie

automatisieren möchten, und stellen Sie den

Automationsmodus ein. Wählen Sie für den

ersten Automationsdurchgang Schreiben.

4 Starten Sie die Wiedergabe, um mit der

Aufzeichnung der Automation zu beginnen.

5 Bewegen Sie die Steuerelemente, die Sie

automatisieren möchten (beispielsweise einen

Lautstärke-Fader der Spur).

6 Stoppen Sie nach Beendigung des Vorgangs die

Wiedergabe.

7 Schalten Sie den Automationsmodus zurück auf

Schreiben, um die soeben aufgenommene

Automation wiederzugeben.
Einführung in Pro Tools
Manuelles Bearbeiten von Automation
Pro Tools bietet für alle Spuren in einer Session

verschiedene Möglichkeiten, Automationsdaten zu

bearbeiten. Sie können Automationsdaten grafisch

bearbeiten, indem Sie Breakpoints in Automations-
Playlists anpassen. Sie können Automationsdaten

auch in der gleichen Weise wie Audio- und MIDI-

Daten ausschneiden, kopieren und einfügen.

Automation-Fenster, Lautstärkeautomation aktiviert

NachdemerstenAutomationsdurchgangkönnen
Sie der Spur zusätzliche Automationsdaten
hinzufügen, ohne den vorherigen Durchgang
völlig zu löschen. Dazu müssen Sie den Touch-
oder Latch-Modus wählen. In diesen beiden
Modi werden nur dann neue Automationsdaten
hinzugefügt, wenn Sie einen Regler des
betreffenden Parameters verschieben.

Automation-

Fenster

Spur

Automation

Mode-

Selektor

Verschieben

des Lautstärke-

Faderswährend

der Wiedergabe
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Die Automationsdaten werden als Liniendiagramm

mit editierbaren Breakpoints dargestellt.

Durch Ziehen dieser Breakpoints lassen sich die

Automationsdaten direkt im Edit-Fenster und in den

MIDI Editor-Fenstern editieren. Wenn Sie einen

Automations-Breakpoint nach oben oder unten ziehen,

wird die Wertänderung angezeigt.

Das Ziehen eines Automations-Breakpoints nach

links oder rechts ändert den Zeitpunkt, zu dem das

Automations-Event gesendet wird.

Um den Automationstyp des Breakpoints auf einer Spur

anzuzeigen, wählen Sie entweder die entsprechende

Spurdarstellung aus oder blenden Sie die entsprechende

Automations- oder Controller-Spur unter der Spur

ein. Beispielsweise können Sie Lautstärke, Panorama,

Mute, MIDI-Controller-Daten oder sogar Plug-In-

Automation anzeigen und bearbeiten.

Automations-Breakpoint

Automations-Breakpoint-Wert
Einführung in Pro Tools
Verwenden des Grabber-Tools

Mit dem Grabber-Tool können Sie durch Klicken auf

eine Diagrammlinie neue Breakpoints erstellen oder

durch Ziehen die Position vorhandener Breakpoints

ändern. Zum Entfernen von Breakpoints klicken

Sie mit dem Grabber-Tool bei gedrückter Wahltaste

(Mac) bzw. Alt-Taste (Windows) darauf.

Spurdarstellung und Automation-Spuren

Verwenden des Grabber-Tools zum Erzeugen eines
neuen Breakpoints

Spuransicht

-Selektor

Automation

Type-Selektor

Automation-

Spuren

Spurdarstel-

lung

„Lautstärke-

Automation“
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Verwenden des Stift-Tools

Mit dem Stift-Tool können Sie neue Breakpoints

erzeugen, indem Sie auf die Diagrammlinie klicken.

Zum Entfernen von Breakpoints klicken Sie mit

dem Stift-Tool bei gedrückter Wahl- (Mac) bzw.

Alt-Taste (Windows) darauf.

Verwenden des Pencil-Tools zum Löschen eines
Breakpoints
Einführung in Pro Tools
Verwenden des Trim-Tools

Mit dem Trim-Tool können Sie alle selektierten

Breakpoints nach oben oder unten verschieben,

indem Sie sie innerhalb der Selektion ziehen.

Verwenden des Trim-Tools zum Verschieben von
Breakpoints
Exportieren Ihres Mix
Nachdem Sie die Spuren Ihrer Pro Tools-Session fertig aufgenommen, bearbeitet und gemischt haben, ist

Ihre Session zum Abmischen und Exportieren bereit, damit Sie das Ergebnis auf eine CD brennen oder im

Internet veröffentlichen können. Sie können den Befehl Bounce auf die Festplatte verwenden, um Ihren

Mix von der Session in eine einzelne Audiodatei zu exportieren.

So exportieren Sie den Mix von Ihrer Session als Stereo-Audiodatei.

1 Verwenden Sie den Selektor, um die Länge der Session in der Timeline (oder in der Spur) festzulegen.
Timeline-Selektion für „Bounce auf die Festplatte“

Timeline-Selektion:

Session-Audio

selektiert und für

„Bounce auf die

Festplatte“ bereit

Selektor-Tool
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2 Wählen Sie Datei > Bounce > Festplatte.

3 Nehmen Sie im Bounce-Dialogfeld die folgenden

Einstellungen vor:

• Wählen Sie die Bounce-Quelle (dies ist für Ihren

Mix der Pfad für den Hauptkanal, wie etwa main

(Stereo) –> Analog 1–2).

• Wählen Sie den Dateiyp (z. B. WAV).

• Wählen Sie Interleaved als Format.

• Wenn Sie vorhaben, die gebouncte Audiodatei

auf eine CD zu brennen, legen Sie 16 Bit für die

Bittiefe fest.

• Wenn Sie vorhaben, die gebouncte Audiodatei

auf eine CD zu brennen, legen Sie 44,1 kHz für

die Sample-Rate fest.

• Wählen Sie die Offline-Option für Bouncen

schneller als in der Echtzeit.

4 Klicken Sie auf Bounce. (Wenn Sie keinen

Bereich in der Timeline selektieren, wird die

gesamte Session von Anfang bis Ende gebounct.)

5 Tippen Sie im Speichern-Dialogfeld den Namen

derAudiodatei, die Sie bouncen, und wählen Sie

einen Speicherort.

Bounce-Dialogfeld
Einführung in Pro Tools
6 Klicken Sie auf Speichern.

Pro Tools beginnt mit dem Bouncen auf die Festplatte.

Wenn die Offline-Option deaktiviert ist, erfolgt das

Bouncen in Pro Tools in der Echtzeit, sodass Sie

während des Bounce-Vorgangs die

Audiowiedergabe Ihrer Mischung anhören können.

(Währenddessen können Sie jedoch keine Pro Tools-

Steuerelemente betätigen.)

Brennen der Mischung auf eine 
CD
Nach Abschluss des Bounce-Vorgangs erhalten Sie

eine Audiodatei, die Sie auf eine Audio-CD brennen

können. Verwenden Sie dazu eine Software zum

Brennen von CDs (etwa iTunes oder Roxio Toast).

Die Audiodatei kann dann auf Standard-CD-Playern

wiedergegeben werden. Das Anhören einer

Referenz-CD außerhalb des eigenen Studios ist ein

lang erprobtes Verfahren zum Prüfen der Umsetzung

der Mischung auf anderen Systemen oder in einer

anderen Hörumgebung.

Weitere Informationen
Wir hoffen, mit dieser kurzen Einführung Ihr

Interesse an der Musikgestaltung mit Pro Tools

geweckt zu haben. Lesen Sie bitte das Pro Tools-
Referenzhandbuch (Hilfe > Pro Tools Reference

Handbuch), um mehr zu den hier vorgestellten

Themen zu erfahren und ausführliche

Informationen zu Pro Tools-Systemen und -

Software zu erhalten. Das Pro Tools-
Referenzhandbuch bietet detaillierte Informationen

zu allen Pro Tools-Features und -Arbeitsabläufen,

geordnet nach Audio- und Musikproduktions-

Aufgaben (wie etwa Aufnahme, Editing und

Abmischen).

Sie können außerdem online die Pro Tools-Hilfe

benutzen (Hilfe > Pro Tools Hilfe), um Antworten

zu spezifischen Themen zu erhalten.
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Introducción a Pro Tools
Lee esta guía si eres un usuario nuevo de

Pro Tools® | Software. La guía contiene ejemplos de

cómo grabar, editar y mezclar audio y explicaciones

sobre el uso de MIDI en Pro Tools.

Si todavía no tienes instalado Pro Tools, instálalo

según las instrucciones en la Guía de instalación de
Pro Tools. Para obtener información sobre la

conexión e instalación de drivers de tu sistema de

audio, consulta la documentación correspondiente.
Introducción a Pro Tools
Conectar auriculares o 
altavoces
Para escuchar el audio de Pro Tools, conecta

auriculares o altavoces a tu hardware de audio (esta

guía usa un interface de audio Pro Tools | Mbox®

de ejemplo). Si utilizas auriculares, baja el nivel

de volumen Headphone (girándolo en sentido

contrario a las agujas del reloj). Si utilizas

altavoces, baja el nivel de volumen general

(Master) girándolo en sentido contrario a las agujas

del reloj. Es importante que empieces con el

volumen bajo para no hacerte daño en los oídos o

perjudicar tu equipo. Una vez que hayas iniciado

Pro Tools, abre o crea una sesión y ajusta los

controles de volumen a tu gusto para una escucha

apropiada.
Controles y conectores del panel frontal de Mbox

Conexiones del panel posterior de Mbox

Nivel de auriculares

Nivel de volumen

principal

Jack de auriculares de 1/4"
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Reproducción de la sesión de 
demostración
Utiliza la sesión de demostración para comprobar

tus auriculares y altavoces y comenzar a explorar lo

que puedes hacer con Pro Tools.

Para instalar y abrir la sesión de demostración:

1 Lleva a cabo uno de estos procedimientos:

• Coloca el disco Pro Tools Installer en tu unidad

de DVD, ubica y abre la carpetaAdditional Files;

después arrastra la carpeta Demo Session a tu

disco duro (para más velocidad, usa un disco

duro externo homologado por Avid en lugar del

disco de sistema).

• Descarga la sesión de demostración de Pro Tools

de tu cuenta Avid online a tu disco duro (para el

mejor rendimiento, usa un disco duro externo

homologado por Avid en lugar del disco de

sistema).
Introducción a Pro Tools
2 Inicia Pro Tools.

3 A continuación, ejecuta uno de estos

procedimientos, dependiendo de lo que veas en

pantalla:

• Si aparece el cuadro de diálogo Inicio Rápido,

haz clic en Abrir Sesión y después en Aceptar.

Busca el archivo de sesión de demostración

(.ptx), selecciónalo y haz clic en Abrir.

• Si el cuadro de diálogo Inicio Rápido no

aparece, elige Archivo › Abrir Sesión. Busca el

archivo de sesión de demostración (.ptx),

selecciónalo y haz clic en Abrir.

Para obtener más información sobre la sesión
de demostración, consulta el archivo Léeme
(Read Me) de la sesión de demostración.
Pistas

Barra de

herra-

mientas
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Para reproducir la sesión de demostración:

1 Baja el volumen de tu interfaz para evitar que el

audio suene demasiado alto.

2 Inicia la reproducción de la sesión de demostración

en Pro Tools. Para iniciar o detener la reproducción,

efectúa uno de los siguientes procedimientos:

• Pulsa la barra espaciadora del teclado del

ordenador.

• Haz clic en los botones Reproducir o Detener en

la ventana de Transporte (Ventana › Transporte)

o en la barra de herramientas de la ventana de

Edición.

3 Mientras se reproduce la sesión, sube el volumen

de tu interfaz de audio a un nivel de escucha

cómodo.

4 Explora Pro Tools mientras tanto (observa las

opciones disponibles en el menú Ventana):

• La ventana de Edición proporciona una

presentación de línea de tiempo de datos de

audio y MIDI y automatización de mezclas para

grabar, editar y organizar pistas. Utiliza esta

ventana para editar y arreglar audio, MIDI y

datos de automatización en la sesión.

Controles Reproducir o Detener en la ventana de
Transporte

ReproducirDetener
Introducción a Pro Tools
• La ventana de Mezcla muestra las pistas como

bandas de canal, al estilo de una consola de

mezcla; en ella verás medidores de nivel y

controles de insertos de plug-ins y de hardware,

envíos, asignaciones de entrada y salida, panorama,

volumen, solo, silenciar, y activación para

grabación. Utiliza esta ventana para encaminar y

mezclar audio y MIDI en la sesión.

• La ventana de Transporte ofrece controles para

funciones de transporte, como Reproducir,

Detener, Grabar, Avance Rápido y Rebobinado.

• Las ventanas de plug-ins ofrecen controles de

procesamiento de audio y plug-ins de

instrumentos virtuales.

• Las ventanas Editor MIDI permiten editar datos

MIDI mediante una interfaz de tipo “rollo de

pianola”, con edición de puntos de inflexión e

incluso con notación musical tradicional.

• La ventana Editor de Partituras permite editar los

datos MIDI de la sesión usando notación musical;

incluso puedes imprimir la partitura desde

Pro Tools.

• El espacio de trabajo proporciona una base de

datos interactiva para todos los contenidos

audiovisuales en la sesión o en el sistema.

5 Pulsa la barra espaciadora o haz clic en el botón

de detención para detener la reproducción.

6 Cuando hayas terminado de explorar la sesión

de demostración, elige Archivo › Cerrar Sesión.

La sesión de demostración es un buen ejemplo
de un proyecto acabado con arreglos, edición y
mezcla. No es preciso regresar a la sesión de
demostración para nada más de esta guía, pero
puede que desees volver a escucharla más
tarde, después de conocer otras funciones de
Pro Tools.
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Ver las ventanas de Edición y Mezcla
Las ventanas Edición y Mezcla son las dos áreas de trabajo principales de Pro Tools. A lo largo del resto de

esta guía, verás ejemplos de ambas ventanas y de su uso para diferentes tipos de procesos de producción.

Ver la Edición

Para mostrar la ventana de Edición:
 Elige Ventana › Edición.
Introducción a Pro Tools
Para mostrar todas las opciones de visualización de la ventana de Edición:

 Selecciona Ver › Vistas de Ventana de Edición › Todo.

Ventana de Edición
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Ver la ventana de Mezcla

Para mostrar la ventana de Mezcla:
 Elige Ventana › Mezcla.
Introducción a Pro Tools
Para mostrar todas las opciones de visualización de la ventana de Mezcla:

 Selecciona Ver › Vistas de Ventana Mezcla › Todo.
e

Ventana de Mezcla (se muestran las ventanas de Transporte y Plug-In)
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Creación de una sesión
Esta sección ilustra cómo crear una sesión nueva.

Puedes crear una sesión al iniciar Pro Tools por

primera vez o en cualquier momento posterior.

Para crear una sesión:

1 Si Pro Tools no está abierto, inícialo.

2 Lleva a cabo uno de estos procedimientos:

• Si al iniciar Pro Tools se abre el cuadro de diálogo

Inicio Rápido, selecciona Crear Sesión en

Blanco y haz clic en Aceptar.

• Elige Archivo › Nueva Sesión. Si tienes una

sesión abierta actualmente, se te pedirá que

guardes todos los cambios. En el cuadro de

diálogo Nueva Sesión, selecciona Crear Sesión

en Blanco y haz clic en Aceptar.

3 En el cuadro de diálogo Guardar, selecciona la

ubicación donde desees guardar la sesión, dale

un nombre y haz clic en Guardar.

Mediante este procedimiento se ha creado una sesión

nueva sin pistas. A continuación, puedes conectar un

micrófono o cable de instrumento y crear pistas

nuevas para grabar audio.
Introducción a Pro Tools
Grabación de audio
Esta sección explica cómo conectar un micrófono o

un instrumento (como una guitarra o un teclado) a

tu sistema Mbox para grabar audio.

Conexión de un micrófono o 
instrumento a Mbox

Para conectar un micrófono o un instrumento:

1 Lleva a cabo uno de estos procedimientos:

• Si vas a utilizar un micrófono, conéctalo a una

entrada Mic/Line del equipo Mbox mediante un

cable XLR.

• Si vas a utilizar un instrumento, conéctalo a una

entrada DI del equipo Mbox con un cable con

conector de ¼".

2 Lleva a cabo uno de estos procedimientos:

• Si tienes un sistema Mbox, asegúrate de que el

interruptor Front/Rear esté en la posición correcta

para una conexión frontal o posterior.

• Si tienes un sistema Mbox Mini, según la entrada

que uses, asegúrate de que el interruptor Line/DI

o Mic/Line esté en la posición correcta para el

tipo de conexión.
Conexión de un micrófono mediante cable XLR a la entrada 1 Mic/Line del panel posterior de un sistema Mbox

Selector de fuente de

entrada 1 (conmutador

Front/Rear) Entrada 1

Entrada Mic/Line
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Crear una pista

Pro Tools utiliza pistas para grabar el audio y MIDI

de cada sesión. Antes de poder grabar audio, tienes

que crear una pista apropiada.

Para crear una pista de audio y prepararla para la

grabación:

1 Crea una sesión nueva o abre una sesión existente.

2 Selecciona Pista › Nueva.

Para grabar con un solo micrófono o instrumento

conectado a tu interface de audio, configura el

cuadro de diálogo Pistas Nuevas a 1 Pista de Audio

Mono en Muestras y haz clic en Crear.

Si deseas grabar ambas entradas a la vez, crea una

pista estéreo o dos pistas mono, dependiendo de lo

que tengas conectado y lo que pienses grabar:

• Para grabar dos fuentes diferentes (como un

micrófono de voz y una guitarra eléctrica), crea

dos pistas de audio Mono. Esto permite grabar

dos señales de entrada a la vez. Tras la grabación,

puedes editarlas, procesarlas y equilibrarlas de

forma independiente.

• Para grabar una fuente estéreo de dos canales, como

un piano electrónico estéreo, crea una pista de

audio con la opción Estéreo.

3 Comprueba que la ventana de Mezcla esté

abierta. Para ello, elige Ventana › Mezcla.

Creación de una pista de audio mono
Introducción a Pro Tools
4 En medio de la banda de canal de la pista nueva,

fíjate donde dice “Analog 1 (Mono).” Esto muestra

qué canal de entrada (Entrada 1 o 2) está

asignado a esta pista. (Para definir otro canal de

entrada, haz clic en el selector de ruta de entrada

de audio y selecciona el otro canal).

Grabar en una pista

Para grabar una pista de audio:

1 Haz clic en el botón Activar para grabación para

habilitar la pista para grabar. El botón parpadeará

en rojo.

2 Canta o interpreta algo frente al micrófono, o

bien toca el instrumento.

Observa el nivel del medidor en la pista de Pro Tools

mientras aumentas la ganancia de entrada en el

interface de audio. (Observa que mover el

atenuador en pantalla no afecta a los niveles de

entrada; solo es para ajustar los niveles de

monitorización).

Activación de una pista para grabar en la ventana de
Mezcla

Selector de

ruta de

entrada de

audio

Activación para grabación

(botón)
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3 Aumenta la ganancia de entrada hasta que veas

que el medidor de pista está en verde la mayor

parte del tiempo, o en amarillo para las partes

más fuertes.

• Si el medidor de pista se pone en rojo, la ganancia

es demasiado alta y debes reducirla.

• Si apenas puedes ver el verde en el medidor de

pista, la ganancia es demasiado baja, por lo que

debes subirla.

Ganancia de entrada

Medidor de pista
Introducción a Pro Tools
4 En la ventana de Transporte, haz clic en el

botón Volver a cero si quieres iniciar la

reproducción desde el principio de la sesión.

5 Haz clic en el botón Grabar de la ventana de

Transporte para preparar la sesión para

grabación. El botón parpadeará en rojo. (De

este modo Pro Tools considera que estás listo

para grabar, como si fuera un botón maestro de

activación para la sesión).

6 Elige Ventana › Edición para que puedas ver lo

que sucede cuando grabas.

7 Cuando estés listo para empezar la grabación,

pulsa la barra espaciadora o haz clic en el botón

Reproducir de la ventana de Transporte. El

botón Grabar y el botón Activar para grabación

de la pista dejan de parpadear y permanecen

encendidos en rojo durante la grabación.

8 Para detener la grabación, pulsa la barra

espaciadora de nuevo o haz clic en el botón

Detener de la ventana de Transporte. (El botón

Grabar de la ventana de Transporte se apaga,

pero el botón Activar para grabación de la pista

sigue encendido y parpadeando en rojo hasta que

hagas clic sobre él).

Acabas de grabar tu primera pista de audio.

Una pista de audio mono después de la grabación

Volver a cero Reproducir Grabar
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Escuchar la grabación

Después de grabar el audio, puedes reproducir el

resultado para revisarlo, editarlo y mezclarlo.

Para reproducir una pista grabada:

1 Haz clic de nuevo en el botón Activar para

grabación de una pista para salir del modo de

grabación. El botón Activar para grabación deja

de parpadear en rojo.

2 Para iniciar la reproducción, pulsa la barra

espaciadora o haz clic en Reproducir en la

ventana de Transporte.

3 Para detener la reproducción, pulsa la barra

espaciadora o haz clic en Detener en la ventana

de Transporte.

Grabar más pistas

Repite estos pasos para crear otra pista de audio

(mono o estéreo) y continuar grabando. De esta

manera puedes grabar fragmentos adicionales de

las pistas que ya has grabado. Esta es una técnica de

producción habitual para ir creando “capas” de sonido

con distintas partes que forman el arreglo completo

de un tema musical.
Introducción a Pro Tools
Medición del tiempo en 
minutos y segundos o barras 
y compases
Pro Tools permite medir el tiempo en minutos y
segundos (tiempo absoluto) o compases y tiempos
(tiempo relativo). En producción de música, suele

ser ventajoso medir el tiempo en compases y

tiempos. Los tiempos son relativos en cuanto que

dependen del tempo; los compases dependen del

ritmo.

Es posible introducir cambios de tempo y de

compás mediante marcadores en la línea de tiempo

de la sesión de Pro Tools, en la parte superior de la

ventana de Edición. Estos ajustes colocan el tiempo

relativo de los compases y tiempos frente al tiempo

absoluto en minutos y segundos (o muestras). En

Pro Tools, esta distinción se llama tiempo basado

en tics (relativo) frente a tiempo basado en

muestras (absoluto). El tiempo del audio y los datos

MIDI se puede configurar en una u otra medida en

cada pista. (Para más información, consulta la Guía
de referencia de Pro Tools.)
Línea de tiempo de Pro Tools con contador principal (tiempo en minutos y segundos)

Contador principal

Línea de tiempo

Modo Grid

Reglas de

base de

tiempo
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Por defecto, el formato de la escala de tiempo principal

de la sesión es Min:Segs (minutos y segundos), pero

puedes cambiarlo a Compases|Tiempos si quieres

efectuar una grabación con una pista de metrónomo

con un compás y tempo determinados. Establecer el

formato de tiempo principal en compases y tiempos es

útil para crear, editar y arreglar audio y MIDI en

una cuadrícula de compases y tiempos.

Cambio del formato de tiempo 
principal

Para establecer el formato de tiempo principal,

elige una de las siguientes opciones:

 Haz clic en un selector de contador principal; se

encuentran en la parte superior de las ventanas

de Edición o de Transporte (si está configurada

para mostrar contadores). Después, selecciona

un formato de tiempo.

 Si hay una regla de base de tiempo visible, haz

clic en su nombre para resaltarla.

Selector de contador principal (en la ventana de
Edición)

La configuración del formato de tiempo
principal como la base de tiempo mostrada
actualmente en el subcontador conmuta los
dos formatos de tiempo, configurando el
subformato como la base de tiempo anterior
del formato de tiempo principal.
Introducción a Pro Tools
Grabación con una pista de 
metrónomo
Una pista de metrónomo ofrece un tempo basado

en clics para usar como referencia de metrónomo al

grabar. Para grabar y editar el material de la pista de

acuerdo con un compás y un tiempo específicos,

configura el formato de tiempo principal en

Compases|Tiempos (Bars|Beats).

Para crear una pista de metrónomo:

1 Elige Pista › Crear Pista de Clic.

Pro Tools crea una nueva pista de entrada auxiliar

con el plug-in Click II en el primer inserto de la

pista. Cuando comienzas la reproducción o la

grabación, el clic proporciona una cuenta previa y

después continúa según las asignaciones de

compás y de tempo en la línea de tiempo de

Pro Tools.

2 Selecciona Ver › Transporte › Controles MIDI

para ver los controles MIDI en la ventana de

Transporte.

3 En esta ventana, asegúrate de que los botones

Metrónomo y Descuento estén seleccionados.

4 Asegúrate de que el botón Pista de Director esté

activado si quieres que el clic adopte el tempo de

la sesión (el de la línea de tiempo). Desactiva el

botón Pista de Director si prefieres ajustar el

tempo manualmente.

Configuración de la escala de tiempo principal en
Compases|Tiempos (Bars|Beats)
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5 Pulsa la barra espaciadora o haz clic en el botón

Reproducir de la ventana de Transporte para

iniciar la reproducción y escuchar el clic de

metrónomo.

Para ajustar la configuración del plug-in Click II:

1 Elige Configuración › Clic/Descuento.

2 Selecciona una de las opciones siguientes:

• Durante reproducción y grabación: el

metrónomo suena durante la grabación y

reproducción.

• Sólo durante grabación: el metrónomo se

escuchará en la grabación, pero no en la

reproducción.

• Sólo durante descuento: el metrónomo solo se

escuchará al realizar una cuenta previa antes de

que comience la grabación o la reproducción.

Tempo

Botón Cuenta previa

Metrónomo (botón)

Pista de Director (botón)
Introducción a Pro Tools
3 Haz clic en Aceptar.

Para silenciar una pista, realiza una de estas

acciones:

 Silencia la pista de metrónomo haciendo clic sobre

el botón M (silenciar) en los controles de pista.

 En la ventana de Transporte, anula la selección

del botón Metrónomo, de forma que no se

muestre resaltado en azul. Después anula la

selección del botón Descuento para que no esté

resaltado. (Hacer ambas cosas silencia la pista

de metrónomo y desactiva la opción Descuento).

Selector de contador principal (en la ventana de
Edición)
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Configuración del compás de 
sesión
Asegúrate de configurar el ritmo de la sesión de modo

que coincida con el compás de tu música. Si el

compás de la sesión no coincide con el de la música

que se graba, la parte fuerte del metrónomo no se

alineará con lo que se esté tocando y, por tanto, el

material grabado no coincidirá con los compases y

tiempos de la ventana de Edición.

Para definir el compás de una sesión:

1 Haz doble clic en el botón de compás actual en la

ventana de Transporte.

2 En Compás, indica el compás que vas a usar

para la sesión y configura el valor de Ubicación

como 1|1|000 (para que el compás insertado

sustituya al predeterminado).

3 En el menú emergente Clic, selecciona un valor

de nota para el tiempo. (Por ejemplo, si estás en

6/8, selecciona una negra con puntillo).

4 Haz clic en Aceptar para insertar el nuevo

evento de compás.

Botón de compás actual

Ventana Cambio de Compás
Introducción a Pro Tools
Configuración del tempo de 
sesión
A las nuevas sesiones de Pro Tools se les asigna un

valor de tempo predeterminado de 120 ppm (pulsos

por minuto). Si vas a grabar con metrónomo usando

un tempo que no sea 120 ppm, asegúrate de definir

el tempo según corresponda.

Para cambiar el tempo de la sesión:

1 Lleva a cabo uno de estos procedimientos:

• En la ventana de Edición, haz doble clic en el

marcador de inicio de canción.

• Haz clic en el botón Añadir cambio de tempo (+)

a la cabecera de la regla de tempo.

2 En el cuadro de diálogo Cambio de Tempo,

introduce el valor en pulsos por minuto (BPM)

de la sesión.

Regla de tempo

Ventana Cambio de Tempo

Puedes introducir un tempo concreto o usar
la tecla T.

Marcador de inicio de canción

Botón Añadir cambio de tempo

Regla de

tempo
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3 Define la Ubicación en 1|1|000 (para asegurarte

de que el evento de tempo insertado reemplace al

tempo predeterminado de la sesión).

4 En el menú emergente Resolución, selecciona el

valor de nota para el tiempo. (Por ejemplo, si

estás en 6/8, selecciona una negra con puntillo).

5 Haz clic en Aceptar.

Uso del modo de tempo manual
En el modo Tempo Manual, Pro Tools puede pasar

por alto los eventos de tempo de la pista de tempo y,

en su lugar, reproducir con un tempo manual. Este

tempo se puede establecer marcándolo.

Para configurar el tempo manualmente:

1 Asegúrate de que se muestran los controles MIDI

en la ventana de Transporte (selecciona Ver ›

Transporte › Controles MIDI).

2 En la ventana de transporte, desactiva la regla de

tempo haciendo clic en el botón Pista de

Director (Conductor), de forma que no aparezca

resaltado. Pro Tools pasa a modo Tempo

Manual. En este modo se omiten los eventos de

tempo que aparecen en la regla respectiva.

Tempo Manual (modo)

Resolución de tempo

Pista de Director (botón)

Tempo
Introducción a Pro Tools
3 Haz clic en el selector de resolución de tempo

(Tempo Resolution) y elige un valor de nota.

(Por ejemplo, si estás utilizando 6/8, selecciona

una corchea con puntillo; si estás usando 3/4,

selecciona una negra).

4 Para especificar un tempo nuevo, realiza una de

estas acciones:

• Haz clic en el valor Tempo, escribe otro número

y pulsa Intro (Enter).

• Haz clic en el valor Tempo y arrástralo hacia arriba

o hacia abajo para cambiarlo. Para realizar un ajuste

más preciso, pulsa la tecla Comando (Mac) o

Control (Windows) mientras arrastras.

• Haz clic en el valor Tempo y pulsa repetidamente

la tecla “T” en el teclado del ordenador con el

tempo que desees para introducir el valor.
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Importación de audio
Muchos flujos de trabajo de producción musical

incluyen el uso de bucles de audio y audio de

bibliotecas de muestras. Por ejemplo, puedes usar

bucles de batería en vez de una pista de metrónomo

para grabar. Incluso puedes combinar y arreglar

bucles de audio y muestras únicas de distintas fuentes

para crear una pieza de música totalmente nueva.

Pro Tools ofrece varias maneras de importar archivos

de audio de distintas fuentes a la sesión. Puedes

importar audio del disco duro, de una unidad en

red, de un CD de audio o de otro soporte extraíble

mediante el comando Import Audio; también puedes

arrastrar y soltar audio desde un navegador de espacio

de trabajo, o desde el Finder de Mac o el Explorador

de Windows.

Uso del comando Importar Audio
El comando Importar Audio permite importar

archivos de audio o clips a la sesión de Pro Tools.

Para importar archivos de audio o clips a una sesión

con el comando Importar Audio:

1 Elige Archivo › Importar › Audio.

2 En el cuadro de diálogo Importar Audio,

localiza y selecciona un archivo de audio para

ver sus propiedades y clips asociados.
Introducción a Pro Tools
3 Para preescuchar un clip o un archivo seleccionado

antes de importarlo, utiliza el botón Reproducir

del cuadro de diálogo Importar Audio. Haz clic

en el botón Detener para parar la reproducción.

Para ajustar el volumen de la audición previa,

mueve el control deslizante vertical. Para situarte

en un punto determinado en el archivo, usa el

control deslizante horizontal bajo los botones

Reproducir y Detener.

4 Efectúa cualquiera de los procedimientos

siguientes:

• Para colocar un archivo o un clip en la lista de

importación, selecciona el archivo y haz clic en

Añadir o en Convertir.

• Para importar todos los archivos y clips del

directorio activo, haz clic en Añadir Todo o en

Convertir Todo.

• Para eliminar un archivo o un clip de la lista de

importación, selecciona el elemento y haz clic en

Quitar.

Cuadro de diálogo Importar Audio

El control de volumen del cuadro de diálogo
Importar Audio también afecta al volumen de
la preescucha cuando se reproducen clips de
la lista de clips.
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• Para eliminar todos los archivos o todos los clips,

haz clic en Quitar Todo.

5 Después de añadir todos los archivos de audio y

clips que desees a la lista de importación, puedes

realizar la conversión de la frecuencia de muestreo

del siguiente modo:

• Activa Aplicar SRC.

Especifica el valor de Frecuencia de Muestreo de

Fuente escribiendo un número o seleccionando una

frecuencia de muestreo en el menú desplegable.

• Selecciona la calidad de conversión de la

frecuencia de muestreo en el menú desplegable

Calidad. Este valor anula la opción Calidad de

Conversión de Frecuencia de Muestreo de la

página Procesamiento de Preferencias.

6 Haz clic en Listo.

7 Si estás copiando o convirtiendo archivos,

selecciona una ubicación para los nuevos archivos,

como la carpeta Audio Files de la sesión actual.

Al añadir archivos, la referencia es el archivo en

su ubicación original.

Pro Tools permite agregar a una sesión
archivos con una frecuencia de muestreo
distinta a la de la sesión. En el campo de
comentarios del cuadro de diálogo Importar
Audio, aparece un mensaje advirtiendo sobre
la reproducción a una velocidad y una altura
musical inadecuadas si los archivos no se
convierten previamente.
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8 En el cuadro de diálogo Opciones de

Importación de Audio, selecciona en qué

ubicación de la sesión se colocarán los archivos

importados:

Pista nueva: Cada archivo de audio se importa en

su propia pista independiente y a la lista de clips.

Lista: Los archivos de audio se importan a la lista

de clips sin crear una pista. Los archivos de audio

importados se muestran en la lista de clips y pueden

arrastrarse a pistas de audio.

9 Si decides crear una pista, elige una ubicación

para el archivo importado en la pista:

Inicio de Sesión: Sitúa el archivo o clip al

principio de la sesión.

Inicio de Canción: Alinea el principio del archivo

o del clip con el punto inicial de la canción.

Selección: Alinea el principio del archivo o del

clip con el cursor de edición o el inicio de una

selección de la línea de tiempo.

Spot: Abre el cuadro de diálogo Spot, que permite

emplazar el archivo o el clip en una ubicación

específica, según cualquiera de las escalas de tiempo.

10 Haz clic en Aceptar.

Cuadro de diálogo Opciones de Importación de Audio
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Importar archivos arrastrándolos
Pro Tools permite importar archivos de sesión, audio, MIDI y vídeo arrastrando archivos desde un navegador de

espacio de trabajo, el Explorador de Windows o el Finder de Mac hasta el icono de la aplicación Pro Tools, la

línea de tiempo de la sesión, una pista, la lista de pistas o la lista de clips.
Introducción a Pro Tools
Importar desde el espacio de trabajo arrastrando

Espacio de Trabajo

Arrastra archivos de contenidos o de

sesión a pistas existentes, o a la lista

de pistas para añadirlos como pistas

nuevas.

Arrastra archivos a la

lista de clips para

importarlos
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La ilustración precedente muestra algunas de las

opciones disponibles para importar archivos

arrastrándolos desde un navegador de espacio de

trabajo.

Para importar archivos a la lista de clips:

1 Selecciona archivos de audio, vídeo, MIDI, grupo

de clips, REX oACID en un navegador de espacio

de trabajo, el Explorador de Windows o el Finder

de Mac.

2 Arrastra los archivos seleccionados a la lista de

clips.

Para importar archivos a una pista:

1 Selecciona los archivos que quieras importar en

un navegador de espacio de trabajo, el Explorador

de Windows o el Finder de Mac.

2 Arrastra el archivo seleccionado hasta una pista

compatible.

Para importar archivos como pistas nuevas:

1 Selecciona los archivos que quieras importar en

un navegador de espacio de trabajo, el Explorador

de Windows o el Finder de Mac.

2 Efectúa cualquiera de los procedimientos

siguientes:

• Pulsa Mayús y arrastra los archivos a la ventana

de Edición.

• Arrastra los archivos a la lista de pistas.

• Arrastra archivos hasta un espacio vacío en la

ventana de Edición, debajo de las pistas o entre

pistas.
Introducción a Pro Tools
Edición de audio
Pro Tools permite editar audio en pistas mediante

diversos métodos: ajustar, separar, cortar, copiar y

pegar, mover, reorganizar, entre otros.

Ajuste de clips de audio
En este ejemplo te mostraremos cómo realizar una

edición sencilla para cambiar el punto de inicio de

una canción. En este ejemplo, se escucha al batería

marcando el tempo (“1...2...1.2.3...”) antes de

empezar el tema (supongamos que en esta pista

estéreo se grabaron los micrófonos suspendidos

sobre la batería). Este es el aspecto del audio en

Pro Tools.

En la imagen, las formas de onda estéreo te permiten

visualizar las distintas secciones del tema musical.

Podemos aprovechar la característica “lo que se ve

es lo que se oye” de Pro Tools para silenciar

rápidamente la cuenta previa ajustando el inicio de

la canción.

Inicio de la

pieza

Cuenta

previa

formas de onda

(canales derecho e

izquierdo)
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Para ajustar un clip de audio:

1 Haz clic para seleccionar la herramienta de ajuste

(Trim, situada en la barra de herramientas de

Edición).

2 Haz clic en la pista después de la cuenta previa y

antes del inicio de la canción (verás que el cursor

muestra el icono de ajuste). Arrastra a la derecha

para ajustar el principio del clip, o a la izquierda

para recortar el principio del clip.

Puedes reducir el ajuste del clip haciendo clic sobre

él y arrastrando nuevamente a la izquierda con la

herramienta de ajuste. Verás que el audio anterior

(la cuenta previa) sigue en su sitio. Este es un pequeño

ejemplo de cómo Pro Tools permite editar de modo
no destructivo.

Copiado y pegado de clips
El ejemplo siguiente muestra cómo copiar y pegar

un clip de audio de una pista a diversas ubicaciones

en la pista y la línea de tiempo en una sesión. Este

ejemplo usa un bucle de audio rítmico importado.

Para copiar y pegar un clip:

1 Importa un bucle de audio rítmico en una Sesión

de Pro Tools (consulta “Importación de audio”

en la página 129).

2 Haz clic en la herramienta de mano o la

herramienta de selección (ubicada en la barra de

herramientas de edición).

Herramienta de ajuste

Inicio de la pieza
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3 Si estás usando la herramienta de mano, haz clic

en el clip que deseas copiar y pegar. Si usas la

herramienta de selección, haz doble clic en el

clip que deseas copiar y pegar.

4 Elige Editar › Copiar.

5 Con la herramienta de selección, ubica el cursor

de edición en la ubicación donde deseas pegar el

clip copiado.

Herramientas de edición

Usa la Herramienta Inteligente para que el
cursor de edición conmute entre las distintas
herramientas de edición según donde lo
ubiques sobre un clip.

Selección de una pista con la herramienta de mano

Herramienta

Inteligente
(Smart Tool)

Herramienta de selección

Herramienta de mano
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6 Elige Editar › Pegar.

Separación y reorganización de 
clips
Hay varias maneras de crear nuevos clips de audio

en Pro Tools: Puedes importar o grabar clips de audio

de archivo entero. También puedes crear clips de

audio que solo se refieren a partes de archivos de

audio mediante ajuste (consulta “Ajuste de clips de

audio” en la página 132) o separando clips de

archivo entero.

El ejemplo siguiente muestra varias maneras en que

puedes separar y reorganizar los clips de audio en

una sesión. Este ejemplo usa un bucle de audio

rítmico importado.

Pegado de un clip en una ubicación temporal diferente
en una pista diferente

Pulsa Comando+C (Mac) o Control+C
(Windows) para copiar la actual selección de
edición al portapapeles. Pulsa Comando+V
(Mac) o Control+V (Windows) para pegar el
contenido del portapapeles a la ubicación de
edición actual.
Introducción a Pro Tools
Separación de clips en la selección de 
edición

Para separar un clip en la ubicación de edición actual:

1 Define una selección de edición con la herramienta

de selección en un clip de audio.

2 Elige Editar › Separar Clip › En Selección.

Selección de edición

Pulsa Comando+E (Mac) o Control+E
(Windows) para separar clips en la actual
selección de edición.

Clips nuevos creados al separar el clip superior en el
límite de la selección de edición
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Reorganización de clips separados

Hay muchas maneras de reorganizar clips en

Pro Tools. El modo de edición seleccionado

(definido en la sección izquierda de la barra de

herramientas de la ventana de Edición) determina

cómo Pro Tools maneja los clips de audio cuando el

usuario los mueve. Lo siguiente indica solo algunas

de las muchas posibilidades para organizar clips de

audio en tu sesión de Pro Tools.

Usa Editar › Separar Clip › En Grid para
separar la selección de audio según la
cuadrícula actual. Esto resulta especialmente
útil si se trabaja con audio en una cuadrícula de
compases y tiempos (Bars|Beats) Usa Editar ›
Separar Clip › En Transitorios para separar la
selección de audio siguiendo los ataques
individuales en el audio. Esto resulta útil para
separar el audio en fragmentos individuales
como cada golpe en un bucle de batería o cada
nota en un riff de guitarra.

Modos de edición, modo Grid seleccionado
Introducción a Pro Tools
Para reorganizar clips, sigue cualquiera de los

siguientes procedimientos:

 Con la herramienta de mano en modo Slip, arrastra

un clip de audio a una nueva ubicación. El clip

se traslada a esa ubicación exacta.

 Con la herramienta de mano en modo Grid,

arrastra un clip de audio a una nueva ubicación.

El clip se adhiere a la ubicación más próxima en

la cuadrícula donde lo hayas movido.

 Con la herramienta de mano en modo Spot,

arrastra un clip de audio a una nueva ubicación.

Se abre el cuadro de diálogo Spot y puedes

especificar una ubicación temporal exacta para

el clip.

 Con la herramienta de mano en modo Shuffle,

arrastra un clip de audio a una nueva ubicación

entre otros clips. Los clips adyacentes se desplazan

para hacer espacio.

 Selecciona un clip con la herramienta de mano

o de selección y elige Editar › Duplicar. El clip

seleccionado se duplica y se coloca inmediatamente

a continuación de la selección actual.

 Selecciona un clip con la herramienta de mano o

de selección y elige Editar › Repetir. En el cuadro

de diálogo Repetir, escribe el número de veces

que deseas repetir el material y haz clic en

Aceptar. Se repite la selección como clips

separados, que se colocan uno después del otro.

Bucle de audio rítmico separado por transitorios e
intercalado
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Secuenciación MIDI con un 
plug-in de instrumento virtual
El ejemplo a continuación muestra cómo programar

una secuencia MIDI en una pista de instrumento

para utilizar un plug-in de instrumento virtual. Este

ejemplo usa el plug-in Xpand!2 de AIR Music

Technology.

Para más información sobre edición y
organización del audio, consulta las secciones
sobre modos de edición y herramientas de
edición, grupos de clips y Elastic Audio en la
Guía de referencia de Pro Tools.

El plug-in Xpand!2 forma parte de la AIR
Creative Collection, que se incluye en
Pro Tools como un instalador descargado
para instalar separadamente. Asegúrate de
ejecutar este instalador, con el contenido
vinculado, antes de seguir con este ejemplo.
Para más datos, consulta el manual AIR
Creative Collection Plug-Ins Guide.
Introducción a Pro Tools
¿Qué es MIDI?
Los datos MIDI (Musical Instrument Digital

Interface) no son audio, ya que el protocolo MIDI

no produce sonido. MIDI es una manera para que

los equipos que lo utilizan —como sintetizadores,

samplers, controladores, teclados y secuenciadores—

se envíen datos de control, para comunicarse entre

sí. Lo que hace MIDI es indicar a los dispositivos

que generan sonido (como equipos sintetizadores o

samplers, o instrumentos virtuales en software) qué

deben reproducir.

Los dispositivos MIDI compatibles con USB y

FireWire envían y reciben mensajes MIDI del

ordenador mediante conexiones USB o FireWire.

Los equipos MIDI se conectan mediante los cables

apropiados a las entradas y salidas correspondientes

del interface MIDI. Los instrumentos MIDI virtuales

se insertan como plug-ins en pistas de instrumento

en Pro Tools y se accede directamente a ellos desde

Pro Tools.
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Crear una pista de instrumento con un plug-in de instrumento
Puedes usar una pista de instrumento o una pista MIDI para grabar, programar y reproducir secuencias

MIDI en Pro Tools. Si estás trabajando con plug-ins de instrumentos virtuales (como Xpand!2 de AIR),

generalmente querrás usar una pista de instrumento. Las pistas de instrumento te permiten trabajar con

secuencias MIDI y también monitorizar audio.

También puedes usar pistas de instrumento con dispositivos MIDI externos.

Para crear una pista de instrumento e insertar un plug-in de instrumento:

1 Selecciona Pista › Nueva. En el cuadro de diálogo Pistas Nuevas, haz lo siguiente:

• Selecciona Estéreo.

• Haz clic en el menú emergente que muestra Pista de Audio y selecciona Pista de Instrumento.

• Haz clic en Crear.

2 Si es preciso, selecciona Ventana › Mezcla para mostrar la ventana de mezcla.

3 Haz clic en el selector de inserto de pista, que se encuentra cerca de la parte superior de la pista de

instrumento, y elige Xpand!2 en el submenú Instrumento.

Cuadro de diálogo Pistas Nuevas, con estéreo y pista de instrumento seleccionada
Introducción a Pro Tools
Inserción del plug-in Xpand!2 en una pista de instrumento

Selector

de inserto
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4 Aparece una ventana de plug-in con el plug-in Xpand!2. Ahora puedes seleccionar un preset de sonido

para reproducir usando MIDI.

Para seleccionar un sonido predefinido (preset) en el plug-in Xpand!2:

 En la parte superior de la ventana del plug-in, haz clic en el menú Librería (<ajuste de fábrica> se encuentra

seleccionada de forma predeterminada) y selecciona un preset de cualquiera de los submenús. Con

Xpand!2, los presets se agrupan en submenús por categoría.

Para mayor información sobre el plug-in Xpand!2, consulta el manual AIR Creative Collection Plug-Ins
Guide.
Introducción a Pro Tools
Selección de un preset de fábrica de Xpand!2 en el menú Librería
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Reproducción de un instrumento 
virtual
Puedes reproducir un instrumento virtual (como

Xpand!2) con una secuencia MIDI o de un

controlador MIDI externo.

Para reproducir un instrumento virtual con una

pista de instrumento, efectúa uno de estos

procedimientos:

 Si tienes un controlador MIDI conectado, puedes

reproducir el instrumento virtual con tal de que

la pista de instrumento en la que está insertado

esté seleccionada o activada para grabación.

Puedes grabar tu interpretación como una

secuencia MIDI mientras la tocas.

 Importa una secuencia MIDI (o programa una

secuencia MIDI) a la pista de instrumento en la que

está insertado el instrumento virtual, y comienza

a reproducir.
Introducción a Pro Tools
Grabación MIDI con un 
controlador externo
Pro Tools te permite grabar datos MIDI de un

controlador MIDI.

Para grabar MIDI en una pista de instrumento:

1 Asegúrate de que el controlador o teclado MIDI

esté conectado a un interface MIDI con los cables

correspondientes o directamente al ordenador con

un cable USB.

2 Crea una nueva pista de instrumento estéreo e

insértale Xpand!2 (consulta “Crear una pista de

instrumento con un plug-in de instrumento” en

la página 137).

3 Selecciona un preset de bajo (también conocido

como “patch”).

4 Selecciona Options › MIDI Thru. (Comprueba que

la opción MIDI Thru esté seleccionada; si no lo

está, selecciónala).

5 Haz clic en el botón Activar para grabación para

activar la pista de instrumento para la grabación

MIDI.

6 En la ventana de transporte, haz clic en el botón

Grabar.

7 Toca usando el teclado del controlador MIDI.

Deberías escuchar el sonido que has seleccionado.

8 Cuando tengas todo listo para grabar, haz clic en

el botón Reproducir o pulsa la barra espaciadora.

Para parar, haz clic en Detener o pulsa la barra

espaciadora.

9 Haz clic de nuevo en el botón de grabación de la

pista para salir de la grabación y reproducir lo que

acabas de grabar.

Datos MIDI grabados en una pista de instrumento
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Dibujo de una secuencia MIDI
Puedes programar una secuencia MIDI en Pro Tools

usando la herramienta de lápiz.

Para insertar una nota MIDI en una pista en la

ventana de Edición:

1 En la ventana de Edición, configura la pista

MIDI o de instrumento a la vista de notas.

2 Selecciona la herramienta de lápiz y configúrala

en el modo Mano Alzada (Free Hand). El cursor

adoptará la forma de la herramienta de lápiz

cuando se coloque sobre el área de lista de

reproducción de una pista MIDI o de instrumento

en la modalidad de vista de notas.

Al insertar notas MIDI u otros datos MIDI
con la herramienta de lápiz, los límites de
clip MIDI se crean en las barras de compás
más cercanas.

Selección de la vista de notas en una pista de
instrumento
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3 Para insertar negras en el pulso, realiza lo

siguiente:

• Configura la escala de tiempo principal en

Compases|Tiempos.

• Activa el modo de edición en Grid.

• Establece el valor de Grid en negras.

• Establece el valor de la opción Duración

predeterminada de nota en negras o en Seguir a

Grid.

4 Mueve la herramienta de lápiz al área de la lista

de reproducción para la pista MIDI o de

instrumento. Para localizar la altura y la ubicación

de nota deseados, usa como referencia la regla

de la ventana de Edición y el miniteclado de la

pista.

Cuando se usa la herramienta de lápiz, la ubicación

del cursor y el valor se visualizan en la barra de

herramientas de la ventana.

Ubicación del cursor y valor

Ubicación del cursor de altura musical

Ubicación del cursor en la línea de
tiempo

Cursor de lápiz
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5 Cuando hayas encontrado el tiempo y la altura

adecuados, haz clic para insertar la nota.

La velocidad de las notas insertadas la determina la

configuración de la opción Velocidad

predeterminada de nota activada. La duración

viene determinada por el valor de la opción

Duración predeterminada de nota. En modo Grid,

la ubicación de la nota activada viene determinada

por el valor de Grid.

Si está activada la preferencia Reproducir notas

MIDI al editar, cada nota sonará al insertarla.

Es posible arrastrar la herramienta de lápiz después

de hacer clic (y antes de soltar) para ajustar la altura

o la duración de la nota. Arrastra hacia la derecha

para alargar la nota sin cambiar su punto de inicio.

Arrastra hacia la izquierda para acortarla sin

cambiar su punto final.

Nota MIDI insertada mediante la herramienta de lápiz

Con el modo Grid activado, el punto de
inicio de la nota MIDI se alinea, de forma
predeterminada, con el límite de cuadrícula
más próximo. Con la herramienta de lápiz en
modo Mano Alzada, mantén pulsado
Comando (Mac) o Control (Windows)
mientras haces clic para desactivar
temporalmente la alineación con la
cuadrícula.
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Editar notas MIDI
Es posible editar todos los aspectos de las notas

MIDI desde la ventana de Edición una de las

ventanas de Editor MIDI, incluidos los puntos de

inicio y fin, la duración, la altura y la velocidad de

ataque. Las herramientas de selección, de ajuste, de

mano y de lápiz se pueden aplicar a notas concretas

o a grupos de notas.

Selección de notas MIDI

Para poder editar las notas MIDI, primero se deben

seleccionar.

Para seleccionar notas MIDI:

1 Configura la pista MIDI o de instrumento en

vista de notas.

2 Lleva a cabo uno de estos procedimientos:

 Con la herramienta de lápiz o cualquier

herramienta de mano, pulsa la tecla Mayús

mientras haces clic en cada nota.

 Con cualquier herramienta de mano, mueve el

cursor donde no haya notas (aparecerá el

recuadro), haz clic y dibuja un rectángulo

alrededor del grupo de notas que deseas editar.

Con el modo Grid activado, el punto final de
la nota MIDI se alinea, de forma
predeterminada, con el límite de cuadrícula
más próximo. Para desactivar
temporalmente la alineación con la
cuadrícula, pulsa la tecla Comando (Mac) o
Control (Windows) mientras arrastras con la
herramienta de lápiz.
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Con una herramienta de mano, si cualquier parte del

rectángulo toca una nota (en el punto de inicio o fin),

esta se incluirá en la selección.

 Con la herramienta de selección, arrastra para

seleccionar un grupo de notas.

Cuando se utiliza la herramienta de selección, para

que se pueda seleccionar una nota se debe incluir su

punto de inicio.

Transporte de notas

Las notas MIDI se pueden transportar arrastrándolas

hacia arriba o hacia abajo con la herramienta de

lápiz o cualquier herramienta de mano. Si se

seleccionan varias notas antes de arrastrarlas, se

transportará cada una de ellas.

Para transportar una nota MIDI:

1 Configura la pista MIDI o de instrumento en

vista de notas.

2 Selecciona la herramienta de lápiz o cualquier

herramienta de mano.

Selección de notas con una herramienta de mano

Selección de notas con la herramienta de selección
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3 Mantén pulsada la tecla Mayús mientras

arrastras la nota hacia arriba o hacia abajo.

La tecla Mayús garantiza que la nota transportada

mantenga el punto original de inicio en la línea de

tiempo.

Al realizar el arrastre, sonará cada nota nueva y el

indicador del valor de ubicación del cursor indicará

(en la ventana de Edición) el número de semitonos

y la dirección (+/–) del transporte.

Transporte mediante una herramienta de mano.

Mientras pulsas Control (Mac) o Inicio
(Windows) y pulsa la tecla Más (+) del
teclado numérico para subir las notas MIDI
seleccionadas un semitono, o pulsa la tecla
Menos (–) del teclado numérico para bajar
las notas MIDI seleccionadas un semitono.

Para transportar una copia de la nota, sin
cambiar la original, pulsa la tecla Opción
(Mac) o Alt (Windows) mientras arrastras.
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Desplazar notas

Al igual que los clips, las notas MIDI pueden

arrastrarse hacia la derecha o izquierda con la

herramienta de lápiz o cualquier herramienta de

mano para cambiar su punto de inicio en la línea de

tiempo. Si se seleccionan varias notas antes de

arrastrarlas, se desplazarán todas a la vez.

Para desplazar una nota MIDI:

1 Configura la pista MIDI o de instrumento en

vista de notas.

2 Con la herramienta de lápiz o cualquier

herramienta de mano, arrastra la nota hacia la

derecha o hacia la izquierda (pulsa la tecla

Mayús durante el arrastre para conservar la

altura de la nota).

El indicador del valor de ubicación del cursor (en la

ventana de Edición) muestra dinámicamente el

nuevo punto de inicio a medida que se arrastra la

nota.

Si el modo de Edición está configurado en Grid, la

nota arrastrada se alinea con el límite de cuadrícula

más próximo. Si el modo de Edición está

configurado en Spot, se abre el cuadro de diálogo

Spot.

Para copiar las notas seleccionadas, sin
cambiar las originales, pulsa la tecla
Opción (Mac) o Alt (Windows) mientras
arrastras.
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Ajuste de los tiempos de inicio y de fin 
de nota

Al igual que los clips, los puntos de inicio y de fin de

las notas MIDI se pueden ajustar con la herramienta

de ajuste. Si se seleccionan varias notas cuando se

está realizando el ajuste, se cambiarán todas ellas.

Para cambiar los puntos de inicio o fin de un grupo

de notas MIDI:

1 Configura la pista MIDI o de instrumento en

vista de notas.

2 Selecciona las notas que desees ajustar.

3 Lleva a cabo uno de estos procedimientos:

• Selecciona la herramienta de ajuste.

• Utiliza la herramienta de lápiz.

4 Coloca el cursor cerca del comienzo de cualquier

nota resaltada para que aparezca la herramienta

de ajuste. Arrastra las notas a la derecha para

acortarlas o a la izquierda para alargarlas.

Si el modo de Edición está configurado en Grid, el

punto de inicio o fin arrastrado se alinea con el

límite de cuadrícula más próximo. Si el modo de

Edición está configurado en Spot, se abre el cuadro

de diálogo Spot; en él, puedes indicar la nueva

ubicación del punto de inicio o de fin de la nota.

Cambiar los tiempos de fin de nota con la herramienta
de ajuste

En modo Grid, utiliza la tecla Comando (Mac)
o Control (Windows) para desactivar el modo
Grid de forma temporal.
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Edición manual de velocidades de notas

Cuando una pista MIDI o de instrumento está

configurada en la vista de velocidad, o cuando la

ruta de velocidad se muestra bajo una pista, la

velocidad de ataque de cada una de las notas se

representa con un tallo de velocidad. Cuanto más

alto sea este indicador, mayor será el valor de

velocidad (0-127).

Para editar la velocidad MIDI en la ventana de

Edición:

1 Lleva a cabo uno de estos procedimientos:

• Configura la pista MIDI o de instrumento en la

vista de velocidad.

• Muestra la ruta de controlador de la pista MIDI o

de instrumento y la velocidad

2 Selecciona cualquier herramienta de mano.

3 Arrastra la parte superior (en forma de rombo)

del indicador de velocidad arriba o abajo.

Mostrar ruta de velocidad

Arrastre de un indicador de velocidad

Las velocidades de una selección de notas
se pueden editar con cualquiera de las
herramientas de lápiz.
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Eliminación de notas MIDI

Además de eliminar las notas seleccionadas con el

comando Borrar del menú Editar, las notas también

se pueden eliminar una a una con la herramienta de

lápiz.

Para eliminar un grupo de notas MIDI con el

comando Borrar:

1 Selecciona las notas que quieras eliminar.

2 Lleva a cabo uno de estos procedimientos:

• Elige Editar › Borrar para eliminar las notas

seleccionadas. Los datos de controlador

subyacentes en la pista permanecen intactos.

• Con cualquier herramienta de edición, haz clic

derecho en cualquier nota seleccionada y elige

Borrar.

• Pulsa la tecla Supr (Mac) o Retroceso (Windows).

Para eliminar una nota MIDI con la herramienta de

lápiz:

 Con la herramienta de lápiz seleccionada, pulsa

la tecla Opción (Mac) o Alt (Windows) y haz clic

en la nota. La herramienta de lápiz se convierte en

una goma de borrar al pulsar la tecla Opción (Mac)

o Alt (Windows).

Al eliminar notas MIDI dentro de una selección
de lapso de tiempo, también se eliminan todos
los datos subyacentes de controlador y
automatización.

Eliminación de una nota con la herramienta de lápiz
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Mezclas y procesamiento con 
plug-ins
Realizar mezclas en Pro Tools implica trabajar con

elementos del flujo de la señal de audio, como

entradas, salidas, buses, inserciones y envíos, para

submezclas y mezclas finales.

En el transcurso de una sesión, además de la mezcla

final, pueden tener lugar tareas de mezcla.

Durante la mezcla, los plug-ins en tiempo real y los

insertos de hardware ofrecen efectos y procesamiento

de señal. Pro Tools viene con un paquete de plug-

ins de efectos de audio que puedes usar para cambiar

los sonidos que has grabado. En esta sección se

muestran ejemplos de uso de los plug-ins para

procesar el sonido.

Los eventos de cambio de programas y los
eventosexclusivosdel sistematambiénsepueden
eliminar si mantienes pulsada la tecla Opción
(Mac) o Alt (Windows) al mismo tiempo que
haces clic en ellos con la herramienta de lápiz.

Para obtener información completa y
detallada sobre los plug-ins incluidos con
Pro Tools, consulta la Guía de plug-ins de
Audio (Ayuda › Guía de plug-ins de Audio).
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Ecualización y compresión
Seguramente, al mezclar audio, querrás aplicar

ecualización y compresión en pistas individuales

para que el audio suene a tu gusto.

Ecualización (EQ): Te permite modificar el

espectro de frecuencias del sonido. Un ejemplo de

ecualización sencilla son los controles de graves y

agudos de muchos equipos estéreo. Puedes usar

estos controles para reforzar o atenuar las frecuencias

bajas y altas del audio. Puedes usar la EQ para ayudar

a separar el bajo y la guitarra, para hacer más nítido

el sonido de la batería, destacar la voz, e incluso

eliminar ruidos indeseados. Pro Tools proporciona

varios tipos diferentes de plug-ins de EQ para modelar

el sonido.

Compresión: Te permite suavizar la dinámica del

audio. Actúa como un control automático de volumen

que evita que las partes intensas resulten demasiado

fuertes. Puedes usar compresión para dar más

intimidad a una voz, o para evitar que los platillos

suenen demasiado estridentes. Usa un limitador
para evitar que los picos en la señal de audio excedan

cierto umbral sin afectar el audio que no exceda ese

nivel. Pro Tools proporciona varios tipos diferentes

de plug-ins para modelar la dinámica del sonido.
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Para aplicar ecualización a una pista:

1 Elige Ventana › Mezcla.

2 En la parte superior de la pista, haz clic en el

primer selector de inserto de pista y elige EQ 3

7-Band en el submenú EQ.

Selector de inserto en una pista de audio en la
ventana de Mezcla
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3 Se abre la ventana del plug-in EQ III. Puedes usar

los ajustes preconfigurados (presets) del plug-in

como un punto de partida para investigar cómo

las diversas configuraciones afectan al sonido.

4 Comienza a reproducir para escuchar el efecto.

Ventana del plug-in EQ III, selector de presets
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Para aplicar compresión a una pista:

1 Elige Ventana › Mezcla.

2 En la parte superior de la pista, haz clic en el

siguiente selector de inserción de pista y elige

Dyn 3 Compressor/Limiter en el submenú

Dynamics. Pro Tools inserta el plug-in

Dynamics III Compressor/Limiter en la pista y

abre su ventana de plug-in.

3 Se abre la ventana del plug-in Dyn III. Puedes

usar los ajustes preconfigurados (presets) del plug-

in como un punto de partida para investigar cómo

las diversas configuraciones afectan al sonido.

4 Comienza a reproducir para escuchar el efecto.

Ventana del plug Dyn III, selector de presets
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Uso de la reverberación
La reverberación (reverb) agrega una sensación de

acústica ambiental. Los efectos de reverberación

son básicamente un conjunto de “retardos” que se

usan para simular la reflexión de sonido sobre las

superficies de distintas salas, auditorios y otros

espacios. Puedes usar efectos de reverberación para

darle un sentido de espacio a toda la mezcla usando

envíos de las pistas fuente y procesándolas con una

pista de entrada auxiliar. Los efectos de reverberación

pueden hacer que tu mezcla suene como si se hubiera

grabado en un gran auditorio, en un salón pequeño,

o incluso en un pasillo.

Una de las mejores formas de incorporar

reverberación en una mezcla es mediante una

configuración “de envío y retorno”. En Pro Tools,

el envío desde las pistas facilita hacer pasar el audio

de muchos pistas a través del mismo efecto de

reverberación. De esta manera, tus pistas fuente

sonarán como si todas provinieran de la misma

sala.
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Para usar reverb con una pista de entrada auxiliar y muchas pistas fuente:

1 Elige Ventana › Mezcla.

2 Selecciona Pista › Nueva y configúrala para crear una pista de entrada auxiliar estéreo. Después, haz clic

en Crear.

3 En la pista de entrada auxiliar que has añadido, haz clic en el selector de entrada de pista y selecciona

Bus › Bus 1–2.

Creación de una pista de entrada auxiliar.
Introducción a Pro Tools
Seleccionar Bus 1–2 del selector de entrada o una pista de entrada auxiliar

Selector de entrada

de pista
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4 Haz clic en el selector de envío A en la pista de origen como se muestra a continuación y elige Bus › Bus 1-2.
Introducción a Pro Tools
5 Repite el paso anterior por cada pista adicional que desees enviar a la pista de entrada auxiliar para

procesar con reverb.

Selección de Bus 1–2 para Envío A en una pista de audio

Selector de

envío A
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6 Inserta un plug-in Reverb en la pista de entrada auxiliar.
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7 Puedes usar las ventanas individuales Salida de Envío para ajustar el nivel de envío de pistas fuente; o

puedes configura la opción vista de envíos para mostrar los controles de envío para un envío concreto (por

ejemplo, selecciona Ver › Envíos Expandidos › Envíos A).

8 Pulsa la barra espaciadora y levanta lentamente el pequeño atenuador en la ventana Salida de Envío o

en los controles de pista Envios. Esto ajusta qué cantidad de la pista fuente envías a la pista de entrada

auxiliar para procesamiento con reverb.

9 Sigue escuchando y reproduciendo, ajustando los niveles individuales de envío, y comprobando distintos

ajustes de plug-ins para encontrar el efecto apropiado para tu mezcla.

Enviar pistas de audio a una pista de entrada auxiliar para procesamiento de reverb con D-Verb
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Uso de la automatización
Pro Tools presenta la automatización dinámica de los

controles de mezcla en cada uno de los tipos de pista.

Puedes escribir los movimientos de automatización y

verlos en tiempo real durante la reproducción de la

sesión. También puedes editar datos de automatización

con las mismas técnicas que usas para editar audio

y datos MIDI.

Escritura de automatización

Puedes escribir automatización de todos los controles

automatizables si los mueves durante la reproducción.

Para escribir automatización en las pistas:

1 Elige Ventana › Automatización.

2 Comprueba que el tipo de automatización esté

activado para escritura.

Ventana de Automatización, automatización de
volumen activada

La ventana de

Automatización

Selector de

modo de

automatiza-

ción de pista

Mover el control

deslizante de

volumen

durante la

reproducción
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3 En la ventana de Mezcla o de Edición, haz clic

en el selector del modo de automatización en

todas las pistas que desees automatizar y define

el modo de automatización. Para un pase inicial

de automatización, selecciona Escribir.

4 Inicia la reproducción para comenzar a escribir

automatización.

5 Desplaza los controles que desees automatizar

(como un atenuador de volumen de pista).

6 Cuando hayas terminado, detén la reproducción.

7 Conmuta nuevamente el modo de automatización

a Leer para reproducir la automatización que

acabas de grabar.

Editar automatización manualmente

Pro Tools ofrece varios métodos para modificar los

datos de automatización de todas las pistas de una

sesión. Puedes editar los datos de automatización

de forma gráfica si ajustas los puntos críticos en una

lista de reproducción de automatización. También

puedes cortar, copiar y pegar datos de automatización

de la misma manera que lo harías con datos de audio

y MIDI.

Los datos de automatización se muestran en forma

de gráfica, con puntos críticos editables.

Después del primer pase de automatización,
puedes escribir automatización adicional en
la pista sin borrar el pase anterior mediante
los modos Tocar o Fijar. Estos modos solo
añaden nuevos datos de automatización cuando
desplaza un control.

Punto crítico de automatización
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Al arrastrar estos puntos críticos, podrás modificar

los datos de automatización directamente en las

ventanas Editar y Editor MIDI. Al arrastrar un

punto crítico de automatización hacia arriba o hacia

abajo, se indica el cambio del valor.

Arrastrar un punto crítico de automatización hacia

la izquierda o la derecha ajusta la temporización del

evento de automatización.

Para visualizar el tipo de punto crítico de

automatización de una pista, selecciona la vista de

pista correspondiente o muestra la correspondiente

ruta de automatización o de controlador de la pista.

Por ejemplo, puedes ver y editar volumen, panorama,

silenciamiento, datos del controlador MIDI y hasta

la automatización de plug-ins.

Valor del punto crítico de automatización

Vista de pistas y rutas de automatización

Selector de

vista de pista

Selector de

tipo de

automatización

Rutas de

automatización

Vistadepistade

automatización

de volumen
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Uso de las herramientas de mano

Las herramientas de mano permiten crear puntos

críticos al hacer clic en la gráfica o ajustar los puntos

críticos existentes arrastrándolos. Pulsa la tecla

Opción (Mac) o Alt (Windows) y haz clic en los

puntos críticos con una herramienta de mano para

eliminarlos.

Uso de la herramienta de lápiz

La herramienta de lápiz permite crear puntos críticos

haciendo clic en el gráfico. Pulsa la tecla Opción

(Macintosh) o Alt (Windows) y haz clic en los puntos

de edición con la herramienta de lápiz para

eliminarlos.

Uso de las herramientas de ajuste

La herramienta de ajuste permite ajustar los puntos

críticos seleccionados hacia arriba o hacia abajo

arrastrándolos a cualquier lugar en la selección.

Uso de la herramienta de mano para crear un punto
crítico

Uso de la herramienta de lápiz para eliminar un punto
crítico

Uso de la herramienta de ajuste para mover puntos
críticos
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Exportación de la mezcla
Después de terminar de grabar, editar y mezclar pistas en una sesión de Pro Tools, puedes mezclar la sesión

y exportar los resultados para crear un CD o publicarla en Internet. Puedes usar el comando Realizar Bounce

a Disco para exportar tu mezcla de la sesión a un solo archivo de audio.

Para exportar la mezcla como un archivo de audio estéreo:

1 Usa la herramienta de selección para seleccionar la duración de la sesión en la línea de tiempo (o en una pista).
Introducción a Pro Tools
Selección en la línea de tiempo para realizar un bounce a disco

Selección de línea

de tiempo

Sesión de audio

seleccionada y lista

para usar el comando

Realizar Bounce a

Disco

Herramienta de selección
2 Elige Archivo › Realizar Bounce a › Disco.

Cuadro de diálogo Realizar Bounce
3 En el cuadro de diálogo Realizar Bounce, haz lo

siguiente:

• Selecciona la fuente como Fuente del Bounce

(este será el camino principal para tu mezcla,

Principal (Estéreo) –› Analog 1–2).).

• Selecciona el tipo de archivo (como por ejemplo

WAV).

• Selecciona Intercalado como formato.

• Si vas a grabar el archivo de audio exportado a

CD, selecciona 16 Bits para la profundidad de

bits (Bit Depth).

• Si vas a grabar el archivo de audio exportado a

CD, selecciona 44.1 kHz en Frequencia de

Muestreo (Sample Rate).

• Para un hacer bounce más rápido que en tiempo

real, selecciona la opción Offline.
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4 Haz clic en Realizar Bounce. (Si no efectúas

ninguna selección, se utilizará la sesión

completa, de principio a fin).

5 En el cuadro de diálogo Guardar, escribe el

nombre del archivo de audio que estás

exportando, y selecciona la ubicación donde

quieres que se guarde.

6 Haz clic en Guardar.

Pro Tools comienza el proceso.

Si esta opción no está habilitada, los “bounces” se

realizan en tiempo real, para poder escuchar la

reproducción de la mezcla durante la exportación.

(No obstante, no es posible ajustar ningún control

de Pro Tools durante el bounce).

Grabar la mezcla en un CD
Al terminar el bounce, tendrás un archivo de audio

que puedes grabar en un CD de audio con un

programa apropiado (como iTunes o Roxio Toast)

para poder usarlo en reproductores de CD normales.

Escuchar un CD de referencia en un entorno distinto

al del estudio es una forma profesional y de eficacia

comprobada para descubrir cómo se reproducirá la

mezcla en otros sistemas o en otros entornos de

audición.
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Más información
Esperamos que esta introducción rápida a

Pro Tools te haya inspirado para crear música.

Para aprender más sobre cualquiera de los temas

presentados aquí, Consulta la Guía de referencia de
Pro Tools (Ayuda › Guía de Referencia de Pro

Tools) para datos completos sobre el programa y

los sistemas Pro Tools. La Guía de referencia de
Pro Tools proporciona una explicación detallada

de todos los conceptos y las características del

programa, organizada por tareas de audio y

producción musical (como grabar, editar, y

mezclar).

También puedes usar la ayuda de Pro Tools online

(Ayuda › Ayuda de Pro Tools) para cualquier tema

específico.
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